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GOLD EventLetters User's Guide

 

GOLD EventLetters™ is a user-friendly software application that merges a data file of information with pre-
defined letter templates. The letters are sent out to your clients when certain events take place, such as late
notices, loan payoffs, renewing a deposit account, interest posting, and many more.

To use this program, you will need GOLD EventLetters™ software. This is a 32-bit program that requires

Windows® 7 or higher. You also need Microsoft® Word® 2010 or higher to compose the letters.

GOLD EventLetters allows you flexibility and control when processing event letters. It is tailored to meet both
the deposit and loan sides of your financing needs. For more detailed information concerning the Deposit and
Loan systems, see Loan Event Processing Procedures, and Deposit Event Processing Procedures,
respectively. 

GOLDPoint Systems Only—Loans

1. Institution option EVNT must be set for each event.

2. For institution option 7 MDYS, enter the number of days before the maturity date to create the letter
(Event 25). Default is 120 days.

3. For institution option FHAD, enter the date the FHA Payoff letter is to be created (Events 35 and 36).

4. For institution option FHAF, enter the extra fee to be added to the FHA Payoff Letter (Events 35 and 36).

5. For institution option T EV29, enter a “Y” to stop sold loan letters (Event 29) from creating letters for
disbursement types 10-19.

6. The Event Letter Report (FPSRP175) must be set to run daily. Refer to the GOLDPoint Systems Only
section in the Event Letter Report for the sort field options.

7. For Balloon Loans (Event 27), the first two characters of the Miscellaneous Parameters on the report
setup are used for the number of days (1-99) before the balloon date to automatically produce a balloon
letter. If the first two digits of the Miscellaneous Parameters are left blank, the balloon letter will generate
on the balloon date.

8. To print the first 20 characters of the name instead of the short name, check the Miscellaneous Options
1 box of the Event Letter Report (FPSRP175).

9. For Insurance Letter (before expiration date) (Event 32), the second two characters (positions 3 and 4) of
the Miscellaneous Parameters on the report setup are used for the number of days (1-99) before the
expiration date to automatically produce a letter.  If the letter is automatically generated, institution
options RDEX and RDE2 (below) must be used.

10. Institution options RDEX and RDE2 are used to control which reserve types will generate an expiration
letter for Event 32. Only reserve types entered in the institution option will automatically generate a letter.

11. To create a follow-up date for Events 44, 45, and 46, enter the number of days to add to the run date (0
to 99) in positions 5–6 of the Miscellaneous Parameters used.

https://secure.goldpointsystems.com/gpsdocs/loans/LoanReports/llr175.asp
https://secure.goldpointsystems.com/gpsdocs/loans/LoanReports/llr175.asp
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12. To display the servicing officer instead of the origination officer on the report, check the Miscellaneous
Options 2 box on the Report Setup screen. (Must have “ML” in the Input Records to use this option.)

13. To stop a Delinquency Event letter (23) from generating on a bankrupt account, check the Miscellaneous
Options 3 box on the Report Setup screen.

14. For event 24, Special Request Letter, if the institution includes the <<PAYOFF_AMOUNT>> merge field
in the letter, you must check Miscellaneous Options 4 on the Loan Reports setup screen for the Event
Letter Report (FPSRP175). If this option is not checked and the <<PAYOFF_AMOUT>> field is included
on letters, nothing will print in that field when the letter is merged with actual data.

15. For event 23, Delinquency Event Letter, if the institution includes the <<PAYOFF_AMOUNT>> merge
field in the letter, you must check Miscellaneous Options 5 on the Loan Reports setup screen for the
Event Letter Report (FPSRP175). If this option is not checked and the <<PAYOFF_AMOUT>> field is
included on letters, nothing will print in that field when the letter is merged with actual data.

https://secure.goldpointsystems.com/gpsdocs/loans/LoanReports/llr175.asp
https://secure.goldpointsystems.com/gpsdocs/loans/LoanReports/llr175.asp
https://secure.goldpointsystems.com/gpsdocs/loans/LoanReports/llr175.asp
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Overview

This manual is designed to give you a well-rounded understanding of the GOLD EventLetters™ program. It will
guide you step-by-step through the event letter processing procedures, including downloading, printing, and
saving the letters, as well as setting up the event letters, tying them to data source files, and finally assigning
merge letters to specific events. 

This chapter gives you a brief overview of the GOLD EventLetters program and how it works. It also provides you
with a summarized description of the events available and a list of the event merge fields.

GOLD EventLetters first requires that you set up merge letter templates on your PC using the Microsoft Word®

"Mail Merge" function and linking the letters to a data source file. This is described in detail in GOLD
EventLetters Setup Procedures.

The data file is created in the afterhours process using the host computer. The data file is created as a result of
either automatic "events" occurring on one or several accounts, or a result of user-requested events. Examples
of events could be new accounts, late payments, interest rate changes, deposit account maturity, etc. You can
also have different letters for each event, such as a letter for new accounts opened with more than $25,000, or
another letter for new accounts opened with less than $1,000. Each event has a possibility of 255 letters that
can be created. The event information is explained in further detail in Loan Event Processing and Deposit Event
Processing.

After the letters have been merged, you can preview a sample letter before you print the batch. You can either
print all of the letters at once, print selected letters, or save the merged letter. This is described in Printing and
Saving Event Letters.

GOLD EventLetters saves the data for the letters to the "Have Been Printed" folder on your PC. The data will
stay there until you either move them to the "Archived Events" folder, you back them up to a diskette, or you
delete them.

Before anyone at your institution can use GOLD EventLetters, they must first be set up with the proper security
clearance. See Setting Up GOLD EventLetters Security for more information.

Additionally, you may want to set up files and other options where you can easily find your letters and data
source files. See Setting Up the GOLD EventLetters System for more information.

See Loan Event Description and Deposit Event Description for more information about the different types of event
records.

Setup Tip: Your GOLDPoint Systems account manager must set up each event in
institution option EVNT. Additionally, your institution's security administrator needs to
flag each event letter your institution wants to use. To do this, they need to checkmark
the Add box for each event letter on the Loans > System Setup Screens > Client Code
Setup > CSLNEVNT - Loan Event Letter Codes screen, as shown below:
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Loans > System Setup Screens > Client Code Setup > CSLNEVNT - Loan Event Letter Codes

Screen

Once the event is checked, it is included in the Event list on the Action/Holds/Events tab, as shown below:

Loans > Marketing and Collections Screen, Actions/Holds/Events Tab
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List of Loan System Events

The following is a list of Loan system events. For more detailed information concerning the loan side of GOLD
EventLetters, see Loan Event Processing. Remember: Institution option EVNT must contain the event numbers
your institution wants generated. Your GOLDPoint Systems account manager can set that option up for you.

Event Description How the Record is
Generated

1 ARM (adjustable rate mortgage) automatic

2 ARM (adjustable rate mortgage) automatic

3 ARM (adjustable rate mortgage) automatic

4 ARM (adjustable rate mortgage) automatic

5 Rate Sensitive automatic

6 ARM (adjustable rate mortgage) automatic

7 ARM (adjustable rate mortgage) automatic

10 ARM (adjustable rate mortgage) automatic

11 ARM (adjustable rate mortgage) automatic

13 Reserve Tax Payment Letter automatic

14 Payoff requested 

15 LIP Billing automatic

16 LIP Billing reminder requested

17 ARM (adjustable rate mortgage) automatic

18 ARM (adjustable rate mortgage) automatic

19 ARM (adjustable rate mortgage) automatic

20 ARM (adjustable rate mortgage) automatic

21* New Loan automatic/requested

22* Closed Loan automatic/requested

23* Delinquent Event requested

24* Special Request requested

25* Maturity (institution-defined days before maturity date) automatic

26 Maturity (at maturity) automatic/requested

27 Balloon Payment automatic

28 Beneficiary Statement requested

29 Loan Sold requested

30 Buydown Payment Change (subsidy) automatic/requested

31 Buydown Expiration (subsidy) automatic/requested

32* Insurance Letter (before expiration date) automatic/requested
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Event Description How the Record is
Generated

33 Over-Credit-Limit Notification (LOC) automatic/requested

34 ARM (adjustable rate mortgage) automatic

35 FHA Payoff Letter (insured prior to August 2, 1985) automatic/requested

36 FHA Payoff letter (on or after August 2, 1985) automatic/requested

40 ARM (adjustable rate mortgage) automatic

41 Payment Change when LIP automatic

42 LIP Rate Change automatic

43 Charge Interest on Negative Reserves Billing requested

44* First Late Notice automatic/requested

45* Second Late Notice automatic/requested

46* Third Late Notice automatic/requested

47* Consumer Insurance Event automatic

48 Loan Miscellaneous Fee Assessment Notice automatic

49 Loan Miscellaneous Fee Reminder requested

50 PMI requested

51 Late Charge Assessment automatic

60 One-time Electronic Payment automatic

61 Cancelled Event Letter automatic

* Most commonly used events.

Note:

Additional events can be identified and merged with user-created databases. See
Copying events for more information.

Note:

For more information concerning the setup of GOLD EventLetters, see the following
sections:

· Loan Event Processing
· Deposit Event Processing
· GOLD EventLetters Setup Procedures
· Working with GOLD EventLetters

The system creates merge fields that pulls in information from different fields in CIM GOLD. The three main
areas where fields are pulled are explained in the following links:

· CIF Fields (All Events)
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· Common Loan Event Fields (All Loan Events)
· Basic Loan Fields
· ARM Fields

List of Deposit System Events

Currently, the following events have been defined and are available for deposits in the GOLD EventLetters
program (see Deposit Event Descriptions for a full description of each event). Following this list is a list of
applicable event fields you can use to create the event letter. For more detailed information concerning the
Deposit side of GOLD EventLetters, see Deposit Event Processing.

Remember: Institution option EVNT must contain the event numbers your institution wants generated. Your
GOLDPoint Systems account manager can set that option up for you.

Event # Description

1010
1020
1030
1040
1050-1052
1051
1060 
1070 
1080 
1090 
2010 
2020 
2030 
2040 
2050
2090
3010-3019 
4010 
4020 
4030
5010-5019 
5030-5039 
5050-5059 
5070-5079

Interest Postings
Dormant Accounts
Inactive Accounts
Account Renewals
Safe Deposit Box Billing (Daily)
Safe Deposit Box Billing (Monthly)
Safe Deposit Box Past Due
Account Holds Expiration Dates (Daily, Monthly)
MMDA Limit Exceeded
W-8 Form Expiration
W-4P Notification
Required Minimum Distribution
Club Account Payouts
Address Change
Check Stop Payment
70 ½ During Current Year
Account Hold Effective Dates
Account Maturities
Account Escheatment
Safe Deposit Box Escheatment
Negative Balance Accounts
New Accounts
Closed Accounts
Excessive Returns

Note:

Additional events can be identified and merged with user-created databases. See
Copying events for more information.
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OPTION

An option is available that will split out the "No Mail" letters to their own
event. The system will add 100 to the original event number, and all "No
Mail" letters (mail codes: 20 = Do Not Mail, 30 = Bad Address, 40 =
Institution Attention, 50 = Earnings Ck Top Sort) will appear for that event
(for example, no mail 1040 events will become 1140). These new events
will need to be attached to a letter before they can be printed. If your
institution would like to use this feature, you will need to tie the
appropriate event numbers to your event letters. 

If this option is not used, the "No Mail" letters will be intermingled with the
letters to be mailed, but will still indicate the "No Mail" status.

The following event fields are currently available for use:

Event Date
Event Number
Event Letter 
Account Office
Account Number
Amount Due
Box Branch Number
Box Number
Check Digit
Due Date
Formatted Account 
IRS Owner Title
IRS Owner Name 
IRS Owner Suffix
IRS Owner SSN 
Mail Address Line 1
Mail Address Line 2 
Mail Address City 
Mail Address ZIP 
Mail Address ZIP 4
Label Line 1 
Label Line 2
Label Line 3 
Label Line 4
Label Line 5
Label Line 6
Last Activity Date 
IRS Owner First Name
IRS Owner Middle Name 
IRS Owner Last Name
1st Owner First Name 
1st Owner Middle Name
1st Owner Last Name 
2nd Owner First Name

Club Payout Freq 
Club Payout Holdback
Current Balance 
Cycle High Balance
Cycle Low Balance 
Cycle Start Date
Date Acct Went Neg 
Date Closed
Date Int Last Paid 
Date Last Return
Date Last W4 Notif 
Date of Last ACH
Date of Last ATM 
Date of Last Deposit
Date of Last WD 
Date Opened
Deposit Type 
Dormancy Date
End of YR Balance 
Escheatment Date
Federal WH Amount
Fed WH Fixed Amount
Fed WH Percentage
General Category
Grace End Date
Hold Action Code
Hold Action Eff Date 
Hold Action Exp Date
Inactive Date
Interest Rate
Last Activity Date 
Last Cust Contact Date
Last Mat Roll Date 
Last Overdraft Date

No WD Cycle
No Xfer Cycle 
Nxt Cycle Start Date
OD Fee Pcnt Of Xfer 
Officer Code
Old Account Number 
Opening Balance
OTC Checks in Cycle 
Overdraft Fee Code
Overdraft Amt Code 
Overdraft Inc Amt
Payout Date
Plan Number 
Product Code
Product Code Desc 
Rate Offset
Reason Charge Waived 
Returned ACH Cyc
Returned Chks Cycle
Secured Account (This will print
X’s based on your institution’s
account number option. The last
four digits of the account number
will display, as will the check
digit.) 
Source of Funds
Srvc Chrg Eff Date 
State WH Amount
State WH Fixed Amnt 
State WH Min Amount
State WH Percentage 
Sub Category
Term 
Term Type
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2nd Owner Middle Name 
2nd Owner Last Name
3rd Owner First Name
3rd Owner Middle Name 
3rd Owner Last Name
Amt of Last Deposit 
Amt of Last Withdrawal
APY 
Anticipated Balance
Base Rate
Bonus Expiration Date
Bonus Rate 
Book Balance
Closing Reason Club 

Last Srvc Chrg Date 
Last Tran Date
Limit Checks in Cyc 
Ltd Returned ACH
Ltd Returned Checks 
Ltd Returned Items
Maturity Date 
Maximum Rate
Minimum Balance 
Minimum Rate
Monthend Balance 
Negative Bal Limit
Next Maturity Date 
Next Product Code
No Checks This Cyc

Transaction Amount 
Transaction Date
Transaction Desc 
Transfers in Last Yr
Transfers Out Lst Yr 
Uncollected Funds
W8 Expiration Date 
YTD Interest
YTD Int Prior Yr 
YTD Returned ACH
YTD Returned Checks 
YTD Penalty
YTD Service Chrgs 
YTD Transfers In
YTD Transfers Out



GOLDEvent Letters14

© 2019 GOLDPoint SystemsLast updated: 11/25/2019

Setting Up GOLDEventLetters Security

Setting up security for GOLD EventLetters is specific to the Loans and Deposits systems. However, general
security for the GOLD EventLetters program is set up as follows:

1. In CIM GOLD, access the Security > Setup screen from the left tree navigation.

2. Select the employee you are setting up in the employee list view, and then access the System tab.

3. Expand the FPS PC Applications menu, and scroll to the GOLDEventLetters Access option.

4. Select the Maintain radio button if this person should have access to GOLD EventLetters (as shown below).

5. Click <Save Changes>.

Security > Setup Screen, System Tab in CIM GOLD

Deposits:

In order for employees to be able to request event letters on accounts, the employee must have screen-
level access to the Deposits > Definitions > Event Setup screen in CIM GOLD. 

GOLDPoint Systems Only: In order for deposit event to generate, JCl

FPSAHN.N must include FPSDEPEV and EVNTSRT.

1. On the Security > Setup screen in CIM GOLD, access the CIM GOLD tab.

2. Expand the Deposits > Definitions menu, and scroll until you see Event Setup.

3. Select the Maintain button to the right of Event Setup (as shown below).

https://secure.goldpointsystems.com/gpsdocs/other/SecurityCIMGOLD/index.asp?securitysetupscreen.asp
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4. Click <Save Changes>. This employee now has access to the Deposit Event Setup screen.

CIM GOLD > Security > Setup, CIM GOLD Tab

Loans:

In order for employees to be able to request event letters on loan accounts, the employee must not be
restricted from field-level access to the event fields found on the Actions/Holds/Event Letters tab found on
various screens in the CIM GOLD Loans system. (See Event Descriptions for more information.)

To see if field-level access is restricted:

1. Access the Security > Setup screen for the employee who you are setting up security, and then
access the Field Level tab.

2. In the Record Type field in the All Fields field group, select "CFLN - Loan Master."

3. Click on the Field Description column heading to sort the fields alphabetically.

4. Scroll to the Event Date 1 field (LNEVDT).

5. If those fields are checkmarked (as shown below), the employee is restricted from making changes to
those fields on the Loans > Marketing and Collections screen > Actions/Holds/Event Letters tab.
Uncheck the fields and that employee should then have access to make changes to those fields.

6. Click <Save Changes>.
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CIM GOLD > Security > Setup, Field Level Tab
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Loan Event Processing

This chapter guides you step-by-step through the loan event processing procedures. 

· The Event Description section explains what an event is and how loan event letters are generated. 

· The Requesting Loan Events Letters topic describes how to request a letter using the Actions/Holds/Events
tab found on various screens in the Loan system in CIM GOLD. 

· The Event Letter Descriptions screen gives a detailed description of each loan event record available for your
use.

· See Appendix A for which fields in the Loans system are used in creating specific event letters.

Note: Additional events can be identified and merged with user-created databases. See Copying to Event File
for more information concerning this process. 

Note: For more information concerning the setup of GOLD EventLetters, please refer to GOLD EventLetters
Setup Procedures and Working with GOLD EventLetters.

Event Description

An event occurs when a pre-defined event affects a loan or when you manually request an event letter. Some
examples are when a loan rolls a rate, when it is delinquent, or when a loan account is opened or closed (see
List of Loan System Events for information on when an event record is automatically generated as opposed to
when an event record is requested).

Each pre-defined event has an assigned event number. When an event occurs, the system automatically
generates an event data file. The next day your institution will then download the events data file and merge this
data file into letter templates stored on your PC. This is done through GOLD EventLetters. When an event letter
is generated, it is written in history.

WARNING

Customers are wholly responsible for the format and wording of
event letters. GOLDPoint Systems does not guarantee that
sample letters comply with regulatory agencies. See Setup
Procedures for detailed instructions on how to create the letter

in Microsoft® Word and use the Mail Merge function to merge
GOLD EventLetters-generated data with the letter. 

The Actions/Holds/Events tab in CIM GOLD is used to manually request a letter or change the letter being
created from the default (0) to a specific letter number. GOLDEvent Letters does not allow two of the same event
(even with differing letter numbers) to be ordered on the same night. Only the first event will be created.

https://secure.goldpointsystems.com/gpsdocs/loans/LoansCIMGOLD/index.asp?actionsholdseventlettersscreen.asp
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NOTE

Unless you have manually requested the letter on the
Actions/Holds/Events tab, the letter number assigned by the
system will always be 0 (default).

For example, if the system automatically generated a "closed loan letter," GOLD EventLetters would
automatically assign it event 22, letter 0. However, perhaps you have different letters you want for different loan
accounts when they are closed, such as a closed-loan letter for mortgage loans verses a closed-loan letter for
precomputed loans. You would need to complete the following steps:

1. Set up the letter with the appropriate wording and the appropriate merge fields in Microsoft® Word. Make
sure to name the document including the letter number. For example, if creating a closing event letter based
on loan types, you could name letter number 1 "Closed Loan Loan Type 1."

2. Set up the letter numbers on the Event Letter Descriptions screen.

3. Assign the letter number and the Closed Loan Event (event 22) to the applicable accounts using the
Actions/Holds/Events tab, as shown below:

Actions, Holds, Event Letters Screen

If you want a letter to be created on a specific date, such as tonight, you would enter 1 the event number, 2 the
letter number if other than letter 0 (default), and 3 the date you want the letter created, as shown below. 

https://secure.goldpointsystems.com/gpsdocs/loans/LoansCIMGOLD/index.asp?actionsholdseventlettersscreen.asp
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During the night of the letter date, the system will generate the letter and it will be ready for download in GOLD
EventLetters. Once you download the letter, you can assign the event to a letter, then print the letter accordingly
in GOLD EventLetters, as shown below:

Print Event Letters screen in GOLD EventLetters

See the Working with GOLD EventLetters chapter for more information on the steps involved in printing the event
letters.
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NOTE

An option is available that blocks specific event letters from generating when certain action codes are
placed on an account. If you would like to block certain events based on action codes, complete the
following steps:

1. Access the Loans > System Setup Screens.

2. Click the Setup Screen list icon  and select "Action Code Descriptions" from the pop-up
menu.

See the following example:

3. Select the action code for which you want to block event letters from the list view.
4. Check the Block Event Letter Requests box.
5. Click <Save Changes>.

Now when that action code is set up on accounts, an event letter will not be generated. Additionally,
the Event Letters, Numbers & Dates field group will be grayed out.
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Why didn't the system generate the event letter for this account?

Certain activity on an account will prevent the account from generating an event letter record, even though you
request an event letter. Under the following circumstances, the system will not create an event letter record for
accounts:

· Loans with a General Category of 80 and above.
· Loans with an Origination Code of 3, 15, or 16 (loans purchased/serviced by others).
· Hold Codes 1, 2, 4, 5, 6, 27, 92, or 93.
· Hold Code 7 (legal) and 90 (judgment awarded) will create an event letter record. However, if a charge-off

is also involved with the loan, the event letter record will not be created.

Where do I set up event letters in CIM GOLD?

Information entered on the Actions/Holds/Events tab from anywhere in the Loan system is saved, and the
information appears on the tab wherever it exists in CIM GOLD. The Actions/Holds/Events tab can be found on
the following screens:
Loans > Marketing and Collections screen 
· Loans > Misc Secured F/M Data screen
· Loans > Transactions > CP2 screen
· Loans > Transactions > Payment Reversal

Note: If you want an event to generate that is not currently defined, please submit a work order to your
GOLDPoint Systems account manager to have the event programmed. You can see the complete list of all
possible event letters currently programmed on the Loans > System Setup Screen > Client Code Setup > Loan
Event Letter Codes. See the Overview section for more information.

Also see Appendix A for a listing of fields pulled from the Loans system available for each event letter. 

Event Letter Types

The following chart lists the event numbers currently defined when an ARM loan (payment method 7 or payment
method 6 ARM) rolls a rate.

Event 
Number

Subsidy 
Constant 
Change

Next Accrual 
Rate Change

Next P/I 
Payment 
Change

Periodic Rate 
Cap Used

Lifetime Rate 
Cap Used

1 no up no yes no

2 no down no yes no

3 no up yes yes no

4 no down yes yes no

6 no down no no no

7 no down yes no no

10 no up no no no

11 no up yes no no

17 no up yes yes yes

https://secure.goldpointsystems.com/gpsdocs/loans/LoansCIMGOLD/index.asp?generalcategory_lads.asp
https://secure.goldpointsystems.com/gpsdocs/loans/LoansCIMGOLD/index.asp?originationcode_lalf.asp
https://secure.goldpointsystems.com/gpsdocs/loans/LoansCIMGOLD/index.asp?holds_1-4_ahel.asp
https://secure.goldpointsystems.com/gpsdocs/loans/LoansCIMGOLD/index.asp?actionsholdseventlettersscreen.asp
https://secure.goldpointsystems.com/gpsdocs/loans/LoansCIMGOLD/index.asp?marketingandcollectionsscreen.asp
https://secure.goldpointsystems.com/gpsdocs/loans/LoansCIMGOLD/index.asp?miscsecuredfmdatascreen.asp
https://secure.goldpointsystems.com/gpsdocs/loans/LoansCIMGOLD/index.asp?cp2screen.asp
https://secure.goldpointsystems.com/gpsdocs/loans/LoansCIMGOLD/index.asp?paymentreversalscreen.asp
https://secure.goldpointsystems.com/gpsdocs/loans/LoansCIMGOLD/index.asp?loaneventlettercodes_lsccs.asp
https://secure.goldpointsystems.com/gpsdocs/loans/LoansCIMGOLD/index.asp?loaneventlettercodes_lsccs.asp
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Event 
Number

Subsidy 
Constant 
Change

Next Accrual 
Rate Change

Next P/I 
Payment 
Change

Periodic Rate 
Cap Used

Lifetime Rate 
Cap Used

18 no down yes yes yes

19 no up yes no yes

20 no down yes no yes

34 no down yes no no

40 no up/down yes yes/no yes/no

Other events that do not pertain to ARM loan rate rolls are listed here with their event numbers.

Event Event 
Number

Description

Rate Sensitive Event 5 This event automatically produces an event letter when the loan rate
changes on a payment method 5 or a payment method 6 (non-ARM
loan).

Reserve Tax Payment
Letter

13 This event record is generated when the system encounters tran
codes 440 (reserve 1 disbursement), 448 (reserve 1 disbursement
correction), 640 (reserve 2 disbursement), and 648 (reserve 2
disbursement correction) for a single, family-owned (collateral code 1-
4), owner-occupied loan (LNOWNR is checked) for reserve
disbursement codes.

Loan Payoff Event 14 This event record is not generated automatically. It must be requested.
This letter can also be requested by using the Letter Date and Letter
Number fields on the Loans > Payoff screen. Only event letter number
14 can be requested from that screen. 

LIP Billing Event 15 This event record is automatically generated when the Prior Unpaid
Charges field is changed. 

LIP Reminder Event 16 This event record is not generated automatically. It must be requested.

New Loan Event 21 This event record is generated when the system encounters tran code
680 (new loan). The origination officer's name and number are available
for this letter. 

Closed Loan Event 22 This event record is generated when the system encounters tran code
580 (close loan).

Delinquency Event 23 This event record is not generated automatically. It must be requested.
The loan must be delinquent when this event is ordered or the letters
will not generate. (The due date must be in the past.) Date and time of
appointment can be set up in Action Code 210 and 211 on the
Actions/Holds/Events tab. 

Specialty Request Letter 24 This is reserved for letters that are a special request of the institution.
This is the same as event 23, except the loan does not have to be
delinquent.

Note: If you want to use the <<PAYOFF_AMOUNT>> merge field on
this event, the following needs to take place:
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Event Event 
Number

Description

1. You must contact GOLDPoint Systems and have your account
manager set the fourth Miscellaneous Option for the Event
Letter Report (FPSRP175). If this option is not set, nothing will
print in the <<PAYOFF_AMOUNT>> field when the letter is
merged with real data.

2. The Include Payoff box must be checked on the Loans >
System Setup Screens > Event Letter Descriptions screen.

Prenotification of Loan
Maturity Letter

25 This letter can be generated any number of days before the maturity
date. You must inform GOLDPoint Systems of the number of days
prior to maturity the letters should be generated. The system defaults
to 120 days. 

GOLDPoint Systems Only: Set OPT7-MDYS to the desired number
of days.

Loan Maturity Event
Letter

26 This letter will be generated on the maturity date.

Loan Balloon Payment
Letter

27 This letter will print when there is and action code 1 (Balloon Payment
Due) on the loan. Action code 1 stops all activity on the loan. This
letter can be generated from 1 to 99 days before the balloon date. You
must inform GOLDPoint Systems of the number of days (01–99) prior
to the balloon date the letters should be generated. 

GOLDPoint Systems Only: The first two positions of the
Miscellaneous Parameters field should contain the number of days
(01-30) prior to the balloon date that event 27 should be generated. If
left blank, then the letter will generate on the balloon date. The
parameters are set up on the GOLDPoint Systems > Report Setups >
Loan Reports screen for the GOLD EventLetters Report (FPSRP175). 

Beneficiary Statement 28 This letter is generated upon request from this screen; however, if no
payoff record exists it will not be created. If you attempt to set up this
letter, the system will first check to see if a payoff record exists. If it
doesn't, you will receive the message "MUST CREATE PAYOFF
RECORD FIRST." If it does, the letter will be created. You must lock
in payoff, then unlock it (that creates the payoff record), then order
event letter 28 on the Actions/Holds/Events tab. Use the same date
you used in the Letter Date field on the Loans > Payoff screen,
Balances tab. 

Loan Sold Letter 29 This letter is generated when a loan is sold to allow you to inform all
associated with the loan that it was sold. All information found on the
Loans > Payee Information screen can be used to build this event
letter. This event can be created with information regarding the
company that reserve disbursements are sent to. This event creates
multiple letters; e.g., if you have three insurance companies set up,
you will receive three separate letters. Institution option T EV29 will
stop letters from being created for Reserve Disbursement Types 10
through 19 (taxes). If you would like this option, submit a work order.

https://secure.goldpointsystems.com/gpsdocs/loans/LoanReports/llr175.asp
https://secure.goldpointsystems.com/gpsdocs/loans/LoanReports/llr175.asp
https://secure.goldpointsystems.com/gpsdocs/loans/LoanReports/llr175.asp
https://secure.goldpointsystems.com/gpsdocs/loans/LoansCIMGOLD/index.asp?type_ard.asp
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Event Event 
Number

Description

This event must be requested through a work order and set up
manually. 

Buydown Payment
Change Letter

30 This letter is generated one month prior to the new subsidy effective
date pulled from the Loans > Account Information > Reserves >
Account Reserves Detail screen. Tracking subsidies is not currently
available in CIM GOLD. Contact your GOLDPoint Systems customer
service representative for more information.

Buydown Expiration
Letter

31 This letter is generated one month prior to the subsidy expiration date.

Insurance Letter (before
expiration date)

32 This letter can be automatically generated or you can manually
request it.  

This event will generate a letter to inform the customer that a reserve
disbursement item is about to expire. The letter will generate a
specific number of days before the expiration date.

Automatically generated:
If you would like the letters to be automatically generated, the
following options must be set up:

1. A report option is available which indicates how many days prior
to the expiration date a letter will automatically be generated.

2. Institution options RDEX and RDE2 store the reserve
disbursement types for which the finance company would like
letters to be automatically generated.

This event must be requested through a work order.

Manually requested:
This letter can be manually requested for reserve types 20-28 and 30-
49 that will expire within 75 days. However, on closed accounts, only
letters ordered within 60 days of the date closed will be created. 
(Example: This would be used to notify an insurance company to
delete the institution’s name from the policy, etc.) 

Over Credit Limit
Notification for Line-of-
Credit Loans

33 This letter is generated when the credit limit for line-of-credit loans has
been exceeded. This is for line-of-credit loans (payment method 5)
only. Commercial line-of-credit loans (payment methods 9 and 10) will
not generate this event. The letter will automatically be created when
the date of the last transaction is today and the principal balance
exceeds the credit limit. 

Note: A letter will be created each time the date of the last transaction
changes; this may result in more than one letter being created within
several days. (The date of the last transaction is for monetary activity
only.) The letter can also be ordered manually.
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Event Event 
Number

Description

P/I Payment Changes
Only Letter

34 All P/I change fields are checked for a change, and any change is
reported on the letter. No rate changes are included in this letter.

FHA Loan Payoff Letter
(Insured Prior to August
2, 1985)

35 This letter is sent once a year as required by the National Affordable
Housing Act, section 329 and follows the format defined by HUD. In
the afterhours on the date requested by the institution, the system
automatically selects letter 35 or 36 using the Date Opened field on
the Loans > Account Information > Account Detail screen. The letter
prints the payoff amount, the fees pertaining to the payoff either as
part of the total payoff amount or as a separate amount, and any
requirements the borrower must fulfill to prevent accrual of interest on
the mortgage loan after the pre-payment date. 

· To request this letter, submit a work order to GOLDPoint Systems
indicating the telephone number of your Loan Service Department
for the borrower to call, the name and title of the employee who
signs the letter, and how the payoff fees are disclosed.

· To manually generate this letter, set up the event on the
Actions/Holds/Events tab. The payoff is calculated to the end of the
month following the date that the event letter is requested. 

FHA Loan Payoff Letter
(Insured On or After
August 2, 1985)

36 This letter is generated and calculated the same as event 35 with the
following exceptions:

1.  This letter is for FHA loans insured on or after August 2, 1985.

2.  One of the following sentences can be printed on the letter
specified by your institution:

Option 1: Otherwise, your prepayment will be refused until the
next installment due date and interest will be charged to that
date.

Option 2: Otherwise, you may be required to pay interest on the
amount prepaid through the end of the month.

GOLDPoint Systems ONLY: 

FHAD Set this option (FHA Disclosure letter run date
MMDD) to have the letters run every year on the same
month and day.

FHAF Set this option (FHA Disclosure extra fee) to disclose
the fees pertaining to the payoff.

EVNT Set this option (Event Letter Request) to include
events 35 and 36.
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Event Event
Number

Description

P/I Payment Change
Different than Rate
Changes Letter
(CNE040)

40 All P/I change fields are checked for a change, and any change is
reported on the letter. The letter includes a summary of interest rate
changes that have occurred since the last P/I change. This letter can
only be generated if the Use Event Letter 40 field on the Loans >
Account Information > ARM Information screen, Rate Caps & Negative
Amortization tab displays a checkmark, the rate change frequency is
not the same as the P/I constant change frequency, and you have
requested the event letter by work order.

For example, if the next P/I change is on April 1, the last P/I change
was April 1, and the interest rate does not change on April 1, the event
letter will generate showing the next P/I change date and amount and
all the rate changes since April 1. 

Payment Change when
LIP Letter

41 Event 41 calculates the new P/I while the loan is still in the
construction process. If the LIP method code is 1 or 101 and the loan
fields on the Loans > Account Information > ARM Information screen
call for a P/I change, the system will calculate the new loan accrual
rate and P/I constant.

WARNING

While the loan is in the construction process and
payments are posted, the Current Installment Number
on the Loans > Account Information > Account Detail
screen does not increase (it remains zero). Depending on
the number of remaining months to be used in the P/I
calculation, you may have to manually enter the installment
number either from the pattern or prior to the system
calculation. 

Example: You have a construction/permanent loan with a
term of 360 months. The first 9 months is the construction
period. The mortgage payments on the permanent loan are
to amortize over 351 months. In order for the new P/I to be
calculated correctly, the Current Installment Number
should be 9. 

LIP Rate Change 42 Event 42 will generate an LIP rate change letter if the LIP
(construction) rate changes are either based on a rate change date or
for rate sensitive loans. This letter will only create if the LIP method
code is 1 or 101.

Charge Interest on
Negative Reserves
Billing

43 Event 43 will generate a billing letter for charging interest on negative
reserves.

First Late Notice 44 Event 44 generates a letter for the first late notice. In order to generate
late notices through the event letter system, the event number (44, 45,
or 46) must be entered in the Notice 1 Type, Notice 2 Type, and
Notice 3 Type fields on Loans > Account Information > Account

https://secure.goldpointsystems.com/gpsdocs/loans/LoansCIMGOLD/index.asp?useeventletter40_laais.asp
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Event Event
Number

Description

Detail screen, Late/NSF tab, as well as the desired number of days.
See the Past Due Notices topic for more information.

Second Late Notice 45 Event 45 generates a letter for the second late notice. See the Past
Due Notices topic for more information.

Third Late Notice 46 Event 46 generates a letter for the third late notice. See the Past Due
Notices topic for more information.

Consumer Insurance
Event

47 Event 47 will generate a letter anytime an insurance policy expires or a
Force Place Insurance transaction (tran code 2870) is run. See the
Force Place Screen topic in the Loans in CIM GOLD manual for more
information.

Fee Assessment Notice 48 This event generates if a Miscellaneous Fee transaction or
corresponding correction is processed on an account.

Valid transaction codes are:

Assess Misc. Fee—tran code 660/668
Waive Misc. Fee—tran code 670/678
Pay Misc. Fee—tran code 850/858

Fee Reminder Notice 49 This letter must be requested manually.

PMI Notice 50 This letter must be requested manually.

Late Charge
Assessment

51 This event is created automatically any time an account is assessed a
late charge (tran code 560). If you want to use this event letter, please
submit a work order. We can set this event up to run for accounts from
specific states.

One-time Electronic
Payment

60 The One-Time Electronic Payment (event 60) record is automatically
generated when your customers approve of one-time ACH loan
payments. This event is created after employees click <Submit
Payment> after creating a one-time payment on the Loans >
Transactions > EZPay screen in CIM GOLD. Additionally, this letter is
not included on the Event Letter Report (FPSRP175).

Cancelled Event Letter 61 The Cancelled Event Letter (event 61) record is automatically
generated when your customers cancel one-time ACH payments. This
letter will not generate for same-day cancellation of ACH payments.
Additionally, this letter is not included on the Event Letter Report
(FPSRP175).

Negative Amortizing Loans

If the loan is a negative amortizing loan (see the Loans > Account Information > ARM Information screen, Rate
Caps & Negative Amortization tab), the letter number is the event number plus 200. For example, if event 1 is
selected for a negative amortizing loan, the letter number is 201.

A letter from the 200 series is generated whenever the system calculates the next interest rate, the Next P/I
Constant, or both and, because of the caps, the new calculated P/I is lower than the required Amortized P/I
and the Interest P/I. For example:

https://secure.goldpointsystems.com/gpsdocs/loans/LoansCIMGOLD/index.asp?insuranceforceplacescreen.asp
https://secure.goldpointsystems.com/gpsdocs/customers/CIMGOLDTeller/index.asp?trancode660_assessloanfee.asp
https://secure.goldpointsystems.com/gpsdocs/loans/LoansCIMGOLD/index.asp?miscellaneousfeeprocessing_mac.asp
https://secure.goldpointsystems.com/gpsdocs/loans/LoansCIMGOLD/index.asp?miscellaneousfeeprocessing_mac.asp
https://secure.goldpointsystems.com/gpsdocs/loans/LoansCIMGOLD/index.asp?easypayscreen.asp
https://secure.goldpointsystems.com/gpsdocs/loans/LoanReports/llr175.asp
https://secure.goldpointsystems.com/gpsdocs/loans/LoanReports/llr175.asp
https://secure.goldpointsystems.com/gpsdocs/loans/LoanReports/llr175.asp
https://secure.goldpointsystems.com/gpsdocs/loans/LoansCIMGOLD/index.asp?ratecapsnegamorttab_laais.asp
https://secure.goldpointsystems.com/gpsdocs/loans/LoansCIMGOLD/index.asp?ratecapsnegamorttab_laais.asp
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New Calculated P/I = $490

Required Amortized P/I = $520

Interest P/I = $500

then a letter from the 200 series is generated.

If the new calculated P/I is lower than the Amortized P/I, but greater than the Interest P/I, then the 300 series
letter is generated. For example:

New Calculated P/I = $490

Required Amortized P/I = $500

Interest P/I = $480

then a letter from the 300 series is generated.

 
The system will calculate the Amortized P/I and the Interest Only P/I, and show these amounts on the Loans
> Account Information > ARM Information screen, Rate Caps & Negative Amortization tab (for ARM loans,
payment method 7). These amounts can also be printed on 200 and 300 series AML event letters using the
correct merge fields. The borrower is not required to pay the Amortized P/I, but if the borrower does, the loan
will continue to fully amortize over the remaining term of the loan. If the borrower chooses to pay the Interest
Only P/I, then the Interest Only amount will be applied to the loan.

Requesting Loan Event Letters

Event letters can either be automatically created when certain activity occurs on a loan, or you can manually
request that event letters records generate in the afterhours of a specific date you assign using the
Actions/Holds/Events tab. For a list of all loan events and whether they are automatic or requested, see the List
of Loan System Events topic.

Remember: Institution option EVNT must contain the event numbers your institution wants generated, whether
requested or automatic. Your GOLDPoint Systems account manager can set that option up for you.

Requesting Event Letters

To request an event letter, users must input an event number, letter number (if desired), and event date on
Actions/Holds/Events tab on either the Loans > Marketing and Collections screen (or the standalone screen).
Up to five event letters can be generated on a loan per night.

For example, if you want a letter to be created on a specific date, such as tonight, you would enter the event
number, letter number (if other than the default letter "0"), and today's date, as shown below:

https://secure.goldpointsystems.com/gpsdocs/loans/LoansCIMGOLD/index.asp?ratecapsnegamorttab_laais.as
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When you use the Letter field to request an event letter on a specific date, the system will only generate the
event record and the event letter. It does not cause the actual event to occur. GOLDEvent Letters does not allow
two of the same event (even with differing letter numbers) to be ordered on the same night. Only the first of the
same event will be created. 

Letter numbers are determined by your institution. Use the Loans > System Setup Screens > Event Letter
Descriptions screen to designate the different letters used by your institution.

When the system detects a pre-defined event happening, it checks to see if the number in the Event field is the
event number that is happening. If so, the system will generate the letter number in the Letter field instead of
using the default letter (0) as the letter number.

Note: Events 44, 45, and 46 must have a Letter number as well if requested from the Actions/Holds/Event
Letters screen. If you would rather automatically generate events 44, 45, and 46, use the Notice Type fields on
the Late/NSF tab of the Account Detail screen instead, as described in the Past Due Notices topic.

Note: If you want an event to generate that is not currently defined, please submit a work order to your
GOLDPoint Systems account manager to have the event programmed. You can see the complete list of all
possible event letters currently programmed on the Loans > System Setup Screen > Client Code Setup > Loan
Event Letter Codes. See the Overview section for more information.

Automatic Event Letters

The system generates automatic event records in the afterhours of when the event took place. For example,
your institution wants an event record generated each time a late charge is assessed (event 51). In the
afterhours of when late charges are assessed (Update Function 32), the system will also run an event record for
all accounts that were assessed a late charge. 

However, before the system can do this, your GOLDPoint Systems account manager must set up institution
option EVNT with the event records you want automatically generated. For a list of which events are
automatically generated verses events that are generated upon request, see the List of Loan System Events.

Note: Certain hold codes and account specifications may result in the account not generating an event record.
See Why didn't the system generate the event letter for this account?

Event Report

https://secure.goldpointsystems.com/gpsdocs/loans/LoansCIMGOLD/index.asp?holds_1-4_ahel.asp
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See FPSRP175, Event Letter Report, to view a list of accounts where an event record was generated. 

Event Letter Descriptions Screen

The Loans > System Setup Screens > Event Letter Descriptions screen is used to set up event letter options for
use by your institution. All event letters are available for your institution. This screen allows you to set up
specific options concerning the event letters, such as what letter number to assign to the event, a description of
the event, an external letter number you want to use with this event, and whether or not you want the payoff
amount included with the event.

Some event letters are processed automatically when certain events take place on a loan. Other events must be
selected using the Loans > Account Information > Actions, Holds, and Event Letters screen. Any event letter

modifications you set up on this screen will be displayed in the Letter field (click the list icon ) on the
Actions, Holds, and Event Letters screen, as shown below:

Once an event takes place, you can print the designated letters to those account owners notifying them of
action taken on their account. Use the GOLD EventLetters program to process those event letters, print them,
and send them to your customers. 

Note: Institution option EVNT must be set up with the events your institution wants to use. Notify your
GOLDPoint System account manager if you want events added or removed.

The Event Letter Descriptions screen is found when you access the Loans > System Setup Screens, click the

list icon , and select "Event Letter Descriptions" from the list that appears, as shown below.

https://secure.goldpointsystems.com/gpsdocs/loans/LoanReports/llr175.asp
https://secure.goldpointsystems.com/gpsdocs/loans/LoansCIMGOLD/index.asp?eventletterdescriptionsscreen.asp
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Loans > System Setup Screens > Event Letter Descriptions Screen

To set up event options:

1. Click <Create New> at the bottom of the screen. The other fields on this screen become file maintainable.

2. Click the list icon  in the Event field and select the event you want to set up.

3. In the Letter Number field, enter a number that you and everyone at your institution will use for this event
letter.

4. In the Description field, enter an additional description (besides the Event description) for this event
letter. For example, if this letter is for loans over $5,000, you could enter "Loans Over $5,000" in this field.
Use a description that will be understandable by all employees creating event letters for customers.

5. Enter the External Letter Number connected to this event letter, if any. This field is for use by your
institution however you need it. It can reference a letter that you include with the event letters, such as an
advertisement flyer; it could be a company-wide policy change letter; or anything else you want included
with this event letter.

6. If you want the payoff amount to be calculated on the night after the date this event is set up for this
account (on the Loans > Account Information > Actions/Holds/Events tab, Date field), check the Include
Payoff checkbox (BLINPO). This checkbox is only used for event 24 (Specialty Request Letter). The
payoff amount will be available in the SQL database to use in reports.

7. Click <Save Changes>. This event letter will now be available for this event in the Letter field on the
Actions/Holds/Events tab.
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Deposit Event Processing

Before your institution can use GOLD EventLetters for the Deposit system, several features must be set up on
the Security System, as well as in the GOLDVision/WinTerm environment. These screens will not be moving
over to CIM GOLD. This section will explain the process of setting up events so GOLD EventLetters will function
properly for deposit events.

1. First, you must set up security to be able to access the Deposit Event Setup screen (through GOLDVision >
GOLD Services, function 35/36).

2. Second, use the Event Setup screen to set up which event letters you want generated for your institution.

3. Last, use the features in GOLD EventLetters and Microsoft Word to create your event letter and generate
accounts where the event letter will be sent. 

Deposit Event Descriptions

This section describes the events available for set up on the Deposit Event Setup screen (through GOLDVision
> GOLD Services, function 35/36). Deposit Event Letters can be used to notify your customers of a variety of
events that can occur on deposit accounts, such as certificate maturities, new accounts, interest postings,
retirement distributions, and address changes.

Features and options must be set up on this screen before any event letters can be processed through GOLD
EventLetters™. 

To make changes to the options on this screen, you must first give your employees the appropriate access and
security. 

You can print event letters using GOLD EventLetters and Microsoft® Word® and following these steps:

1. Download the day's events from GOLD EventLetters.

2. Create your letter using Microsoft Word, and insert merge fields from the file created by GOLD EventLetters.
(This step may only have to be done once or updated periodically.) Also see Setting Up GOLD EventLetters
(Deposits) for a list of merge fields available.

3. Assign the letter you created in Microsoft Word to data files in GOLD EventLetters.

4. Print the letters using GOLD EventLetters.

The following is an example of the Deposit Event Setup screen in GOLDVision.
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Deposit Event Setup Screen in GOLDVision (GOLD Services, then function 36)

Each event is preceded by a checkbox enabling your institution to mark whether you want to use the event or
not. Enter a checkmark in the box if you want it, or leave it blank if you don’t. Only the events marked with a
checkmark will create letters. For events marked with a checkmark, run options must also be entered. Run
options tell the system when to run events. Depending on the events, they can be run daily, weekly, monthly,
yearly, or whenever your institution specifies as permitted.

Each event also has a system-defined event number. If different options are available based on account criteria,
a four-digit event letter number is also listed. When there are different event letter numbers available, you can
create different event letters in your Microsoft Word file. The numbers and letters are listed under the event in the
following event descriptions. The following event descriptions specify what run options to use for each event.

"No Mail" Option

An option is available that will separate the “No Mail” letters to their own event. The
system will add 100 to the original event number, and all “No Mail” letters will be
generated for that event (for example, no mail 1040 events will become 1140). These
new events will need to be attached to a letter before they can be printed. If your
institution would like to use this feature, you will need to tie the appropriate event
numbers to your event letters, then submit a work order to have the option turned on
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for the Event Letter Generation Report (FPSDR500). If this option is not used, the “No
Mail” letters will be intermingled with the letters to be mailed, but will still indicate the
“No Mail” status.

Event Event
Number

Event Letter Description

Account
Maturities

4010
4110 (No
Mail - see
Option box
above)

Four-digit Product
Code

Or

If the Sort by
Office field under
the Account
Maturities field is
checked, then the
letter number will
be the account's
office number. 

This event will run based on three different run options,
with up to two different monthly run days, as shown
below. 

An anticipated balance and next maturity date are
calculated and available for use with this event. For
Interest Destination 1 (pay interest by check) and 2
(transfer interest by Customer Directed Transfers), the
anticipated balance will be the current balance. For
Interest Destination 0 (pay interest to the account), the
anticipated balance will be the interest for the coming term
added to the current balance. (Interest Destination is
found on the Deposits > Account Information > Interest
Fields screen in CIM GOLD.) 

The options are as follows:

· Run option 1 runs monthly. If you want all certificates
with a maturity date in the next month to generate an
event record, select “1=Monthly” from the Run Option
field. The event will process each month on the day
entered in the Run Days field.

· Run option 2 allows you to generate up to two different
monthly run days.  To use two run days, select “2=Two
Different Run Days” from the Run Option field. For
accounts maturing on days 1 through 15 of the next
month, type any number between 1 and 15 in the first
Run Days field. You must generate account maturity
events for all accounts maturing from day 16 to the end
of the current month. To do this, type a number
between 16 and 31 in the second Run Days field.

· Run option 3 runs weekly.  Select “3=Weekly” in the
Run Option field to use this option. It adds 28 days to
the run date and generates records for accounts
maturing between that day and the same day the

https://secure.goldpointsystems.com/gpsdocs/deposits/ReportsCIM/fpsdr500.asp
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Event Event
Number

Event Letter Description

following week. Type a number indicating the day of the
week in the Run Days field:

2     Monday
3     Tuesday
4     Wednesday
5     Thursday
6     Friday
7     Saturday

Note: Once you download the Account Maturities letters
from GOLD EventLetters, the merge fields applicable to
that letter can be inserted using Microsoft Word. The
TERM_TYPE merge field will be plural unless the TERM
merge field is equal to "1" (for example, 1 month, 1 year; 3
months, 3 years). We suggest that you make sure your
Maturity Event Letters are grammatically correct with this
in mind. For example, if you enter "your <<TERM>>
<<TERM_TYPE>> certificate" and the certificate term is
for three months, the letter would print "your 3 months
certificate." Instead, you can write “your certificate
matures in <<TERM>> <<TERM_TYPE>>," and the letter
will print "your certificate matures in 3 months” when the
fields are merged with actual data.

See Tying Data Source Files to Event Letters for detailed
instructions on merge fields.

Deposit
Account
Escheatment

4020
4120 (No
Mail - see
Option box
above)

If account is
  < $25.00,
then first two digits
= 25.
Last two digits:
01 = Checking
02 = Savings
03 = Certificate
04 = Retirement

To process this event, the escheatment months (ESCH
Months field) and escheatment date (ESCH Date field)
must also be filled in. Enter the number of escheatment
months your institution is required to use in the ESCH
Months field, and enter the escheatment date your
institution is required to use in the ESCH Date field. The
data in these fields overrides the institution options used
for the notices generated during afterhours. Escheatment
months are defined as the number of months from the date
of last customer contact until an account becomes
escheatable. The escheatment date is the month and date
(MMDD) accounts escheat to the state each year. A
certificate is not escheatable in its first term. An account
with no dormancy term is not escheatable.

The event can be run one of two ways:

· The first option you can use is the run dates. When
using the run dates, up to four different run dates in
MMDD format can be used in the Run Dates field. All
accounts that become escheatable by those four
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Event Event
Number

Event Letter Description

dates will create an event record. Use the cutoff date
with the run dates. The cutoff date pulls the same
accounts on each run date. The Cutoff Date field is
file maintainable. If used, all accounts that become
escheatable by the cutoff date instead of the run date
will create an event record.

· The second option that can be used instead of the
run dates is the run parameter. Valid data for the Run
Parameter field is "M = Monthly," "Q = Quarterly,"
and "S = Semi-monthly." If a parameter is used, this
event will run the last processing day of each month,
quarter, or six months, depending on the parameter
used. All accounts that become escheatable in the
next month, quarter, or six months will be selected.

See example below with the Run Parameter option
selected.

Safe Deposit
Box
Escheatment

4030
4130 (No
Mail - see
Option box
above)

None, unless the
Sort All Box
Letters by Box
Office field is
checked. In which
case, the safe
deposit box office
number will
appear. 

This event works similarly to deposit account
escheatment. This event bases the escheatment on the
date of last activity. Enter the number of escheatment
months your institution is required by the state to use in
the Esch Months field, and enter the escheatment date
your institution is required to use in the Esch Date field,
as shown below. 

Escheatment months are defined as the number of
months from the date of last customer access until a safe
deposit box becomes escheatable. The escheatment date
is the month and day (MMDD) accounts escheat to the
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Event Event
Number

Event Letter Description

state each year. The only fields used to create the safe
deposit box escheatment event letter are as follows:

Box Branch Number
Box Number
Last Activity Date
Amount Due
Due Date
Date Box Opened
Escheatment Date
Account Number (if there is one tied to the safe deposit
box)

Neg Balance
Accounts

5010-5019

5110-5119
(No Mail -
see Option
box above)

0001 = Checking
0002 = Savings
0003 = Certificate 
0004 = Retirement

This event runs daily in the afterhours. You need to
choose the days negative you want letters generated on
for negative accounts. Ten intervals can be entered in the
provided fields, as shown below. 

Each interval has a separate event number. The first
interval’s event number is 5010, the second is 5011, third
is 5012, fourth is 5013, fifth is 5014, sixth is 5015, seventh
is 5016, eighth is 5017, ninth is 5018, and tenth is 5019. 

Any account that has a negative balance will create an
event record. You can specify an amount for the negative
balance limit you want for letter creation. Enter the
negative balance limit in the Limit for Event field. Note:
Don't enter the minus sign. The system already
recognizes the number as a negative number.  If this field
is left at zero or blank, any account with negative balance
will produce an event letter.

You can choose to generate a record on the day an
account goes negative and for nine other days. For
example, if you want a letter to generate on the first day
an account becomes negative and every week after, then
type “1,” “8,” “15,” “22,” “29,” and “30” in the fields below
the checkbox. You can generate up to 10 letters a month
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Event Event
Number

Event Letter Description

for negative accounts. If a run date falls on a non-
processing day, the record will be generated the
processing day before the run date you specified in the
provided fields.

New
Accounts

5030-5039

5130-5139
(No Mail -
see Option
box above)

0001 = Checking
0002 = Savings
0003 = Certificate
0004 = Retirement

This event runs daily in the afterhours. You need to
choose the days you want letters generated for new
accounts. Any day of the month can be used; however,
only 10 days can be entered in the provided fields, as
shown below. 

Each day has a separate event number. The first day's
event number is 5030, the second is 5031, third is 5032,
fourth is 5033, fifth is 5034, sixth is 5035, seventh is 5036,
eighth is 5037, ninth is 5038, and tenth is 5039. 

A new account will create an event record on the day you
specify unless the owner of the account already has
accounts with your institution. For example, if you want a
letter to generate on the first day an account is opened
and every week after, then type “1,” “8,” “15,” “22,” “29,”
and “30” in the fields below New Accounts. If an account
is going to reach a specified date on a non-processing
day, it will be pulled in the processing day before it
reaches the date specified in the provided fields.

Closed
Accounts

5050-5059

5150-5159
(No Mail -
see Option
box above)

0001 = Checking
0002 = Savings
0003 = Certificate
0004 = Retirement

This event runs daily in the afterhours. You need to
choose the days you want letters generated for closed
accounts. Any day of the month can be used; however,
only 10 days can be entered in the provided fields, as
shown below. 

Each day has a separate event number. The first day's
event number is 5050, the second is 5051, third is 5052,
fourth is 5053, fifth is 5054, sixth is 5055, seventh is 5056,
eighth is 5057, ninth is 5058, and tenth is 5059. 

Any closed account will create an event record on the day
you specify. For example, if you want a letter to generate
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Event Event
Number

Event Letter Description

on the first day an account is closed and every week after,
then type a “1,” “8,” “15,” “22,” “29,” and “30” in the fields
below Closed Accounts. If an account is going to reach a
specified date on a non-processing day, it will be pulled in
the processing day before it reaches the date specified in
the provided fields. 

Excessive
Returns

5070-5079

5170-5179
(No Mail -
see Option
box above)

0001 = Checking
0002 = Savings
0003 = Certificate
0004 = Retirement

This event runs in the afterhours either monthly, quarterly,
or semi-annually. Select “M = Monthly," “Q = Quarterly,"
or “S = Semi-Annually" in the Run Parameter field, as
shown below. 

Any account where the date of last return is in the prior
week/month will be considered. The weekly option will run
on Fridays, using Saturday as the start of the week. The
monthly option will run on the last processing day of the
month. If Friday is a non-processing day, then this event
will run before, on Thursday when using the weekly
option. 

This event is based on the total life-to-date returns
calculated by adding life-to-date returned checks
(DMRALD) with life-to-date returned ACH items
(DMRCLD). These fields are found on the Deposits >
Account Information > Activity Information screen). If
numbers 5, 10, and 15 are entered in the fields under
Excessive Returns, then accounts with five through nine
returns will be event number 5070; accounts with 10
through 14 returns will be event number 5071; accounts
with 15 or more returns will be event number 5072. This
continues through all 10 spaces in the provided fields (see
example above).

Event Event
Number

Event Letter Description

These last events are easier to set up and only require you
to check the box in front, as shown below:
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Event Event
Number

Event Letter Description

Interest
Posting

1010
1110 (No
Mail - see
Option box
above)

Same as Interest
Destination found
on the Deposits >
Account
Information >
Interest Fields
screen.

This event runs daily in the afterhours. All accounts that
pay interest in the afterhours will create an event. You are
able to select events to print by letter or number. This
allows you to choose between printing and not printing
certain interest destinations. 

Dormant
Accounts

1020
1120 (No
Mail - see
Option box
above)

0001 = Checking
0002 = Savings
0003 = Certificate
0004 = Retirement

This event runs in the daily afterhours on the last
processing day of the month. It creates an event record for
all dormant accounts that became dormant during the past
month.

Inactive
Accounts

1030
1130 (No
Mail - see
Option box
above)

0001 = Checking
0002 = Savings
0003 = Certificate
0004 = Retirement

This event runs in the daily afterhours on the last
processing day of the month. It creates an event record for
all inactive accounts that became inactive during the past
month.

Account
Renewal

1040
1140 (No
Mail - see
Option box
above)

Same as product
code number

This event runs daily in the afterhours. An event record is
created for renewable certificates on the last day of the
grace period. The Average Percentage Yield (APY) is
computed, based on the number of days in the term and
the interest amount that is calculated. This is a projected
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Event Event
Number

Event Letter Description

APY based on the amount of interest the CD will earn in
the next year. 

Starting from the last maturity roll date (DMLMRD), the
interest frequency, method, anniversary, options, and
interest at maturity are all used in calculating the
projected amount of interest for the next year. In leap
years, institution options B366 and NOMT will also be
used in the calculation. If the CD's term is for less than
one year, a full year's interest will still be calculated as if
the CD will be renewed to stay open for one year, and in
order to analyze it for the APY.

Deposit Box
Billing
(Daily)

1050
1150 (No
Mail - see
Option box
above)

0001 = if no
account to charge

0002 = if account
is charged

This event runs daily. An event record is created on the
night of the due date for each safe deposit box. The only
fields used in creating this event letter are as follows:

Box Branch Number
Box Number
Last Activity Date
Amount Due
Due Date
Account Number (if there is one tied to deposit billing)

You cannot select “Daily” and “Monthly” at the same time.

Sort Letters by Box Office
If the Sort Letters by Box Office field is checkmarked,
the following numbers are used:

Event Letter: The safe deposit box office number

Event Numbers:

Mail No Mail

No account to charge 1051 1151

Account is charged 1052 1152

Deposit Box
Billing
(Monthly)

1051, 1052
1151, 1152
(No Mail -
see Option
box above)

The letter number
is the safe deposit
box office number.

This event runs monthly. All boxes with a due date in the
next month will be pulled. The only fields used in creating
this event letter are as follows:

Box Branch Number
Box Number
Last Activity Date
Amount Due
Due Date

You cannot select “Daily” and “Monthly” at the same time.
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Event Event
Number

Event Letter Description

Sort Letters by Box Office
If the Sort Letters by Box Office field is checkmarked,
the following numbers are used:

Event Letter: The safe deposit box office number

Event Numbers:

Mail No Mail

No account to charge 1051 1151

Account is charged 1052 1152

Deposit Box
Past Due

1060
1160 (No
Mail - see
Option box
above)

None, unless the
Sort All Letters
By Box Office
field is checked. In
which case, the
safe deposit box
office number is
shown.

This event runs in the daily afterhours on the last
processing day of the month. It creates an event record for
all safe deposit boxes with billing at least one month
overdue. The total amount past due will be calculated. The
only fields used in creating this event letter are as follows:

Box Branch Number
Box Number
Last Activity Date
Amount Due
Due Date
Account Number (if there is one tied to the deposit box)

Sort All Box
Letters by
Box Office

See
description
.

The letter number
is the safe deposit
box office number.

This option is used with the Safe Deposit Box events
above. If the Sort All Letters by Box Office field is
checkmarked, the following numbers are used:

Event Letter: The safe deposit box office number

Event Numbers:

Mail No Mail

No account to charge 1051 1151

Account is charged 1052 1152

Account
Holds 
(Monthly)

1070
1170 (No
Mail - see
Option box
above)

Letter number
entered on the
Deposits >
Account
Information >
Restrictions and
Warnings screen.

If this box is checkmarked, this event runs in the daily
afterhours on the last processing day of the month. It
creates an event record for hold codes expiring in the next
month. An event record is only created if the hold code
has a letter number in the Document field on the Deposits
> Account Information > Restrictions and Warnings
screen. The same account can have multiple hold event
letters created if there are several holds expiring in the
same month.
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Event Event
Number

Event Letter Description

Account
Holds  (Daily)

1070
1170 (No
Mail - see
Option box
above)

Letter number
entered on the
Deposits >
Account
Information >
Restrictions and
Warnings screen.

If this box is checkmarked, this event will run in the daily
afterhours. It creates an event record for hold codes
expiring on the same date in the following month. An event
record is only created if the hold code has a letter number
in the Document field on the Deposits > Account
Information > Restrictions and Warnings screen. The
same account can have multiple hold event letters created
if there are several holds expiring in the same month.

MMDA Limit
Exceeded

1080
1180 (No
Mail - see
Option box
above)

0005 = Savings
account

0006 = Money
market account

This event runs daily in the afterhours. Any money market
account, general category 5 or 6, will create an event
record on the last day of its cycle if it has exceeded the
transaction limits. The transaction limit is six withdrawals.
Checks, withdrawals, POS, transfers (DMFXCY), and
GOLDPhone transfers (DMGTPN) (all on the Deposits >
Account Information > Activity Information screen, Deposit
Activity tab) are added together to get total withdrawals.

W-8 Form
Expiration

1090
1190 (No
Mail - see
Option box
above)

0001 = Checking
0002 = Savings
0003 = Certificate
0004 = Retirement

This event runs in the daily afterhours on the last
processing day of the month. It creates an event for all
accounts with a W-8 form on file that has an expiration
date in the next month.

You can use alternate addresses to mail the W-8
Expiration Form to addresses different from all other
mailings for your accounts. Alternate addresses are set up
in CIF. 

W-4P
Notification

2010
2110 (No
Mail - see
Option box
above)

None This event was designed to meet the regulations on
notifying IRA owners of their right to change the
withholding on their distributions. If the distributions are
quarterly or more frequently, your institution needs to
notify the customer annually. If the distributions are less
frequently than quarterly, the customer needs to be
notified with each distribution but not more than six
months before the distribution.

Customer-directed transfer records are read to find
retirement distribution frequencies and scheduled
distribution dates. This event has an annual run date
determined by your institution and entered in the Run
Options column next to the W-4P Notification field. On
the annual date, an event record is created for all
retirement accounts in distribution with a distribution of
quarterly or more frequently. This event also runs at each
quarter-end. At this time, an event record is created for
frequencies less often than quarterly, if the scheduled
distribution is from three to six months in the future.

Required
Minimum

2020
2120 (No

None This event will run the same night the required minimum
distribution (RMD) update takes place, which is the last

https://secure.goldpointsystems.com/gpsdocs/deposits/DepositCIMGOLD/index.asp?depositactivitytabdaiactinfo.asp
https://secure.goldpointsystems.com/gpsdocs/deposits/DepositCIMGOLD/index.asp?depositactivitytabdaiactinfo.asp
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Event Event
Number

Event Letter Description

Distribution Mail - see
Option box
above)

processing day of the year. If there are errors in
calculating the RMD, or the RMD is on another plan, no
event record will be created. You can refer to the Required
Minimum Distribution Calc Reporting Report (FPSDR041)
to determine what retirement plans had errors in
calculating the RMD. Events will also be generated on the
test run of the RMD update that is usually run in November
of each year, as scheduled by your institution.

Club Account
Payouts

2030
2130 (No
Mail - see
Option box
above)

None This event runs in the afterhours on the last processing
day of the month. Any club account with a payout date in
the next month will create an event record.

70 ½ During
Current Year

2090
2190 (No
Mail - see
Option box
above)

None This event has an annual run date determined by your
institution. Any retirement account in which the owner will
be 70½ years of age during the current calendar year will
create an event record. This condition will occur only in the
calendar year the owner will be 70½ years of age and not
in subsequent years.

Note: You must notify GOLDPoint Systems if you use
this letter, because an Update Function 53 must coincide
with this event.

Address
Change

2040
2140 (No
Mail - see
Option box
above)

None Check the Address Change box on the Deposit Event
Setup screen in GOLDVision (GOLD Services, function
36) to generate an event record any time any part of the
address mailing lines change for an open deposit or loan
account, as shown below. 

Note: Institution options OP15-ADEV and OP16-ALEV
must both be set to "Y" before you can process the
address change event for both deposits and loans.
Contact your GOLDPoint Systems account manager to
have those options turned on for your institution.

If multiple accounts are tied to the same address, an event
record will generate for the IRS owner tied to each account
with that mailing address. One letter per IRS owner will be
created. 

Letters should be sent to the “old” address (remember this
when creating your mail merge document). The
mnemonics are as follows:

OLD_MAILING_LINE_1

https://secure.goldpointsystems.com/gpsdocs/deposits/ReportsCIM/fpsdr041.asp
https://secure.goldpointsystems.com/gpsdocs/deposits/ReportsCIM/fpsdr041.asp
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Event Event
Number

Event Letter Description

OLD_MAILING_LINE_2
OLD_MAILING_LINE_3

The “new” address should be indicated in the body of the
letter using the new mailing line mnemonics. The
mnemonics are as follows:

NEW_MAILING_LINE_1
NEW_MAILING_LINE_2
NEW_MAILING_LINE_3

Only one account number for each IRS owner per address
change will be available for the event, and all mailing
address changes tied to deposit and loan accounts are
included.

For CIF clients, a letter will be created for the regular
account address or the alternate address, whichever one
is in effect at the time of the change. 

Note: Events generated for loan accounts are still
generated in the Deposit Events system. All 2040 address
change events, regardless of whether they are a deposit or
loan, will be generated in the Deposit Events system. If a
loan event letter is ordered, it will show on the history for
the loan.

If you are already using the address change event letter,
but want to add loan accounts, please send in a work
order and the minimum one-time fee will be assessed. If
you want to begin using the address event letter for the
first time, send in a work order and a $450.00 one-time fee
will be assessed for the use of this event. Be sure to
indicate if you want loan accounts included.

Setting Up GOLD EventLetters (Deposits)

To use the GOLD EventLetters system, you need to set up merge-letter templates on your PC using the

Microsoft Word® Mail Merge function, and link them to a data source file. The data file is created in the
afterhours process using GOLDPoint Systems’s host computer. The data file is a result of either automatic
events occurring on one or several accounts, or a result of user-requested events. 

An event occurs when a pre-defined event affects an account or when you manually request an event letter.
Some examples are when a CD account matures, a change of address, or a new account opening. Up to 255
events can be created this way, with each event having a possibility of 255 letters. Currently, the following
events have been defined and are available in the Deposit GOLD EventLetter Processing (see Deposit Event
Descriptions for a full description of each event). See the Tying Data Source Files to Event Letters help for more
information.
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Event # Description

1010
1020
1030
1040
1050-1052
1051
1060 
1070 
1080 
1090 
2010 
2020 
2030 
2040 
2050
2090
3010-3019 
4010 
4020 
4030
5010-5019 
5030-5039 
5050-5059 
5070-5079

Interest Postings
Dormant Accounts
Inactive Accounts
Account Renewals
Safe Deposit Box Billing (Daily)
Safe Deposit Box Billing (Monthly)
Safe Deposit Box Past Due
Account Holds Expiration Dates (Daily, Monthly)
MMDA Limit Exceeded
W-8 Form Expiration
W-4P Notification
Required Minimum Distribution
Club Account Payouts
Address Change
Check Stop Payment
70 ½ During Current Year
Account Hold Effective Dates
Account Maturities
Account Escheatment
Safe Deposit Box Escheatment
Negative Balance Accounts
New Accounts
Closed Accounts
Excessive Returns

Note: Additional events can be identified and merged with user-created databases. This process is described in
the Copying to Event Letter Files help.

Once the event letter templates have been set up with merge fields that match their corresponding data file, all
that is left to do is merge the data file and letter together. This is done using the GOLD EventLetters program.
See Assigning Merge Letters to Events for more information.

The following event fields are currently available for use:

Event Date
Event Number
Event Letter 
Account Office
Account Number
Amount Due
Box Branch Number
Box Number
Check Digit
Due Date
Formatted Account 
IRS Owner Title
IRS Owner Name 
IRS Owner Suffix
IRS Owner SSN 
Mail Address Line 1
Mail Address Line 2 

Club Payout Freq 
Club Payout Holdback
Current Balance 
Cycle High Balance
Cycle Low Balance 
Cycle Start Date
Date Acct Went Neg 
Date Closed
Date Int Last Paid 
Date Last Return
Date Last W4 Notif 
Date of Last ACH
Date of Last ATM 
Date of Last Deposit
Date of Last WD 
Date Opened
Deposit Type 

No WD Cycle
No Xfer Cycle 
Nxt Cycle Start Date
OD Fee Pcnt Of Xfer 
Officer Code
Old Account Number 
Opening Balance
OTC Checks in Cycle 
Overdraft Fee Code
Overdraft Amt Code 
Overdraft Inc Amt
Payout Date
Plan Number 
Product Code
Product Code Desc 
Rate Offset
Reason Charge Waived 
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Mail Address City 
Mail Address ZIP 
Mail Address ZIP 4
Label Line 1 
Label Line 2
Label Line 3 
Label Line 4
Label Line 5
Label Line 6
Last Activity Date 
IRS Owner First Name
IRS Owner Middle Name 
IRS Owner Last Name
1st Owner First Name 
1st Owner Middle Name
1st Owner Last Name 
2nd Owner First Name
2nd Owner Middle Name 
2nd Owner Last Name
3rd Owner First Name
3rd Owner Middle Name 
3rd Owner Last Name
Amt of Last Deposit 
Amt of Last Withdrawal
APY 
Anticipated Balance
Base Rate
Bonus Expiration Date
Bonus Rate 
Book Balance
Closing Reason Club 

Dormancy Date
End of YR Balance 
Escheatment Date
Federal WH Amount
Fed WH Fixed Amount
Fed WH Percentage
General Category
Grace End Date
Hold Action Code
Hold Action Eff Date 
Hold Action Exp Date
Inactive Date
Interest Rate
Last Activity Date 
Last Cust Contact Date
Last Mat Roll Date 
Last Overdraft Date
Last Srvc Chrg Date 
Last Tran Date
Limit Checks in Cyc 
Ltd Returned ACH
Ltd Returned Checks 
Ltd Returned Items
Maturity Date 
Maximum Rate
Minimum Balance 
Minimum Rate
Monthend Balance 
Negative Bal Limit
Next Maturity Date 
Next Product Code
No Checks This Cyc

Returned ACH Cyc
Returned Chks Cycle
Secured Account (This will print
X’s based on your institution’s
account number option. The last
four digits of the account number
will display, as will the check
digit.) 
Source of Funds
Srvc Chrg Eff Date 
State WH Amount
State WH Fixed Amnt 
State WH Min Amount
State WH Percentage 
Sub Category
Term 
Term Type
Transaction Amount 
Transaction Date
Transaction Desc 
Transfers in Last Yr
Transfers Out Lst Yr 
Uncollected Funds
W8 Expiration Date 
YTD Interest
YTD Int Prior Yr 
YTD Returned ACH
YTD Returned Checks 
YTD Penalty
YTD Service Chrgs 
YTD Transfers In
YTD Transfers Out

After the letters have been merged, GOLD EventLetters allows you to preview the event letters before you print
them. You can choose to print all the letters at once or print selected letters.

GOLD EventLetters will save the event letters to the "HAVE BEEN PRINTED" folder on your PC hard drive. The
letters will stay there until you move them into the "ARCHIVED EVENTS" folder or delete them. Both folders are
installed on the PC at the same time the program is installed.

Note: For more information concerning the set up of deposit event letters, please refer to the GOLD EventLetters
Setup Procedures help.

Secondly, the Deposit GOLD EventLetter Report (FPSDR500) needs to be set up to generate the event records.
Job Control Language (JCL) also needs to be added to the afterhours. A work order must be sent to GOLDPoint
Systems to have the report and JCL set up for your institution.

GOLD EventLetters will automatically delete event records more than seven days old and event records created
the same day when a re-run occurs, and write an account file maintenance record for each event.

https://secure.goldpointsystems.com/gpsdocs/deposits/ReportsCIM/fpsdr500.asp
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GOLD EventLetters Setup Procedures

The following sections explain how to set up the GOLD EventLetters program on your PC:

· Setup guides you through some of the initial setup process.

· Tying Data Source Files to Event Letters explains what a data source file is and then how to tie data
source files to your event letters, while 3-Up Notices gives step-by-step instructions for setting up to three
notices per page.

· Assigning Merge Letters to Events shows you how to tie your merged letter (data source file tied to event
letter) to an event number. In addition, this section provides you with an example of a merged letter before
and after the data is filled in.

· Past Due Notices are specific to sending out notices to customers whose payments are past due.

Setting Up the GOLD EventLetters System

Setting up the GOLD EventLetters process takes a few steps, and once you have completed the setup, there
are only a few occasions when you may have to repeat some of the steps. Those occasions are:

· If you need to create a new merge letter file.
· If you need to change or add a letter-to-data file assignment.

Please see Tying Data Source Files to Event Letters for information on how to create or change your letters or
their assignments.

Before using GOLD EventLetters for the first time, some options need to be set up on your PC. Once these
options are set up on a PC, you do not need to set them up again on that PC.

NOTE 

Your institution must have the Event Letter Report (FPSRP175) set up for the data file
to be created for the Loan system, and the Deposit GOLD EventLetter Report
(FPSDR500) for the Deposit system. If you do not have these reports set up, please
submit a work order. For more information concerning specific needs of the Loan and
Deposit systems with regards to GOLD EventLetters, see:

Deposit System

Loan System

For deposit event letters, Job Control Language (JCL) also needs to be added to the
afterhours. A work order must be sent to GOLDPoint Systems to have the report and
JCL set up for your institution.

https://secure.goldpointsystems.com/gpsdocs/loans/LoanReports/llr175.asp
https://secure.goldpointsystems.com/gpsdocs/deposits/ReportsCIM/fpsdr500.asp
https://secure.goldpointsystems.com/gpsdocs/deposits/ReportsCIM/fpsdr500.asp
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GOLD EventLetters will automatically delete event records more than seven days old
and event records created the same day when a re-run occurs, and write an account
file maintenance record for each event.

To set up these options on your computer, follow the steps below:

1. Select “Event Letter Options” from the Options menu. The options dialog will appear as shown below.

2. Verify which system you want to pull event letters from by selecting either the "Deposit," "Loan," or
"GOLDTrak PC" radio buttons. Depending on which system you select, only event letters from that
system will be available to download in GOLD EventLetters. 

3. The Days Back to View for Download Events field on the Options dialog allows you to select how far
back in history you want to download events. You can select a number from “1” to “7.” This option resides
on your computer, so it will be different for each user.

4. If you want to separate event files into their respective offices, click the Separate Event Files for Offices
checkbox on the Options dialog.

5. Select <OK> to update GOLD Event Letters.

Now you are ready to set up where you want event letters to be downloaded. The following steps explain how
to do this.

6. Select “Folders” from the Options menu and the Folders dialog will appear as shown below (see
description of each of the folders following the screen example).  

7. Names and paths for five folders will be displayed. These folders and paths were created during the
installation process. These paths are the folders where your data source files will be sent, and where you
will save your letters and log files. You may change the path, including changing the path name, to a
folder found on your network. However, if you share event letter files amongst many computers at your
institution, some additional setup is required. See Sharing the Assign Event Letters List for more
information.

8. Verify that the paths for each folder are correct and click <OK>.
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See the following descriptions of the five folders:

Folder Description

Folder for Events to Be
Printed:

This is where you will save the Microsoftâ Word letter that you created and
merged with data source files downloaded from GOLD EventLetters. See
Printing and Saving Event Letters for more information.

Folder for Events that
Have Been Printed:

Once letters have been printed for events, this folder displays a log of all the
events that were printed on a given day.

Folder of Events that
Have Been Archived:

If you move events from the Events that Have Been Printed list to the Archived
Events list on the Print Event Letters screen, this folder displays the log that
was previously in the HaveBeenPrinted folder.

Folder of Event Merge
Letters:

This is the folder to where you will save event letters when you initially create
them in Microsoftâ Word. You need to create merge fields where the finished
data will go, such as customers' names, account balances, etc. The merge
fields are pulled from the data source files (see below). These letters will later
be assigned to specific events in GOLD EventLetters. See Tying Data Source
Files and Assigning Merge Letters to Events for more information. Any letter
you create must be saved in this folder. Otherwise, the event letter process will
not work.

Folder of Event Data
Source Files:

This is the source directory of event letter data files that will be the default "data
source" for your word processor merge letter files. This is where the data
(fields) to be merged into the letters are stored. You must first download events
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Folder Description

from GOLD EventLetters before they will be displayed in this folder. See
Downloading Event Records for more information.

Tying Data Source Files

The following instructions describe how to use the Mail Merge function in Microsoft® Word 2010 to tie the data
source files generated by GOLD EventLetters into letters you create in Word to be sent to your customers. 

The data source file is where the loan fields are stored. The data source file is generated by GOLD EventLetters
when you log on to that program and download the day's events. You must first download events in GOLD
EventLetters before you can proceed with the steps outlined in this section. 

There is one data file for each event. Each file (event) has specific fields available that can be used in the event
letter. For example, loan event 1 is an ARM event. The data file has fields used specifically for ARM
adjustments such as the next P/I, the amortized principal balance, date of next rate change, etc. Many fields
are calculated in the "afterhours" process. Appendix A lists all common fields available for each loan event, as
well as each field available for each of the loan events. The Deposit Event Descriptions section lists all fields for
deposit events. 

You can modify existing letters already on your PC or create new letters. As you create the letter and save it, or
if you modify an existing letter already on your PC, save the letter to the "Merge Letters" folder in the following
location: C:\Program Files (x86)\FPSGOLD\GOLDEventLetters\EventLetterFolders\MergeLetters. Then you can
print the letters using GOLD EventLetters. 

The following steps will explain how to tie a new or existing letter to its merge fields.

1. Open Microsoft Word from the Start menu or your desktop. Microsoft Word will open with a blank document.

2. Click the Mailings tab, then click Select Recipients, and then select "Use Existing List."
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The Open Data Source screen will appear.

3. In the Look in field at the top of the Open Data Source screen, navigate to the following location (for
Windows 7 or higher): 

C:\Program Files (x86)\FPSGOLD\GOLDEventLetters\EventLetterFolders\DataSourceFiles

4. Click the down arrow in the Files of Type field at the bottom of the Open Data Source screen, and select
"All Files." All the events generated by GOLD EventLetters will now appear (see following example).
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LMASTERXXXX.EVM or DMASTERXXXX.EVM

· "D" or "L" represents the event system from where you are working. "D" is for deposits, and "L" is for
loans.

· Following the word "MASTER" in the file name, the next four characters represent the event number.
· The file extension, ".EVM", represents an event letter master source file.

Tip: If you want to use a data source file of your own making (from an Excel file, Report
Writer, GOLDWriter data files, etc.), see Copying Events.

5. Double-click on the data source file (the event) you want to use. You will be returned to the blank Word
document, and the Insert Merge Fields drop-down list will be file maintainable on the Mailings tab, as
shown in the following example. 
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6. If you are beginning a new letter, you would begin the letter at this point. Once you are ready to insert a
merge field, proceed to the next step.

If you are using an existing letter, place the cursor at the desired insertion point, and then proceed to the
next step.

7. Click the Insert Merge Field drop-down list located on the Mailings tab. A list of fields available for that
event will appear, as shown in the previous example.

8. At the desired insertion point in the letter, select the first field you want from the Insert Merge Field drop-
down list.  When you select the field, the system will automatically place the field in the letter for you.
Continue inserting fields in your letter, wherever needed, until you are finished. For an example of a finished
letter, see Finished Letter.

Remember: Merge fields displayed in this list view are tied to specific events. If a field you want to use is not
listed, you will need to talk to your GOLDPoint Systems account manager and ask about programming more
fields for particular events.

9. Save the finished letter that includes the merge fields in the Merge Letters folder by choosing "Save As" from
the File menu. 

For Windows 7 and above users, the Merge Letters folder is located at:
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C:\Program Files (x86)\FPSGOLD\GOLDEventLetters\EventLetterFolders\MergeLetters

You may want to include the event record number in the drop-down File name field.  For example, if you
were finishing an event letter that welcomed new loan customers (event 21), you would enter “E21 L00
Welcome Letter” for the name of the letter.

10. Close Microsoftâ Word by clicking the X in the upper-corner of the application.

Now you are ready to assign the merge letter to a specific event.

See also:  Past Due Notices

3-Up Notices

It is possible to create two or three event letters per page (commonly known as 3-up event notices) by
completing the following steps. 

1. Create section 1 by following steps 1-8 in Tying Data Source Files.

Note: You must have version 1.1.2 or higher of GOLD EventLetters to print 3-up letters.

2. On the line above where you want the second and third sections of the 3-up notice to appear, put
the <Next Record> merge field in your document in MicrosoftÒ Word. This indicates the end of
section 1 and the beginning of section 2, and the end of section 2 and the beginning of section 3.

To insert a <Next Record> field into your letter, on the Mailings tab, click Rules, and then select "Next
Record" (as shown below).

3. Copy and paste the information from section 1 into section 2.
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4. Insert another <Next Page> break from the Rules drop-down list, and then paste the information
from section 1 into section 3.

 TIP: Use perforated paper to separate the notices easier.

For an example of a finished 3-up letter, see Example of 3-up Letter.

Example of 3-Up Letter

The following are examples of a 3-Up letter. The first example displays the merge fields and the second
letter displays the complete letter as it will appear after being printed with your customers' actual data.

Example of 3-Up Letter with Merge Fields:

Past Due Notice
Past Due Since  «DUE_DATE»                                            
Loan Number:  «FORMATTED_LOAN_NUMBER»

«IRS_OWNER_FIRST_MIDDLE_LAST_NAME»
«MAIL_ADDRESS_LINE1»
«MAIL_ADDRESS_LINE2»
«MAIL_ADDRESS_CITY_STATE_ZIP»

Your payment is now delinquent. A late fee has been assessed and is also due. Your immediate
attention in this matter is necessary. You are hereby notified that a negative credit report reflecting on
your credit record may be submitted to a credit reporting agency if you fail to fulfill the terms of your
credit obligations.

Amount past Due:  «TOTAL_PAYMENTS_DUE»   
Late Charges:   «LATE_CHARGES»

Total Amount Due :  «TOTAL_PMTS_WITH_LATE_CHARGES»

«Next Record»

Past Due Notice
Past Due Since  «DUE_DATE»                                          
Loan Number: <<FORMATTED_LOAN_NUMBER>>

«IRS_OWNER_FIRST_MIDDLE_LAST_NAME»
«MAIL_ADDRESS_LINE1»
«MAIL_ADDRESS_LINE2»
«MAIL_ADDRESS_CITY_STATE_ZIP»

Your payment is now Delinquent. A late fee has been assessed and is also due. Your immediate
attention in this matter is necessary. You are hereby notified that a negative credit report reflecting on
your credit record may be submitted to a credit reporting agency if you fail to fulfill the terms of your
credit obligations.

Amount past Due:  «TOTAL_PAYMENTS_DUE»   
Late Charges:   «LATE_CHARGES»
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Total Amount Due :  «TOTAL_PMTS_WITH_LATE_CHARGES»

«Next Record»

Past Due Notice
Past Due Since  «DUE_DATE»                                        
Loan Number: «FORMATTED_LOAN_NUMBER»

«IRS_OWNER_FIRST_MIDDLE_LAST_NAME»
«MAIL_ADDRESS_LINE1»
«MAIL_ADDRESS_LINE2»
«MAIL_ADDRESS_CITY_STATE_ZIP»

Your payment is now Delinquent. A late fee has been assessed and is also due.  Your immediate
attention in this matter is necessary. You are hereby notified that a negative credit report reflecting on
your credit record may be submitted to a credit reporting agency if you fail to fulfill the terms of your
credit obligations.

Amount past Due:  «TOTAL_PAYMENTS_DUE»   
Late Charges:   «LATE_CHARGES»

Total Amount Due :  «TOTAL_PMTS_WITH_LATE_CHARGES»

Example of Finished 3-Up Letter:

Past Due Notice
Past Due Since  12-01-2012                   
Loan Number:  0001-023455-01

MINDY MILLIONS 
123 CASH STREET
PROVO  UT   84608         

Your payment is now Delinquent. A late fee has been assessed and is also due.  Your immediate
attention in this matter is necessary. You are hereby notified that a negative credit report reflecting on
your credit record may be submitted to a credit reporting agency if you fail to fulfill the terms of your
credit obligations.

Amount past Due:  331.33
Late Charges:   10.57

Total Amount Due :  341.90

Past Due Notice
Past Due Since  12-01-2012
Loan Number:  0001-123456-02

GERALD GOOGLER 
777 DICE WAY
PROVO  UT   84604
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Your payment is now Delinquent. A late fee has been assessed and is also due.  Your immediate
attention in this matter is necessary. You are hereby notified that a negative credit report reflecting on
your credit record may be submitted to a credit reporting agency if you fail to fulfill the terms of your
credit obligations.

Amount past Due:  399.18     
Late Charges:   18.51

Total Amount Due :  417.69

Past Due Notice
Past Due Since  12-01-2001
Loan Number:  0001-001122-03

BARRY BILLIONAIRE    
700 MANSION 2, SUITE 4
OREM  UT   84058

Your payment is now Delinquent. A late fee has been assessed and is also due. Your immediate
attention in this matter is necessary. You are hereby notified that a negative credit report reflecting on
your credit record may be submitted to a credit reporting agency if you fail to fulfill the terms of your
credit obligations.

Amount past Due:  191.46 
Late Charges:   7.51

Total Amount Due :  198.97

Example of Finished Letter

The following examples show a letter with the merged fields followed by an example of a letter with a
customers' actual data filled in. For more information on how to print event letters, see Printing and Saving
Event Letters.

For information on creating 3-Up letters, see 3-Up Notices.

Example of Letter with Merged Fields:

<<EVENT_DATE>>

<<IRS_OWNER_FIRST_MIDDLE_LAST_NAME>>
<<MAIL_ADDRESS_LINE1>>
<<MAIL_ADDRESS_CITY_STATE_ZIP>>

Dear <<IRS_OWNER_FIRST_NAME>>:

Welcome to GOLDPoint Systems Finance Company. We thank you for giving us the opportunity
to serve your financial needs.  If you have any questions about your account
<<FORMATTED_LOAN_NUMBER>>, please feel free to call.

At this time, we would like to confirm that we have entered your information correctly.  Our
records show your beginning balance of <<ORIGINAL_PRINCIPAL_BALANCE>> and your Social
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Security number as <<IRS_OWNER_SSN>>.  If these are not correct, call one of our account
representatives.

This loan opened on <<DATE_OPENED>> for a term of <<TERM>> <<TERM_TYPE>>, with an
interest rate of <<INTEREST_RATE>>.  This loan will mature on <<MATURITY_DATE>>.

Sincerely,

John Doe
<<OFFICER TITLE>>

<<EVENT_NUMBER>>/<<EVENT_LETTER>> 

Example of Finished Letter with Data Filled In: 

03-10-2013

Polly W. Cracker
620 Pelican Drive
Provo, UT 84604

Dear Polly:

Welcome to GOLDPoint Systems Finance Company. We thank you for giving us the opportunity
to serve your financial needs. If you have any questions about your account 0001 1112223 04,
please feel free to call.

At this time, we would like to confirm that we have entered your information correctly. Our
records show your beginning balance of $6,000.00 and your Social Security number as 123-45-
6789. If these are not correct, call one of our account representatives.

This loan opened on 02-27-2013 for a term of 12 months, with an interest rate of 8.75000.  This
loan will   mature on 02-27-2014.

Sincerely,

John Doe
New Accounts Manager

E21/L00
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Past Due Notices (Loan events 44, 45, and 46)

Past Due Notices can be generated and printed by GOLDPoint Systems, or you can choose to generate the
letters yourself and print them at your institution. GOLD EventLetters allows you to generate, create, and print
past due notices to your customers from your institution.

Creating your past due notices in GOLD EventLetters eliminates any delay getting notifications to your
customers; notices can be printed and mailed the same day (after the nightly afterhours has run). It also allows

you to control the verbiage and appearance of your notices by setting up the wording in Microsoft® Word, which
eliminates any delay when a form change is needed from GOLDPoint Systems.

Note: Past Due Notices can either be automatically generated using the Notice Type fields on the Late/NSF
tab of the Account Detail screen, or you can manually request late notices using the Event, Letter, and Date
fields on the Actions/Holds/Event Letters screen. However, if you do set up late notices manually from the
Actions/Holds/Event Letters screen, you must have a Letter number as well. See the Events field description
on the Action/Holds/Event Letters screen for more information.

To automatically generate late notice records in GOLD EventLetters, you will need to do the following:

1. Create your notices in Microsoft® Word by following the steps in Tying Data Source Files.  

2. Request that your loan account manager turn on events 44, 45, and/or 46 (institution option EVNT).

3. Input the applicable event code (event codes 44, 45, 46) in the Notice 1, 2, 3 Type fields located on the
Late/NSF tab of the Loans > Account Information > Account Detail screen in CIM GOLD (as shown below).
Also include the days after the due date when the notices will be generated by entering the days in the
Notice 1, 2, 3 Days fields. For example, the notice type displayed in Notice 1 Type will be generated in
GOLD EventLetters in the afterhours of the 10th day after the due date if "10" is displayed in Notice 1 Days.
The notice type displayed in Notice 2 Type will be generated on the 15th day after the due date if "15" is
displayed in Notice 2 Days. The notice type displayed in Notice 3 Type will be generated on the 25th day
after the due date if "25" is displayed in Notice 3 Days. 

https://secure.goldpointsystems.com/gpsdocs/loans/LoansCIMGOLD/index.asp?holds_1-4_ahel.asp
https://secure.goldpointsystems.com/gpsdocs/loans/LoansCIMGOLD/index.asp?event1-5_ahel.a
https://secure.goldpointsystems.com/gpsdocs/loans/LoansCIMGOLD/index.asp?latensftab_lads.asp
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Loans > Account Information > Account Detail Screen, Late/NSF Tab

Contact your loan account manager if programming help is needed to populate these fields. You will also
need to modify any loan patterns containing this information as well as GOLDTrak PC, if applicable.

4. Determine if you would like a separate report reflecting late notices only and notify your loan account
manager to set up FPSRP018. If a separate report is not needed, any notices generated to accounts will be
included in the Event Letter Report (FPSRP175) with other event letters generated on the same day. 

Important:  You can use some or all of the events, but each event is only valid in the specified field, as
follows:

Event 44 is ONLY valid in the Notice 1 Type field.
Event 45 is ONLY valid in the Notice 2 Type field.
Event 46 is ONLY valid in the Notice 3 Type field.

Note:  Events 44, 45, and 46 will not generate for loans with the following hold codes:

Hold Code Description

1 Foreclosure completed

2 Charge-off

4 Bankruptcy - Chapter 7, 11, or 12

5 Bankruptcy - Chapter 13

6 Deed in lieu of foreclosure

7 Legal hold, but only if accompanied with
charge-off

9 Legal hold or in Foreclosure

https://secure.goldpointsystems.com/gpsdocs/loans/LoanReports/llr018.asp
https://secure.goldpointsystems.com/gpsdocs/loans/LoanReports/llr175.asp
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Hold Code Description

27 Loan in Default

90 Judgment, but only if accompanied with
charge-off

92 Voluntary Surrender

93 Repossession by Grantor

If you do not want event letters 44, 45, or 46 generated for an account, make sure the Notice Type fields on
the Account Detail > Late/NSF tab are blank. 

Loans with a general category of 80 and above or loans with an origination code of 3, 15, or 16 (loans
purchased/serviced by others) will not create event letters.

Past Due Notice Report Options

Past due notices generated through GOLD EventLetters will appear on the Event Letter Report (FPSRP175)
with other event letters generated on the same day. Notify your GOLDPoint Systems loan account amanger
if you would like this report set up for your institution.  

A separate past-due notice only report (FPSRP018) can be run daily identifying the accounts that had
notices generated in GOLD EventLetters. Refer to the Loan Reports Manual in DocsOnWeb for examples of
both reports.

GOLDPoint Systems Only:

A separate Past Due Notice report (FPSRP018) can be generated
for notices generated through GOLD EventLetters with the following
modifications to the report setup:

Pull field 12 (Late Notice Code 1) must include notice code 44.
Pull field 13 (Late Notice Code 2) must include notice code 45.
Pull field 14 (Late Notice Code 3) must include notice code 46.

To create a follow-up date for events, enter a number from 0 to 99 in
positions 5–6 of the Miscellaneous Parameters field for
FPSRP175. 

https://secure.goldpointsystems.com/gpsdocs/loans/LoanReports/llr175.asp
https://secure.goldpointsystems.com/gpsdocs/loans/LoanReports/llr018.asp
https://secure.goldpointsystems.com/gpsdocs/loans/LoanReports/llr018.asp
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Working with GOLD EventLetters

Use GOLD EventLetters to download the event record files needed to create the merge fields in Microsoftâ

Word, to print the letters, and more. See the following sections.

· Downloading event records.

· Assigning Merge Letters to Events

· Printing and saving event letters.

· Copying events.

· Blocking certain events.

· Sorting separate events into offices.

Downloading Event Records

The following steps explain how to download your event letters from GOLD EventLetters.

Note: You will need to select which system you want to work with before completing these steps. If you want to
download events from the Deposit system, Loan system, or GOLDTrak PC system, first select that system by
accessing the Options > Event Letter Options menu. The options dialog will appear, as shown below, where you
can select which system to download events.

1. From the Functions menu, select "Download Events." You can also click the Download Events icon on the

toolbar .

The Download Event Files screen will appear displaying all the event records created the previous night by
the overnight processing. It will also display those event records that were created on previous days. The
following example shows event records created by the host. 
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The Information Message field displays the progress of the download. It also displays when the download is
completed and any errors that are found. 

This field will also display the following message if the Block Events feature is set up on your computer:
“Block-Events-Feature-Activated.” See Blocking Certain Events for more information concerning blocked
events.

The default sort order is by the most recent date first, with ascending event letter and ascending account
number within each event.

The records will remain on the host for seven calendar days.

Note: The information downloaded to this screen will change according to whether you are downloading
deposit, loan, or GOLDTrak PC events. See Setting Up GOLD EventLetters for more information.

2. Once all the event records are shown, select one of the two radio buttons labeled Select specific records
from the list above or Select group records from criteria below. 

When selecting Select specific records from the list above, a single or group of records can be
selected. 

When selecting Select group of records from criteria below, a group of event records for a certain date
can be selected. The Event Date field will accept only dates. Enter the event number or the word "ALL" in
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the Event Number field; enter the letter number or the word "ALL" in the Letter Number field; and enter the
office number or the word "ALL" in the Office Number field.

3. Click <Download> to begin downloading the event letter data files from the host. 

A message box will appear if you have previously downloaded the same event and letter for that date. Press
<Yes> if you want to overwrite the file event or <No> if you do not want to overwrite it.

Note: The message box will appear only if you have previously downloaded the same event and letter for a
given date on this PC.

Once the event records are downloaded, they are saved as a data source file in the following location on your
computer:

C:\Program Files (x86)\FPSGOLD\GOLDEventLetters\EventLetterFolders\DataSourceFiles

Use these data source files to include as merge fields in Microsoftâ Word, as explained in the Tying Data
Source Files section. 
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Assigning Merge Letters to Events

Once you have created your letter in Microsoft Word (as explained in the Tying Data Source Files to Event
Letters help), you can tie a specific letter to the event number and event letter number you want using GOLD
EventLetters. The following steps explain how to do this.

Note: If sharing one directory for letters amongst many computers at your institution, see Sharing the Assign
Event Letters List for setup procedures to ensure all computers see the same event letters.

1. From the Functions menu in the GOLD EventLetters system, select “Assign Event.” You can also click the

Assign Events icon found on the toolbar . The Assign Event Letters screen will appear displaying the
event and letter numbers that have already been assigned or “tied to” a specific merge letter. (If none have
been assigned, the Merge Letter File column will be blank.)

2. Click <Add New Event> or <Change Events>. The Assign Event Letter Number to Merge Letter File screen
will appear (as shown below).
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3. Type the needed data in the Event, Letter, Office, Event Letter Description fields at the top of the screen.

Note: The Office field will only be file maintainable if you have the Office option set on the Options dialog
(select "Event Letter Options" from the Options menu). See the Setting Up the GOLD EventLetters System
help section for more information on the Options dialog.

4. From the Select the merge letter file to be used to print this event from the list below field, highlight a
merge letter file by left-clicking on one from the list.

Note: You should have already created a letter before these steps, using Microsoft Wordâ, as explained in
the Tying Data Source Files to Event Letters help.

5. Click <OK>. This returns you to the Assign Event Letters screen.

You can continue to add new events or change event assignments from the Assign Event Letters screen by
clicking <Add New Event> or <Change Events>.

6. The next step is to print the available letters found on the Print Event Letters screen. This process is
explained in the Printing Event and Saving Event Letters help. 

See the examples of a letter with the merged fields and a letter with data filled in. 

See also instructions and examples of a 3-Up letter.
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Sharing the Assign Event Letters List

When the GOLDEvent Letters software application is going to be run by an institution on more than one PC,
very often it is desired that the Assign Event Letters List be the same on each PC. The following steps can be
taken to standardize each machine. 

1. On one of the institution’s PC’s, assign the Events, Offices (if desired), and Descriptions to the appropriate
Merge Letter File. (This is explained in the Assigning Merge Letters to Events topic.) 

2. Close the GOLD EventLetters program. 

3. Open Windows® Explorer and go to the following GOLDEventLetters folder: 

C:\Program Files\FPSGOLD\GOLDEventLetters 

4. Copy the evntopts.ism file and the EventLetterFolders folder to a shared network folder.

5. Once you have pasted the evntopts.ism file and EventLetterFolders folder into this shared network folder,
highlight the network address, right-click your mouse, and select "Copy" (see below).

6. Find your GOLD EventLetters program icon used to open GOLD EventLetters (either through the Windows
Start, icon on your desktop, or icon in your System Tray) and right-click to select "Properties" (see below). 
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The GOLD EventLetters Property dialog will be displayed.

7. On the Shortcut tab, paste the network address you copied above into the Start in field, then click <OK>.
(Important: Keep the quotes around the location and make sure to end with a backslash, as shown below.)
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8. The next time you start GOLDEvent Letters, your application will use the evntopts.ism file found in the
shared network folder. All of your machines will have the same "assigned events" and will read and be
updated by this file, as changes are made.

Part II: Synchronizing the Options Folders

If your institution elects to use its network server as the machine to save the GOLDEvent Letter folders to,
please follow these steps. Each machine that is running the GOLDEvent Letters program needs to standardize
its GOLDEvent Letter Options Folders to read the network server. 

1. On one of your institution’s PC’s, open the GOLD EventLetters, then open the Folders dialog box by
selecting "Options > Folders" from the top menu bar.

2. Click the browse icon and find the place on the network where you saved your files and folders on the
network drive (this was done in steps 4-5 above. Do that for each of the folders listed, making sure to select
the appropriate folder for the applicable task, as shown below:
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3. Click <OK> then close GOLD EventLetters.

Printing and Saving Event Letters

The following steps explain how to print and save your finished event letters from GOLD EventLetters.

1. Select "Print Event Letters" from the Functions menu. You can also click the Print Event Letters icon found

on the toolbar. 

The Print Event Letters screen will appear displaying three windows of letters (see following example):

· Events To Be Printed
· Events that Have Been Printed
· Archived Events
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Note: In the example above, see how the Description for two letters is "Undefined!" That means those events
have not be assigned to a merge letter. See Assigning Merge Letters to Events to complete these steps and
eliminate the Undefined! error.

2. To preview event letters, highlight the line item from the Events To Be Printed window, then click the
<Preview Selected> button. 

A preview of the letter in Microsoftâ Word of what is to be printed will appear. (Letters can only be previewed
from the Events To Be Printed list.)
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Tip: If you get the following message in Word after clicking <Preview Selected>,

Do the following:

1. From the Field delimiter field, select "Tab."
2. From the Record delimiter field, select "(enter)."
3. Click <OK>.

This error is a Word error that usually no longer appears after designated the above
fields.

WARNING: To close this window, you must click on the <Go Back> button located in the upper-right corner
of your Preview screen, as shown below. 
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3. Click <Go Back> and click <Save As Finished Letter(s)> on the Print Event Letters screen. Microsoftâ Word
will automatically open again displaying the final merged letter.

Microsoftâ Word automatically merges the data from GOLD EventLetters with a letter you previously set up
in Word. Refer to Tying Data Source Files for more information.

4. Save the finished merged letters in the ToBePrinted folder by choosing “Save As” from the File menu in
Microsoftâ Word. The ToBePrinted  folder is located at:

C:\Program Files (x86)\FPSGOLD\GOLDEventLetters\EventLetterFolders\HaveBeenPrinted

Be sure to enter the name of the letter or group of letters in the drop-down File name field, as shown below.
For example, you should enter “02-15-13 3rd Late” which represents the third late notice letters from
February 15, 2013. We recommend that you put the date first and then the description so that the saved
letters will sort in order by date within folders. See the following example:
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5. Click <Save> to save your entry.

6. Click <Go Back> to return to the GOLD EventLetters program. 

7. Select the event(s) you want to print letters for in the Events To Be Printed list, then click <Print Selected>
to print all the letters to your customers. 

Once printed, the event will be displayed in the Events that Have Been Printed list, as shown below:



GOLDEvent Letters76

© 2019 GOLDPoint SystemsLast updated: 11/25/2019

Any item in any of the three lists shown on the Print Event Letters screen can be moved from one list to another
simply by clicking on the event and dragging it into a new list.

The system will place a log file of the printed event in the HaveBeenPrinted folder on your C: drive. If you move
items to the Archived Events list, the system will move the log file to the Archived Events folder on your C: drive.



GOLDEvent Letters 77

© 2019 GOLDPoint Systems Last updated: 11/25/2019

Copying events

GOLD EventLetters allows you to copy an existing data source file to a GOLD EventLetters file. This function
will convert an ASCII-delimited file to an event letter data source file. For example, when you want to do a
mailing and have a Report Writer file, GOLDMiner file, or GOLDWriter file already set up, you would use this
function.

1. From the Functions menu, select “Copy to Event File.” You can also click the "Copy to Event File" icon on

the toolbar . 

The Copy to event file screen will appear (as shown below).

2. In the File to copy into a new event file field, type the path and file name of the data source file you want
to become an event letter data file. This file could have been created with Report Writer, Report Manager,
GOLDWriter, or GOLDMiner. The file could also be an existing data source file that you are already using.

WARNING: The data source file must be in ASCII-delimited format for the “Copy to event file” process to
work. Using a tab delimiter will work the best.

3. Type the event date in the Event Date field, the event number in the Event # field, the letter number in the
Letter Number field, and if using the office number option, enter the office number in the Office field.

4. Click <Copy>. The program will make a copy of the file specified in the File to copy into a new event file
field, and save it in the To-Be-Printed Event folder. This file copy will be named based on the event date,
event number, letter number, and office number (if used) entered in the fields provided. An event master
source file is created in the Master Source Files directory.

5. Now either create or modify the letter, and tie it to its data source file (as explained in the Tying Data
Source Files to Event Letters help section).

6. Print the letter using the GOLD EventLetters application.
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Blocking certain events

GOLD EventLetters allows you to block certain events from being downloaded into the program. These blocks
that you set up reside on the host computer (GOLDPoint Systems’s computer), so they will affect your entire
institution. As events that are available for download are being read for display, the blocks you set up are
searched. If the event letter fits the criteria set by a block, it will not display as an event available to be
downloaded in the Download Event Files window. 

The following steps explain how to block events from being downloaded:

1. Select “Block Events” from the Options menu, or click the Block Events icon on the toolbar . The Block
Events screen will display (as shown below).

2. Click <Add> to add an event to be blocked. If you just want to change a block that has already been
entered, select the block by clicking on it in the list, then click <Edit>. The Event Filter Detail dialog will
appear whether you click <Add> or <Edit> (see the following example).
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3. Enter the applicable information in the fields provided on the Event Filter Detail dialog. You can enter
numbers, hyphens, or commas to specify letters and/or range of letters to be blocked. If you need to block
all letters for a certain event, click the All Letters checkbox to display a checkmark.

You can also disable the blocked events (i.e., allow the events to be able to be downloaded again) by
clicking the Enabled checkbox on the Event Filter Detail dialog, or by placing a checkmark next to the
blocked event on the Block Events screen (see previous example).

4. Click <OK> to process your changes or additions. You will be returned to the Block Events screen, and your
blocked events should appear in the list. From this screen you can add, edit, or delete events to be blocked,
or click <Close> to exit out of the screen.

Now those events will be blocked from being downloaded. When you access the Download Event Files
screen, the message "Block-Events-Feature Activated" will appear in the Information Message field.

Note: If you are discontinuing the use of an event, do not use the block events feature. Contact your
GOLDPoint Systems account manager to have the event permanently disabled from being printed from
GOLD EventLetters.
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Sorting separate events into offices

GOLD EventLetters allows you to set up multiple letters for the same event. For example, you may want a
separate letter for each office. Some setup is required before you can download specified events for individual
offices. 

To set up this feature:

1. Check the Separate Event Files for Offices checkbox field on the Options dialog (as shown below).

 

· If this box does not contain a checkmark, the Office field will be read-only on the Assign Event Letter
Number to Merge Letter File window. 

· If no office is assigned, the Office column on the Assign Event Letters window will be blank, and this
merge letter assignment will be the default if no document is assigned for a particular event-letter-office
combination.

2. Click <OK>.

Contact your GOLDPoint Systems account manager if you would like to use this feature and for any additional
assistance.
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Appendix A - Merge Field Descriptions (Loans)

The data source files generated by GOLD EventLetters are merged into letters using Microsoft® Word's Mail
Merge function. The data source file from GOLD EventLetters is used to create a list of fields that can be

inserted into letters. See Tying Data Source Files for more information on how to use Microsoft® Word's Mail
Merge function to create letters.

Each letter has specific merge fields just for that letter. For example, the Loan Maturity Event Letter (event 26),
contains the merge field called <<TOTAL_DUE_AT_MATURITY>>.

This appendix lists all the available loan event letters and the merge fields available for each letter. After you
perform the steps outlined in Tying Data Source Files, the GOLD EventLetters merge fields will appear in
Microsoft Word on the Mailings tab, then click Insert Merge Fields, and the available fields for that event will
appear in the drop-down list (see the following example).

Every event also has Common Fields, CIF fields, and Basic Loan Fields available to be placed into letters. 
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QUICK TIP

The field descriptions available for each event includes a mnemonic. If you want to know exactly where
the information for that field is pulled from in CIM GOLD, you can search for that mnemonic in the
Master Help, as described in the following steps:

1. In the CIM GOLD program, select "Master Help Search" from the Help menu at the top of the
screen.

The following dialog box is displayed:

2. Click the Search tab, and in the search field, type the mnemonic, then click <List Topics>. All
matching occurrences of that mnemonic will be listed. 

3. Click any of the listed topics, and the help for that mnemonic will be displayed.

The screen where you can find that field (or mnemonic) is listed in the help topic, as highlighted in
the example below:
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The following is a summarized list of the loan event numbers and their descriptions. For information about
deposit events, see Deposit Event Processing.

Event # Event Letter Description How Created

1 ARM Accrual Rate Up, Rate Caps automatic

2 ARM Accrual Rate Down, Rate Caps automatic

3 ARM Accrual Rate Up, Payment Change, Rate
Caps

automatic

4 ARM Accrual Rate Down, Payment Change, Rate
Caps

automatic

5 Daily Simple Interest Rate Change automatic

6 ARM Accrual Rate Down automatic

7 ARM Accrual Rate Down, Payment Change automatic

10 ARM Accrual Rate Up automatic

11 ARM Accrual Rate Up, Payment Change automatic

13 Reserve Tax Payment Letter automatic

14 Payoff requested from the Loans > Payoff
screen

15 LIP Billing automatic

16 LIP Billing Reminder requested

17 ARM Accrual Rate Up, Payment Change, Rate
Caps, Lifetime Caps

automatic
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18 ARM Accrual Rate Down, Payment Change, Rate
Caps, Lifetime Caps

automatic

19 ARM Accrual Rate Up, Payment Change, Lifetime
Caps

automatic

20 ARM Accrual Rate Down, Payment Change,
Lifetime Caps

automatic

21 New Loan automatic/requested

22 Closed Loan automatic/requested

23 Delinquency Event requested

24 Specialty Request Letter requested

25 Prenotification of Loan Maturity (institution defined
days before automatic maturity date)

automatic/requested

26 Loan Maturity (at maturity) automatic/requested

27 Balloon Payment automatic

28 Beneficiary Statement requested

29 Loan Sold requested

30 Buydown Payment Change (subsidy) automatic/requested

31 Buydown Expiration (subsidy) automatic/requested

32 Insurance Letter (before expiration date) automatic/requested

33 Over-Credit-Limit Notification (LOC) automatic/requested

34 ARM (adjustable rate mortgage) automatic

35 FHA Payoff letter (insured prior to August 2, 1985) automatic/requested

36 FHA Payoff letter (on or after August 2, 1985) automatic/requested

40 ARM (adjustable rate mortgage) automatic

41 Payment Check when LIP Letter automatic

42 LIP Rate Change automatic

43 Charge Interest on Negative Reserves Billing requested

44 First Late Notice automatic

45 Second Late Notice automatic

46 Third Late Notice automatic

47 Consumer Insurance Event automatic

48 Loan Miscellaneous Fee Assessment Notice automatic

49 Loan Miscellaneous Fee Reminder requested

50 PMI requested

51 Late Charge Assessment automatic

60 One-time Electronic Payment automatic

61 Cancelled Event Letter automatic
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Common Fields (All Events)

The following event fields are currently available for use in generating GOLD EventLetters for the Loan system.
These fields are common to all loan events.

Branch Fields:

Merge Field Field
Mnemonic/
Calculation

From Screen Description

BRANCH ADDRESS
LINE 1

OBADD1 GOLD Services > Office
Information

Address line 1 where the office is
located

BRANCH ADDRESS
LINE 2

OBADD2 GOLD Services > Office
Information

Address line 2 where the office is
located

BRANCH CITY STATE
ZIP

OBCITY,
OBSTAB,
OBZIPC, OBZIP4

GOLD Services > Office
Information

City, state, ZIP, and ZIP+4 where
the office is located

BRANCH MANAGER
NAME

ONNAMF GOLD Services > Office
Information

Adds the name of the branch
(office) manager to the event letter.
A Manager/Employee Number
must be entered on the GOLD
Services > Office Information
screen in order for it to be pulled
for the event letter.

BRANCH NAME OBFNAM GOLD Services > Office
Information

Name or description of office

BRANCH PHONE
NUMBER

OBPHAC,
PBPHPF,
OBPHON

GOLD Services > Office
Information

Phone number for the office
formatted (xxx) xxx-xxxx

ORIGINATION OFFICER LNOFCR Loans > Account
Information > Additional
Loan Fields screen,
Origination/Maturity tab.

Adds the name of the originating
officer to the event letter

SERVICING OFFICER MLLSOR Loans >
Actions/Holds/Event
Letters screen

The loan servicing officer who last
changed, added, or deleted an
action code, hold code, or event
letter code on the account.

Common Fields:

Merge Field Field
Mnemonic/
Calculation

From Screen Description

EVENT DATE LNEVDT,
LNEVD2-5

Loans > Account
Information > Actions/Holds

This is the date the event was generated.
See Requesting Loan Event Letters.
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Merge Field Field
Mnemonic/
Calculation

From Screen Description

Event Letters

EVENT NUMBER LNEVNT,
LNEVN2-5

Loans > Account
Information > Actions/Holds
Event Letters

This is the event number that was
generated. See Requesting Loan Event
Letters.

EVENT LETTER LNELNO,
LNELN2-5

Loans > Account
Information > Actions/Holds
Event Letters

This is the letter number of the event that
was generated. See Requesting Loan
Event Letters.

FORMATTED
LOAN NUMBER

Loans > Account
Information > Actions/Holds
Event Letters

This is the loan number as formatted by
your institution (e.g., 11 123456 01).

CIF Fields (All Events)

The fields pulled from the CIF (Customer Relationship Management in CIM GOLD) are used in all loan events
generated by GOLD EventLetters. The following is a list of available CIF fields.

Note: If a name has a mailing exception of "Do Not Mail" in CIF, the name information will not be sent to the
GOLD EventLetter system.

Merge Field Field Mnemonic/
Calculation

From Screen Description

ACCOUNT FIRST
MIDDLE LAST NAME 1

Customer Relationship
Management > Customer
Profile Entity
Maintenance to Name

First middle last name of name 1
on account

ACCOUNT FIRST
NAME 1

PNFNAM Customer Profile or
Households

First name of name 1 on acct

ACCOUNT LAST NAME
1

PNLNAM Customer Profile or
Households

Last name of name 1 on acct

ACCOUNT SUFFIX 1 PNSFFX Customer Profile or
Households

Suffix of name 1 on acct

ACCOUNT FIRST
MIDDLE LAST NAME 2

Customer Profile or
Households

First middle last name of name 2
on account

ACCOUNT FIRST
NAME 2

PNFNAM Customer Profile or
Households

First name of name 2 on account

ACCOUNT LAST NAME
2

PNLNAM Customer Profile or
Households

Last name of name 2 on account

ACCOUNT SUFFIX 2 PNSFFX Customer Profile or
Households

Suffix of name 2 on account
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Merge Field Field Mnemonic/
Calculation

From Screen Description

ACCOUNT FIRST
MIDDLE LAST NAME 3

Customer Profile or
Households

First middle last name of name 3
on account

ACCOUNT FIRST
NAME 3

PNFNAM Customer Profile or
Households

First name of name 3 on account

ACCOUNT LAST NAME
3

PNLNAM Customer Profile or
Households

Last name of name 3 on account

ACCOUNT SUFFIX 3 MNSFFX Customer Profile or
Households

Suffix of name 3 on account

ACCOUNT FIRST
MIDDLE LAST NAME 4

Customer Profile or
Households

First middle last name of name 4
on account

ACCOUNT FIRST
NAME 4

PNFNAM Customer Profile or
Households

First name of name 4 on account

ACCOUNT LAST NAME
4

PNLNAM Customer Profile or
Households

Last name of name 4 on account

ACCOUNT SUFFIX 4 PNSFFX Customer Profile or
Households

Suffix of name 4 on account

IRS OWNER FIRST
MIDDLE LAST NAME

Customer Profile or
Households

IRS owner’s first middle last
name

IRS OWNER FIRST
NAME

PNFNAM Customer Profile or
Households

IRS owner’s first name

IRS OWNER LAST
NAME

MNLNAM Customer Profile or
Households

IRS owner’s last name

IRS OWNER MIDDLE
NAME

MNMNAM Customer Profile or
Households

IRS owner’s middle name

IRS OWNER SSN MNCSSN Customer Profile or
Households

IRS owner’s social security
number

IRS OWNER SUFFIX MNSFFX Customer Profile or
Households

IRS owner’s suffix

IRS OWNER TITLE MNTITL Customer Profile or
Households

IRS owner’s title

MAIL ADDRESS CITY MNCITY Customer Profile or
Households

Mailing address city

MAIL ADDRESS CITY
STATE ZIP

Customer Profile or
Households

Mailing address city, state and
ZIP

MAIL ADDRESS LINE1 MNADD1 Customer Profile or
Households

Mailing address line 1
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Merge Field Field Mnemonic/
Calculation

From Screen Description

MAIL ADDRESS LINE2 MNADD2 Customer Profile or
Households

Mailing address line 2

MAIL ADDRESS STATE MNSTAB Customer Profile or
Households

Mailing address state

MAIL ADDRESS ZIP MNZIPC Customer Profile or
Households

Mailing address ZIP code

MAIL ADDRESS ZIP4 MNZIP4 Customer Profile or
Households

Mailing address ZIP plus 4

NUMBER DWELLING
UNITS

LODWEL Number of dwelling units on the
property securing the loan

LABEL LINE 1 Use Label Lines 1-6 instead of
name and address lines to
eliminate blank lines from
appearing between the borrower
names and address lines.

WARNING: If Label Lines are
used, then all six must be set up
in the letter. Basically, the
number of street address lines on
the account determines how
many name lines will be printed,
and up to four names will be
printed depending on how many
address lines are used. 

LABEL LINE 2

LABEL LINE 3

LABEL LINE 4

LABEL LINE 5

LABEL LINE 6

LEGAL DESCRIPTION Ten repetitions of this field.
Displays the first nine lines of the
legal description or 540
characters, whichever comes
first.

PROPERTY ADDRESS
CITY

MNCITY Customer Profile or
Households

City where the property is located

PROPERTY ADDRESS
CITY STATE ZIP

Customer Profile or
Households

Property address city, state and
ZIP
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Merge Field Field Mnemonic/
Calculation

From Screen Description

PROPERTY ADDRESS
LINE1

MNADD1 Customer Profile or
Households

Address line 1 where the property
is located

PROPERTY ADDRESS
LINE2

MNADD2 Customer Profile or
Households

Address line 2 where the property
is located

PROPERTY ADDRESS
STATE

MNSTAB Customer Profile or
Households

State where the property is
located

PROPERTY ADDRESS
ZIP

MNZIPC Customer Profile or
Households

ZIP where the property is located

PROPERTY ADDRESS
ZIP4

MNZIP4 Customer Profile or
Households

ZIP plus 4 where the property is
located

Branch Fields:

Merge Field
Field
Mnemonic/
Calculation

From Screen Description

BRANCH ADDRESS
LINE 1

OBADD1 GOLD Services > Office
Information

Address line 1 where the
office is located

BRANCH ADDRESS
LINE 2

OBADD2 GOLD Services > Office
Information

Address line 2 where the
office is located

BRANCH CITY STATE
ZIP

OBCITY,
OBSTAB,
OBZIPC,
OBZIP4

GOLD Services > Office
Information

City, state, ZIP, and ZIP+4
where the office is located

BRANCH MANAGER
NAME

ONNAMF GOLD Services > Office
Information

Adds the name of the branch
(office) manager to the event
letter. A
Manager/Employee
Number must be entered on
the GOLD Services > Office
Information screen in order
for it to be pulled for the
event letter.

BRANCH NAME OBFNAM GOLD Services > Office
Information

Name or description of office

BRANCH PHONE
NUMBER

OBPHAC,
PBPHPF,
OBPHON

GOLD Services > Office
Information

Phone number for the office
formatted (xxx) xxx-xxxx

ORIGINATION OFFICER LNOFCR Loans > Account Information >
Additional Loan Fields screen,
Origination/Maturity tab.

Adds the name of the
originating officer to the
event letter
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Merge Field
Field
Mnemonic/
Calculation

From Screen Description

SERVICING OFFICER MLLSOR Loans > Actions/Holds/Event
Letters screen

The loan servicing officer
who last changed, added, or
deleted an action code, hold
code, or event letter code on
the account.

Basic Loan Fields

Merge Field Field Mnemonic/
Calculation

Description

ACCRUED INTEREST LNACIN Accrued interest on loan

APPOINTMENT DATE EVACDT Date used with action code 210; only for
event 23 and 24

APPOINTMENT TIME EVTIME Time used with action code 211; only for
event 23 and 24

APPRAISAL AMOUNT LNAPAM Appraisal amount

APPRAISAL DATE LNAPSR Appraisal date

ARM 1ST RATE CHANGE
DATE

LN1ROL Date of 1st rate roll

ARM ACCRUAL RATE LNAMRT Accrual rate on loan

ARM ACCRUAL RATE
LIFETIME MAX

LNAMHI Maximum rate allowed on loan

ARM ACCRUAL RATE
LIFETIME MIN

LNAMLO Minimum rate allowed on loan

ARM ACCRUAL RATE MAX
PTS DOWN

LNAMRD Maximum points per period the rate can
decrease

ARM ACCRUAL RATE MAX
PTS UP

LNAMRU Maximum points per period the rate can
increase

ARM ACCRUAL RATE
OFFSET

LNAMOF Accrual rate offset

ARM MAX PRINCIPAL
BALANCE

LNAMMX Maximum principal balance that the loan is
allowed to reach

ARM NEXT ACCR RATE
CHANGE DATE

LNAMDT Next rate change date

ARM P/I PAYMENT CHANGE
DATE

LNPIEF Next P/I change date
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Merge Field Field Mnemonic/
Calculation

Description

ASSET CLASSIFICATION LNACLS Asset classification

BALLOON DATE Date used with action code 1

BANK ROUTING NUMBER LNABNK Bank routing/transit number

BANK SOURCE ACCOUNT
NUMBER

LNANBR Savings or checking that will be debited for
loan payment

COLLATERAL DESCRIPTION LNCLDS Collateral description

CURRENT LTV LNPBAL + LNBAL2 / LNSELL
OR / LNAPAM

Current loan-to-value ratio which is the
principal balance plus the secondary
balance divided by the lesser of the selling
price or the appraisal amount. If the selling
price or appraisal amount fields are zero, the
field with a value will be used for the
calculation.

DATE INTEREST PAID TO LNPDTO Date interest is paid to

DATE LAST ACCRUED LNDLAC Date of last interest accrual

DATE LAST LATE LNLTDT Date of last late charge assessment

DATE OF LAST CHECK Date used with action code 212

DATE OPENED LNOPND Date the loan was opened

DEALER NAME DELNAM If this loan was originated through a dealer,
you can insert this field to display the dealer
name, pulled from the Loans > Account
Information > Dealer Information screen.

Note: The dealer information must be
maintained on the Dealer Setup > Dealers
screen. If you need an init to place the
dealer name in the letter, contact your
GOLDPoint Systems client solutions
specialist.

DEALER NUMBER MLLNUM This field displays the dealer number of the
dealer who sold this loan account, pulled
from the Loans > Account Information >
Dealer Information screen.

Note: The dealer information must be
maintained on the Dealer Setup > Dealers
screen. If you need an init to place the
dealer name in the letter, contact your
GOLDPoint Systems client solutions
specialist.

DUE DATE LNDUDT Loan due date
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Merge Field Field Mnemonic/
Calculation

Description

EFFECTIVE RATE X LNAMRT OR 
LNRATE OR 
LNLRAT

Loan effective rate: interest rate; accrual
rate; LIP rate for LIP method code 1 or 101

EXTRA PRINCIPAL LNOPMT Amount of extra principal to be added to the
principal

FORMATTED LOAN NUMBER Uses a formatted loan number that includes
the office, account number, and check digit
(e.g. NNNN-NNNNNN-NN). Events 44, 45,
and 46 can use the ACCOUNT NUMBER
merge field, which displays the office number
and account number only (not the check
digit). 

FIRST DUE DATE LN1DUE Date the first payment is due

GRACE DAYS LNLTGR This field contains the number of days after
the due date and before a payment is made
that are allowed on the loan before the late
charge is assessed. Pulled from the Loans >
Account Information > Account Detail screen
> Late/NSF tab.

INSURER CODE LNINSU Insurer code

INTEREST CALCULATION
CODE

LNIBAS Base to use to calculate loan interest

INTEREST RATE LNRATE Annual interest rate or payment rate for
payment method 7 loans

INVESTOR GROUP LNIGRP Investor group number

INVESTOR MASTER LNIMST Investor master number

INVESTOR NAME IMNAM Investor name

LATE CHARGES LNLATE Late charges on loan

LATE CHARGES AND FEES LNLATE + LNFEES Late charges plus total loan fees

LATE CHARGES
PROJECTED

CALC LATE Projected late charges for current payment

LATE RATE LNLTRT Late rate

LINE OF CREDIT LIMIT LNRLCL Line of credit limit

LIP ACCRUED INTEREST LNLACC LIP accrued interest

LIP CUSTOMER BALANCE LNCBAL LIP customer balance

LIP DISBURSED BALANCE LNPBAL - LNLBAL LIP disbursed balance
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Merge Field Field Mnemonic/
Calculation

Description

LIP INTEREST RATE LNLRAT LIP interest rate

LIP LIFETIME MAX LNLMAX LIP lifetime maximum rate

LIP LIFETIME MIN LNLMIN LIP lifetime minimum rate

LIP RATE OFFSET LNLOFF LIP rate offset

LIP UNDISBURSED
BALANCE

LNLBAL Amount of funds not yet disbursed

LOAN FEES LNFEES Total loan fees

LOAN OFFICER NUMBER LNOFCR Loan office number

MATURITY DATE LNMATD Loan maturity date

MISCELLANEOUS FUNDS LNMISC Loan miscellaneous funds

NEXT PAYMENT DUE CALC Next payment due on the account

NEXT PAYMENT PRINCIPAL
PORTION

Calculated Principal portion of current next payment

NEXT PAYMENT INTEREST
PORTION

Calculated Interest portion of current next payment

NEXT PMT WITH EXTRA
PRINCIPAL

CALC NEXT PYMT  +
LNOPMT

Calculated next payment plus extra principal

NUMBER PAYMENTS
DELINQUENT

RUN DATE - LNDUDT +
1 / LNFREQ

Month’s difference between current run date
and due date plus one divided by the loan
frequency. Bi-weekly loans calculate the
number of payments delinquent by taking
the days’ difference between the run date
and due date divided by 14 plus one.

ORIGINAL PRINCIPAL
BALANCE

LNOBAL Original principal balance

P/I CONSTANT LNPICN Principal/interest constant

PARTIAL OR APPLIED TO
PAYMENTS

LNPRTL Partial or applied to payments

PAYMENT FREQUENCY LNFREQ Loan payment frequency

PER DIEM PODIEM One day’s interest calculated by taking the
principal balance multiplied by the effective
rate divided by the interest base. This only
displays two decimal places. If you want to
use three decimal places, use PER DIEM 3
DECIMALS (see below) instead.



GOLDEvent Letters94

© 2019 GOLDPoint SystemsLast updated: 11/25/2019

Merge Field Field Mnemonic/
Calculation

Description

PER DIEM 3 DECIMALS PODIEM Use this field if you want to display the per
diem with three decimal places instead of
two. If you only want to show the per diem
with two decimal places, use the PER DIEM
merge field above instead. 

PRIME LOWER LIMIT LNPSLO Minimum rate allowed on loan after adding
index rate plus margin

PRIME UPPER LIMIT LNPSHI Maximum rate allowed on loan after adding
index rate plus margin

PRINCIPAL BALANCE LNPBAL Principal balance on loan

PROJECTED PMT PRINCIPAL
PORTION (for ARM loans)

Calculated Principal portion of the projected payment

PROJECTED PMT INTEREST
PORTION (for ARM loans)

Calculated Interest portion of the projected new
payment

RATE OFFSET MARGIN LNROFF Interest rate offset margin

RATE ROUNDING FACTOR LNRRND Prints the rounded rate factor, such as
1//4th, 1/8th, 1/10th, 1/16th, or none. This
information is pulled from the Round Rate
To Nearest field (LNRRND) on the Loans >
Account Information > Account Detail screen
in CIM GOLD.

REMAIN PORTION DUE LNRPDU Remaining unpaid portion of payment

REMAINING TERM LNTERM / LNFREQ - LNINNO Remaining term on the loan

Loan term divided by the loan frequency
minus the installment number. 

For bi-weekly loans, take the term in months
divided by 12 multiplied by 26 to get the
number of payments. Subtract the
installment from the number of payments to
get remaining payments. Take remaining
payments divided by 26 then multiply by 12
to get remaining term in months.

RESERVE 1 BAL PLUS
RESERVE 2 BAL

LNR1BL + LNR2BL Sum of Reserve 1 and 2 balances

RESERVE 1 BALANCE LNR1BL Reserve 1 balance

RESERVE 1 CON PLUS
RESERVE 2 CON

LNR1CN + LNR2CN Sum of Reserve 1 and 2 constants

RESERVE 1 CONSTANT LNR1CN Reserve 1 constant



GOLDEvent Letters 95

© 2019 GOLDPoint Systems Last updated: 11/25/2019

Merge Field Field Mnemonic/
Calculation

Description

RESERVE 2 BALANCE LNR2BL Reserve 2 balance

RESERVE 2 CONSTANT LNR2CN Reserve 2 constant

SECURED ACCOUNT
NUMBER 

Places X’s in part of the account number,
e.g., XXXX-XX1234-12 

SECURITY ACCOUNT LNSECX Deposit account that secures the loan

SUBSIDY BALANCE LNSBAL Subsidy balance

SUBSIDY CONSTANT LNSCON Subsidy constant

TERM OF LOAN LNTERM Term of the loan

TIMES 30 LATE LAST 12
MONTHS

BU12M 30+ days late in the last 12 months

TIMES 60 LATE LAST 24
MONTHS

BU24M 60+ days late in the last 24 months

TIMES LATE LNLTNO Number of times the loan has been late

TIMES LATE 10 TO 29 LNLT10 Number of times over life of loan payment
has been made 10-29 days after due date

TIMES LATE 30 TO 59 LNLT30 Number of times over life of loan payment
has been made 30-59 days after due date

TIMES LATE 60 TO 89 LNLT60 Number of times over life of loan payment
has been made 60-89 days after due date

TIMES LATE 90 OVER LNLT90 Number of times over life of loan payment
has been made 90+ days after due date

TIMES LATE LAST 2 YEARS LNDELQ Times late in past 2 years

TOTAL DUE CALC PMTS + LNLATE + 
LNFEES - LNPRTL +
LNRPDU

For payment method 3 or 6
loans with option OP01 ILF6
set to "Y," the total due is
calculated as follows:

PMTS + LNLATE +  LNFEES
- LNPRTL + LNRPDU + 
LNPDUE + LNVPRN

All payments (principal, interest and
reserves) that are due (all payments where
the loan due date is less than or equal to the
run date) plus late charges and loan fees
minus partial plus remaining portion due;
payment method 5 all payments that have
been billed (total of all billings on the billing
screen) plus late charges and loan fees plus
remaining portion due; LIP loans use prior
unpaid charges plus late charges and loan
fees.

TOTAL DUE AFTER GRACE CALC PMTS + LNLATE +
LNFEES - LNPRTL +
LNRPDU

All payments (principal, interest, and
reserves) where the due date plus grace
days is less than or equal to the run date
plus late charges and loan fees minus partial
plus remaining portion due; pmth 5 all



GOLDEvent Letters96

© 2019 GOLDPoint SystemsLast updated: 11/25/2019

Merge Field Field Mnemonic/
Calculation

Description

For payment method 3 or 6
loans with option OP01 ILF6
set to "Y," the total due is
calculated as follows:

PMTS + LNLATE + LNFEES -
LNPRTL + LNRPDU +
LNPDUE + LNVPRN

payments that are billed (total of all billings
on the billing screen) where the due date
plus grace days is less than or equal to the
run date plus remaining portion due plus late
charges and fees; LIP loans only include late
charges and loan fees.

TOTAL DUE TO BALLOON
OR MATURITY

LNPBAL + CALC INT +
LNLATE + LNFEES - LNR1BL
- LNR2BL - LNSBAL - LNR1AI
- LNR2A1 - LNMISC +
NIR1AC + NIR2AC - LNLBAL
- LNCBAL - LNPTRL
(EXCLUDING MTHD 5 OR 6)

Total due (includes all charges due) to the
lesser of the balloon date or the maturity
day. If no balloon date or maturity date,
interest will be calculated to the run date.
This uses the current principal balance.

Also see TOTAL DUE AT MATURITY
(LETT01) for events 25, 26, and 27. It
amortizes payments to maturity date. When
the payments are amortized, the system
makes pseudo-payments so the principal
balance used is the amortized balance
instead of the current principal balance. 

TOTAL INT TO BALLOON OR
MATURITY

CALC INT Total interest due to the lesser of the balloon
date or the maturity date. If no balloon or
maturity date, interest will be calculated to
the run date.

TOTAL PAYMENTS DUE CALC PMTS Total payments due (principal, interest, and
reserves) where the loan due date is less
than or equal to the run date

TOTAL PMTS W FEES AND
LATE CHGS

CALC PMTS + LNLATE +
LNFEES

Total payments due (principal, interest, and
reserves) where the loan due date is less
than or equal to the run date plus late
charges and loan fees

TOTAL PMTS W FEES AND
PARTIAL

CALC PMTS + LNFEES -
LNPRTL

Total payments due (principal, interest, and
reserves) where the due date is less than or
equal to the run date plus loan fees minus
partial

TOTAL PMTS W LATE AND
PARTIAL

CAL PMTS + LNLATE -
LNPRTL

Total payments due (principal, interest, and
reserves) where the loan due date is less
than or equal to the run date plus late
charges minus partial 

TOTAL PMTS WITH LATE
CHARGES

CAL PMTS + LNLATE Total payments due (principal, interest, and
reserves) where the loan due date is less
than or equal to the run date plus late
charges
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Merge Field Field Mnemonic/
Calculation

Description

TOT PMTS WITH LOAN FEES CALC PMTS + LNFEES Total payments due (principal, interest, and
reserve) where the loan due date is less than
or equal to the run date plus loan fees

TOT PMTS WITH PARTIAL CALC PMTS - LNPRTL Total payments due (principal, interest, and
reserve) where the loan due date is less than
or equal to the run date minus partial

TOTAL PRINCIPAL AND
INTEREST DUE

CALC PRIN / INT Total principal and interest due where the
due date is less than or equal to the run date
(does not work for payment method 5)

TRANSFER ACCOUNT LNXFRX Account number of savings or checking
account used as the transfer account

TYPE LNTYPC Type of loan account

USER DEFINED C17 UFC17 This is a user-defined field entered on the
Actions/Holds/Event Letters screen. You
can enter any information in those fields on
that screen, and that information can be
included in event letters if you include this
merge field.

These fields are only available for events 23
and 24.

USER DEFINED C34 UFC34 This is a user-defined field entered on the
Actions/Holds/Event Letters screen. You
can enter any information in those fields on
that screen, and that information can be
included in event letters if you include this
merge field.

These fields are only available for events 23
and 24.

ARM Fields

ARM 2ND NEXT P/I CHANGE DATE
ARM 2ND NEXT RATE CHANGE DATE
ARM ACCRUAL INDEX 1
ARM ACCRUAL RATE 1
ARM ACCRUAL RATE EFFECTIVE DATE 1
ARM ACCRUAL INDEX 2
ARM ACCRUAL RATE 2
ARM ACCRUAL RATE EFFECTIVE DATE 2
ARM ACCRUAL INDEX 3 
ARM ACCRUAL RATE 3
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ARM ACCRUAL RATE EFFECTIVE DATE 3
ARM ACCRUAL INDEX 4
ARM ACCRUAL RATE 4
ARM ACCRUAL RATE EFFECTIVE DATE 4
ARM ACCRUAL INDEX 5
ARM ACCRUAL RATE 5
ARM ACCRUAL RATE EFFECTIVE DATE 5
ARM ACCRUAL INDEX 6
ARM ACCRUAL RATE 6
ARM ACCRUAL RATE EFFECTIVE DATE 6
ARM ACCRUAL INDEX 7
ARM ACCRUAL RATE 7
ARM ACCRUAL RATE EFFECTIVE DATE 7
ARM ACCRUAL INDEX 8
ARM ACCRUAL RATE 8
ARM ACCRUAL RATE EFFECTIVE DATE 8
ARM ACCRUAL INDEX 9
ARM ACCRUAL RATE 9
ARM ACCRUAL RATE EFFECTIVE DATE 9
ARM ACCRUAL INDEX 10
ARM ACCRUAL RATE 10
ARM ACCRUAL RATE EFFECTIVE DATE 10
ARM ACCRUAL INDEX 11
ARM ACCRUAL RATE 11
ARM ACCRUAL RATE EFFECTIVE DATE 11
ARM ACCRUAL INDEX 12
ARM ACCRUAL RATE 12
ARM ACCRUAL RATE EFFECTIVE DATE 12
ARM AMORTIZED P/I PAYMENT
ARM AMORTIZED PRINCIPAL BALANCE
ARM DAYS BEFORE RATE CHANGE 
ARM DIFF BETWEEN NXT CURRENT INDEX
ARM DIFF BETWEEN NXT ORIGINAL RATE
ARM GRADUATED PMT INCREASE PERCENT
ARM INDEX PLUS OFFSET LESS ACCR RT
ARM INDEX PUBLISHING FREQUENCY
ARM INTEREST ACCRUAL RATE
ARM INTEREST ONLY P/I PAYMENT
ARM INTEREST RATE POINTER
ARM LENGTH OF RATE CAP PERIOD
ARM MOST RECENT P/I CHANGE DATE
ARM MOST RECENT P/I PAYMENT
ARM MOST RECENT TOTAL PAYMENT
ARM NAME OF RATE INDEX
ARM NEW INDEX
ARM NEW INDEX WITH OFFSET
ARM NEW P/I PAYMENT
ARM NEW R1 PAYMENT
ARM NEW R2 PAYMENT
ARM NEW SUBSIDY PAYMENT
ARM NEW TOTAL PAYMENT
ARM NEXT INTEREST ACCRUAL RATE
ARM NEXT RATE CHANGE DATE
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ARM OLD INDEX ARM OLD P/I PAYMENT
ARM OLD R1 PAYMENT
ARM OLD R2 PAYMENT
ARM OLD SUBSIDY PAYMENT
ARM OLD TOTAL PAYMENT
ARM ORIGINAL RATE
ARM P/I PAYMENT BASED ON INC LIMIT
ARM P/I PAYMENT CHANGE COUNTER
ARM P/I PAYMENT CHANGE DATE
ARM P/I PAYMENT CHANGE FREQUENCY
ARM P/I PAYMENT INCREASE LIMIT
ARM PAYMENT RATE
ARM RATE AT PERIOD START
ARM RATE CHANGE FREQUENCY 
ARM RATE CHANGE MINIMUM
ARM REMAINING TERM
ARM SOURCE OF RATE INDEX
ARM START OF ACCRUAL PERIOD
DEFERRED INTEREST
PREPAYMENT PENALTY END DATE
PROJECTED PMT PRINCIPAL PORTION
PROJECTED PMT INTEREST PORTION
YTD DEFERRED INTEREST

Event 1, ARM Accrual Rate Up, Rate Caps

This event record is generated automatically when the accrual rate goes up and periodic rate caps are used
(Use Rate Cap field on the Loans > Account Information > ARM Information screen displays a checkmark).

Merge Field Field Mnemonic/
Calculation

Description

ARM 2ND NEXT RATE
CHANGE DATE

LNAMDT + LNAMFQ Next accrual rate change date plus the rate change
frequency.

ARM AMORTIZED P/I
PAYMENT

LNAPIC The principal and interest payment required to fully amortize
the loan.

ARM AMORTIZED
PRINCIPAL BALANCE

AMTZ PRIN The principal balance on which the new adjusted payment is
based.

ARM BASE INDEX LNBINX Base index value used when calculating the new rate on the
loan account when the Use this Base Index Rate displays
a checkmark.

ARM DAYS BEFORE
RATE CHANGE 

LNAMAD Days before the next accrual rate change date to calculate a
new rate.

ARM DIFF BETWEEN
NXT CURRENT INDEX

NEW INDEX - OLD
INDEX

Difference between the next accrual index and current
accrual index.

ARM DIFF BETWEEN
NXT ORIGINAL RATE

LNAMNA - LNAMOA Difference between the next accrual rate and the original
rate.
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Merge Field Field Mnemonic/
Calculation

Description

ARM GRADUATED
PMT INCREASE
PERCENT

LNAMGI The percentage the principal and interest payment will
increase each P/I payment change frequency

ARM INDEX
PUBLISHING
FREQUENCY

RTPBFQ Frequency the index is published. This information is
entered on the Loans > System Setup Screens > Interest
Rate Table screen.

ARM INTEREST
ACCRUAL RATE 

LNAMRT The rate at which interest should accrue for payment
method 7 loans

ARM INTEREST ONLY
P/I PAYMENT

LNIPIC The P/I payment required to satisfy the calculated interest

ARM INTEREST RATE
POINTER

LNAMPT The accrual rate pointer that is tied to the rate index

ARM LENGTH OF
RATE CAP PERIOD

LNAMLP Length of rate cap period

ARM NAME OF RATE
INDEX

RTCL34 Name of the index, such as LIBOR, Treasury Rate 3-4
Years, etc. This information is entered on the Loans >
System Setup Screens > Interest Rate Table screen.

ARM NEW INDEX LNAPIN New index (last index)

ARM NEW INDEX WITH
OFFSET

LNAPIN + LNAMOF New index plus accrual rate offset/margin

ARM NEXT INTEREST
ACCRUAL RATE

LNAMNA Next accrual rate for this account

ARM NEXT RATE
CHANGE DATE

LNAMDT Date of the next rate change on the loan

ARM OLD INDEX TRLG Old (prior) index

ARM OLD P/I
PAYMENT

LNPICN Old P/I payment in effect prior to the new payment change

ARM OLD R1
PAYMENT

EFFECTIVE R1 Reserve 1 payment in effect prior to the new payment
change

ARM OLD R2
PAYMENT

EFFECTIVE R2 Reserve 2 payment in effect prior to the new payment
change

ARM OLD SUBSIDY
PAYMENT 

EFFECTIVE
SUBSIDY

Subsidy payment if effect prior to the new payment change

ARM OLD TOTAL
PAYMENT

OLD P/I +
OLD R1 +
OLD R2 -
OLD SUBSIDY

Old P/I payment plus old Reserve 1 payment plus old
Reserve 2 payment minus old subsidy payment

ARM ORIGINAL RATE LNAMOA Original loan rate
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Merge Field Field Mnemonic/
Calculation

Description

ARM P/I PAYMENT
CHANGE COUNTER

LNAMCC Number of times the system calculates the next P/I
payment automatically

ARM P/I PAYMENT
CHANGE DATE 

LNPIEF The date that the next P/I payment will replace the P/I
payment

ARM P/I PAYMENT
CHANGE
FREQUENCY 

LNAMPC Number of months that should occur between payment
changes 

ARM P/I PAYMENT
INCREASE LIMIT

LNAMPL The percentage the P/I payment can increase with a
payment change

ARM RATE AT PERIOD
START

LNAMSY Rate at the start of the rate cap period

ARM RATE CHANGE
FREQUENCY

LNAMFQ Number of months that should occur between rate changes 

ARM RATE CHANGE
MINIMUM

LNAMCM The minimum percentage by which the loan rate can be
changed

ARM REMAINING
TERM

LNMATD-
LNAMDT

Month’s difference between the maturity date and next
accrual rate change date. For bi-weekly loans, take the term
in months divided by 12 multiplied by 26 to get the number
of payments. Subtract the installment from the number of
payments to get remaining payments. Take remaining
payments divided by 26, then multiply by 12 to get the
remaining term in months.

ARM SOURCE OF
RATE INDEX

RTPBDS Publishing source of the index rate, such as Wall Street
Journal. This information is entered on the Loans > System
Setup Screens > Interest Rate Table screen.

ARM START OF
ACCRUAL PERIOD

LNAMPD Starting date of the current rate cap period.

PREPAYMENT
PENALTY END DATE

Calculated field End date of the prepayment penalty.

PROJECTED PMT
PRINCIPAL PORTION

Calculated Principal portion of the projected new payment.

PROJECTED PMT
INTEREST PORTION

Calculated Interest portion of the projected new payment.

Event 2, ARM Accrual Rate Down, Rate Caps

This event record is generated automatically when the accrual rate goes down and periodic rate caps are used
(Use Rate Cap field on the Loans > Account Information > ARM Information screen (payment method 6 or 7
loans) displays a checkmark).
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Merge Field Field Mnemonic/
Calculation

Description

ARM 2ND NEXT RATE
CHANGE DATE

LNAMDT +
LNAMFQ

Next accrual rate change date plus the rate change
frequency 

ARM AMORTIZED P/I
PAYMENT

LNAPIC The P/I payment required to fully amortized the loan

ARM AMORTIZED
PRINCIPAL BALANCE

AMTZ PRIN The principal balance on which the new adjusted payment is
based

ARM BASE INDEX LNBINX Base index value used when calculating the new rate on the
loan account when the Use this Base Index Rate option is
selected

ARM DAYS BEFORE
RATE CHANGE

LNAMAD Days before the next accrual rate change date to calculate a
new rate

ARM DIFF BETWEEN
NXT CURRENT INDEX

NEW INDEX -
OLD INDEX

Difference between next accrual index and current accrual
index

ARM DIFF BETWEEN
NXT ORIGINAL RATE

LNAMNA -
LNAMOA

Difference between the next accrual rate and the original rate

ARM GRADUATED
PMT INCREASE
PERCENT

LNAMGI The percentage the P/I payment will increase each P/I
payment change frequency

ARM INDEX
PUBLISHING
FREQUENCY

RTPBFQ Frequency the index is published. This information is
entered on the Loans > System Setup Screens > Interest
Rate Table screen.

ARM INTEREST
ACCRUAL RATE

LNAMRT The rate at which interest should accrue for payment method
7 loans

ARM INTEREST ONLY
P/I PAYMENT 

LNIPIC The P/I payment required to satisfy the calculated interest

ARM INTEREST RATE
POINTER

LNAMPT The accrual rate pointer that is tied to the rate index

ARM LENGTH OF
RATE CAP PERIOD 

LNAMLP Length of rate cap period

ARM NAME OF RATE
INDEX

RTCL34 Name of index, such as LIBOR. This information is entered
on the Loans > System Setup Screens > Interest Rate
Table screen.

ARM NEW INDEX LNAPIN New index (last index)

ARM NEW INDEX
WITH OFFSET

LNAPIN +
LNAMOF

New index plus accrual rate offset/margin

ARM NEXT INTEREST
ACCRUAL RATE

LNAMNA Next accrual rate for this account
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Merge Field Field Mnemonic/
Calculation

Description

ARM NEXT RATE
CHANGE DATE

LNAMDT Date of the next rate change on the loan

ARM OLD INDEX TRLG Old (prior) index

ARM OLD P/I
PAYMENT

LNPICN Old P/I payment in effect prior to the new payment change

ARM OLD R1
PAYMENT

EFFECTIVE R1 Reserve 1 payment in effect prior to the new payment
change

ARM OLD R2
PAYMENT

EFFECTIVE R2 Reserve 2 payment in effect prior to the new payment
change

ARM OLD SUBSIDY
PAYMENT

EFFECTIVE
SUBSIDY

Subsidy payment if effect prior to the new payment change

ARM OLD TOTAL
PAYMENT

OLD P/I +
OLD R1 +
OLD R2 -
OLD SUBSIDY

Old P/I payment plus old reserve 1 payment plus old reserve
2 payment minus old subsidy payment

ARM ORIGINAL RATE LNAMOA Original loan rate

ARM P/I PAYMENT
CHANGE COUNTER

LNAMCC Number of times the system calculates the next P/I
payment automatically

ARM P/I PAYMENT
CHANGE DATE

LNPIEF The date that the next P/I payment will replace the P/I
payment

ARM P/I PAYMENT
CHANGE
FREQUENCY

LNAMPC Number of months that should occur between payment
changes 

ARM P/I PAYMENT
INCREASE LIMIT

LNAMPL The percentage the P/I payment can increase with a
payment change

ARM RATE AT
PERIOD START

LNAMSY Rate at the start of the rate cap period

ARM RATE CHANGE
FREQUENCY

LNAMFQ Number of months that should occur between rate changes

ARM RATE CHANGE
MINIMUM

LNAMCM The minimum percentage by which the loan rate can be
changed

ARM REMAINING
TERM

LNMATD -
LNAMDT

Month’s difference between the maturity date and next
accrual rate change date. For bi-weekly loans, take the term
in months divided by 12 multiplied by 26 to get the number
of payments. Subtract the installment from the number of
payments to get remaining payments. Take remaining
payments divided by 26, then multiply by 12 to get the
remaining term in months.
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Merge Field Field Mnemonic/
Calculation

Description

ARM SOURCE OF
RATE INDEX

RTPBDS Publishing source of the index rate. This information is
entered on the Loans > System Setup Screens > Interest
Rate Table screen.

ARM START OF
ACCRUAL PERIOD

LNAMPD Starting date of the current rate cap period

PREPAYMENT
PENALTY END DATE

Calculated field End date of the prepayment penalty

PROJECTED PMT
PRINCIPAL PORTION

Calculated Principal portion of the projected new payment.

PROJECTED PMT
INTEREST PORTION

Calculated Interest portion of the projected new payment.

Event 3, ARM Accrual Rate Up, Payment Change, Rate Caps

This event record is generated automatically when the accrual rate goes up, a new P/I constant is calculated
and periodic rate caps are used (Use Rate Cap field on the Loans > Account Information > ARM Information
screen (payment method 6 or 7 loans) displays a checkmark).

Merge Field Field Mnemonic/
Calculation

Description

ARM 2ND NEXT P/I
CHANGE DATE

LNPIEF +
LNAMPC

P/I effective date plus the P/I payment change
frequency 

ARM 2ND NEXT RATE
CHANGE DATE

LNAMDT +
LNAMFQ

Next accrual rate change date plus the rate change
frequency

ARM AMORTIZED P/I
PAYMENT

LNAPIC The P/I payment required to fully amortize the loan

ARM AMORTIZED
PRINCIPAL BALANCE

AMTZ PRIN The principal balance on which the new adjusted
payment is based.

ARM BASE INDEX LNBINX Base index value used when calculating the new rate
on the loan account when the Use this Base Index
Rate option is selected

ARM DAYS BEFORE
RATE CHANGE

LNAMAD Days before the next accrual rate change date to
calculate a new rate

ARM DIFF BETWEEN
NXT CURRENT INDEX

NEW INDEX -
OLD INDEX

Difference between the next accrual index and current
accrual index

ARM DIFF BETWEEN
NXT ORIGINAL RATE

LNAMNA -
LNAMOA

Difference between the next accrual rate and the
original rate
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Merge Field Field Mnemonic/
Calculation

Description

ARM GRADUATED
PMT INCREASE
PERCENT

LNAMGI The percentage the P/I payment will increase each P/I
payment frequency

ARM INDEX PLUS
OFFSET LESS ACCR
RT

NEW INDEX +
LNAMOF -
LNAMRT

New index plus the accrual rate offset/margin minus
accrual rate

ARM INDEX
PUBLISHING
FREQUENCY

RTPBFQ Frequency the index is published. This information is
entered on the Loans > System Setup Screens >
Interest Rate Table screen.

ARM INTEREST
ACCRUAL RATE 

LNAMRT The rate at which interest should accrue for payment
method 7 loans

ARM INTEREST
ONLY P/I PAYMENT

LNIPIC The P/I payment required to satisfy the calculated
interest

ARM INTEREST
RATE POINTER

LNAMPT The accrual rate pointer that is tied to the rate index

ARM LENGTH OF
RATE CAP PERIOD

LNAMLP Length of rate cap period

ARM MOST RECENT
P/I CHANGE DATE

Newest P/I change date on the ARM Rates and P/I
Tables tab on the ARM Information screen

ARM MOST RECENT
P/I PAYMENT

Newest P/I payment on the ARM Rates and P/I
Tables tab on the ARM Information screen

ARM MOST RECENT
TOTAL PAYMENT

MOST RECENT P/I +
NEW R1 +
NEW R2 -
NEW SUBSIDY

Newest P/I payment on the ARM Rates and P/I
Tables tab on the ARM Information screen, plus
Reserve 1 payment effective for the newest payment
change date plus Reserve 2 payment effective for the
newest payment change date minus subsidy payment
effective for the newest payment change date

ARM NAME OF RATE
INDEX

RTCL34 Name of the index, such as LIBOR. This information is
entered on the Loans > System Setup Screens >
Interest Rate Table screen.

ARM NEW INDEX LNAPIN New index (last index)

ARM NEW INDEX
WITH OFFSET

LNAPIN +
LNAMOF

New index plus accrual rate offset/margin

ARM NEW P/I
PAYMENT

LNPINX Newly calculated P/I constant

ARM NEW R1
PAYMENT

EFFECTIVE R1 Reserve 1 payment effective with the new payment
change

ARM NEW R2
PAYMENT

EFFECTIVE R2 Reserve 2 payment effective with the new payment
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Merge Field Field Mnemonic/
Calculation

Description

ARM NEW SUBSIDY
PAYMENT

EFFECTIVE SUBSIDY The subsidy payment effective with the new payment

ARM NEW TOTAL
PAYMENT

NEW P/I +
NEW R1 +
NEW R2 -
NEW SUBSIDY

New P/I payment plus new Reserve 1 payment plus
new Reserve 2 payment minus new subsidy payment

ARM NEXT INTEREST
ACCRUAL RATE

LNAMNA Next accrual rate for this account

ARM NEXT RATE
CHANGE DATE

LNAMDT Date of the next rate change on the loan

ARM OLD INDEX TRLG Old (prior) index

ARM OLD P/I
PAYMENT

LNPICN Old P/I payment in effect prior to the new payment
change

ARM OLD R1
PAYMENT

EFFECTIVE R1 Reserve 1 payment in effect prior to the new payment
change

ARM OLD R2
PAYMENT 

EFFECTIVE R2 Reserve 2 payment in effect prior to the new payment
change

ARM OLD SUBSIDY
PAYMENT

EFFECTIVE SUBSIDY Subsidy payment if effect prior to the new payment
change

ARM OLD TOTAL
PAYMENT

OLD P/I +
OLD R1 +
OLD R2 -
OLD SUBSIDY

Old P/I payment plus old Reserve 1 payment plus old
Reserve 2 payment minus old subsidy payment

ARM ORIGINAL RATE LNAMOA Original loan rate

ARM P/I PAYMENT
BASED ON INC LMT

LNPICN*
LNAMPL

Old P/I payment multiplied by the P/I payment
increase limit

ARM P/I PAYMENT
CHANGE COUNTER

LNAMCC Number of times the system calculates the next P/I
payment automatically

ARM P/I PAYMENT
CHANGE DATE

LNPIEF The date that the next P/I payment will replace the P/I
payment

ARM P/I PAYMENT
CHANGE
FREQUENCY

LNAMPC Number of months that should occur between
payment changes

ARM P/I PAYMENT
INCREASE LIMIT

LNAMPL The percentage the P/I payment can increase with a
payment change

ARM PAYMENT
RATE

LNRATE The payment rate
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Merge Field Field Mnemonic/
Calculation

Description

ARM RATE AT
PERIOD START

LNAMSY Rate at the start of the rate cap period

ARM RATE CHANGE
FREQUENCY

LNAMFQ Number of months that should occur between rate
changes

ARM RATE CHANGE
MINIMUM

LNAMCM The minimum percentage by which the loan rate can
be changed

ARM REMAINING
TERM

LNMATD -
LNAMDT

Month’s difference between the maturity date and next
accrual rate change date. For bi-weekly loans, take
the term in months divided by 12 multiplied by 26 to
get the number of payments. Subtract the installment
from the number of payments to get remaining
payments. Take remaining payments divided by 26
then multiply by 12 to get the remaining term in
months.

ARM SOURCE OF
RATE INDEX

PMCL60 Publishing source of the index rate. This information is
entered on the Loans > System Setup Screens >
Interest Rate Table screen.

ARM START OF
ACCRUAL PERIOD

LNAMPD Starting date of the current rate cap period

PREPAYMENT
PENALTY END DATE

Calculated field End date of the prepayment penalty

PROJECTED PMT
PRINCIPAL PORTION

Calculated Principal portion of the projected new payment.

PROJECTED PMT
INTEREST PORTION

Calculated Interest portion of the projected new payment.

Event 4, ARM Accrual Rate Down, Payment Change, Rate Caps

This event record is generated automatically when the accrual rate goes down, a new P/I constant is calculated
and periodic rate caps are used (Use Rate Cap field on the Loans > Account Information > ARM Information
screen (payment method 6 or 7 loans) displays a checkmark).

Merge Field Field Mnemonic/
Calculation

Description

ARM 2ND NEXT P/I
CHANGE DATE

LNPIEF +
LNAMPC

P/I effective date plus the P/I payment change
frequency

ARM 2ND NEXT RATE
CHANGE DATE

LNAMDT +
LNAMFQ

Next accrual rate change date plus the rate change
frequency

ARM AMORTIZED P/I
PAYMENT

LNAPIC The P/I payment required to fully amortize the loan
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Merge Field Field Mnemonic/
Calculation

Description

ARM AMORTIZED
PRINCIPAL BALANCE

AMTZ PRIN The principal balance on which the new adjusted
payment is based

ARM BASE INDEX LNBINX Base index value used when calculating the new rate
on the loan account when the Use this Base Index
Rate option displays a checkmark

ARM DAYS BEFORE
RATE CHANGE

LNAMAD Days before the next accrual rate change date to
calculate a new rate

ARM DIFF BETWEEN
NXT CURRENT INDEX

NEW INDEX -
OLD INDEX

Difference between the next accrual index and current
accrual index

ARM DIFF BETWEEN
NXT ORIGINAL RATE

LNAMNA -
LNAMOA

Difference between the next accrual rate and the
original rate

ARM GRADUATED PMT
INCREASE PERCENT

LNAMGI The percentage the P/I payment will increase each P/I
payment change frequency

ARM INDEX PLUS
OFFSET LESS ACCR
RT

NEW INDEX +
LNAMOF -
LNAMRT

New index plus the accrual rate offset/margin minus
accrual rate

ARM INDEX
PUBLISHING
FREQUENCY

RTPBDS Frequency the index is published. This information is
entered on the Loans > System Setup Screens >
Interest Rate Table screen.

ARM INTEREST
ACCRUAL RATE

LNAMRT The rate at which interest should accrue for payment
method 7 loans

ARM INTEREST ONLY
P/I PAYMENT

LNIPIC The P/I payment required to satisfy the calculated
interest

ARM INTEREST RATE
POINTER

LNAMPT The accrual rate pointer that is tied to the rate index

ARM LENGTH OF RATE
CAP PERIOD

LNAMLP Length of rate cap period 

ARM MOST RECENT
P/I CHANGE DATE

Newest P/I change date on the ARM Rates and P/I
Tables tab on the ARM Information screen

ARM MOST RECENT
P/I PAYMENT

Newest P/I payment on the ARM Rates and P/I Tables
tab on the ARM Information screen

ARM MOST RECENT
TOTAL PAYMENT

MOST RECENT P/I +
NEW R1 +
NEW R2 -
NEW SUBSIDY

Newest P/I payment in change table on the ARM
Rates and P/I Tables tab on the ARM Information
screen, plus Reserve 1 payment effective for the
newest payment change date plus Reserve 2 payment
effective for the newest payment change date minus
subsidy payment effective for the newest payment
change date
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Merge Field Field Mnemonic/
Calculation

Description

ARM NAME OF RATE
INDEX

RTCL34 Name of the index, such as LIBOR. This information is
entered on the Loans > System Setup Screens >
Interest Rate Table screen.

ARM NEW INDEX LNAPIN New index (last index)

ARM NEW INDEX WITH
OFFSET

LNAPIN +
LNAMOF

New index plus accrual rate offset/margin

ARM NEW P/I
PAYMENT

LNPINX Newly calculated P/I payment 

ARM NEW R1
PAYMENT

EFFECTIVE R1 Reserve 1 payment effective with the new payment
change

ARM NEW R2
PAYMENT

EFFECTIVE R2 Reserve 2 payment effective with the new payment
change

ARM NEW SUBSIDY
PAYMENT

EFFECTIVE SUBSIDY The subsidy payment effective with the new payment
change

ARM NEW TOTAL
PAYMENT

NEW P/I +
NEW R1 +
NEW R2 -
NEW SUBSIDY

New P/I payment plus new Reserve 1 payment plus
new Reserve 2 payment minus new subsidy payment

ARM NEXT INTEREST
ACCRUAL RATE

LNAMNA Next accrual rate for this account

ARM NEXT RATE
CHANGE DATE

LNAMDT Date of the next rate change on the loan

ARM OLD INDEX TRLG Old (prior) index

ARM OLD P/I
PAYMENT

LNPICN Old P/I payment in effect prior to the new payment
change

ARM OLD R1
PAYMENT

EFFECTIVE R1 Reserve 1 payment in effect prior to the new payment
change

ARM OLD R2
PAYMENT

EFFECTIVE R2 Reserve 2 payment in effect prior to the new payment
change

ARM OLD SUBSIDY
PAYMENT

EFFECTIVE SUBSIDY Subsidy payment if effect prior to the new payment
change

ARM OLD TOTAL
PAYMENT

OLD P/I +
OLD R1 +
OLD R2 -
OLD SUBSIDY

Old P/I payment plus old Reserve 1 payment plus old
Reserve 2 payment minus old subsidy payment

ARM ORIGINAL RATE LNAMOA Original loan rate

ARM P/I PAYMENT
BASED ON INC LMT

LNPICN *
LNAMPL

Old P/I payment multiplied by the P/I payment
increase limit



GOLDEvent Letters110

© 2019 GOLDPoint SystemsLast updated: 11/25/2019

Merge Field Field Mnemonic/
Calculation

Description

ARM P/I PAYMENT
CHANGE COUNTER

LNAMCC Number of times the system calculates the next P/I
payment automatically

ARM P/I PAYMENT
CHANGE DATE

LNPIEF The date that the next P/I payment will replace the P/I
payment

ARM P/I PAYMENT
CHANGE FREQUENCY

LNAMPC Number of months that should occur between payment
changes

ARM P/I PAYMENT
INCREASE LIMIT

LNAMPL The percentage the P/I payment can increase with a
payment change

ARM PAYMENT RATE LNRATE The payment rate

ARM RATE AT PERIOD
START

LNAMSY Rate at the start of the rate cap period

ARM RATE CHANGE
FREQUENCY

LNAMFQ Number of months that should occur between rate
changes

ARM RATE CHANGE
MINIMUM

LNAMCM The minimum percentage by which the loan rate can
be changed

ARM REMAINING
TERM

LNMATD -
LNAMDT

Month’s difference between the maturity date and next
accrual rate change date. For bi-weekly loans, take
the term in months divided by 12 multiplied by 26 to
get the number of payments. Subtract the installment
from the number of payments to get remaining
payments. Take remaining payments divided by 26
then multiply by 12 to get the remaining term in
months.

ARM SOURCE OF
RATE INDEX

RTPBDS Publishing source of the index rate (e.g., Wall Street
Journal). This information is entered on the Loans >
System Setup Screens > Interest Rate Table screen.

ARM START OF
ACCRUAL PERIOD

LNAMPD Starting date of the current rate cap period

PREPAYMENT
PENALTY END DATE

Calculated field End date of the prepayment penalty

PROJECTED PMT
PRINCIPAL PORTION

Calculated Principal portion of the projected new payment.

PROJECTED PMT
INTEREST PORTION

Calculated Interest portion of the projected new payment.

Event 5, Daily Simple Interest Rate Change

This event automatically produces an event letter when the loan rate changes on a payment method 5 or a
payment method 6 (non-ARM loan).
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Merge Field Field Mnemonic/
Calculation

Description

NEW INDEX LNAPIN New index (last index)

OLD INDEX TRLG Old (prior) index

OLD INTEREST RATE TRLG Old (prior) interest rate

Event 6, ARM Accrual Rate Down

This event is generated automatically when the accrual rate goes down.

Merge Field Field Mnemonic/
Calculation

Description

ARM 2ND NEXT RATE
CHANGE DATE

LNAMDT +
LNAMFQ

Next accrual rate change date plus the rate change
frequency

ARM AMORTIZED P/I
PAYMENT

LNAPIC The P/I payment required to fully amortize the loan

ARM AMORTIZED
PRINCIPAL BALANCE

AMTZ PRIN The principal balance on which the new adjusted payment
is based

ARM BASE INDEX LNBINX Base index value used when calculating the new rate on
the loan account when the Use this Base Index Rate option
displays a checkmark

ARM DAYS BEFORE
RATE CHANGE

LNAMAD Days before the next accrual rate change date to calculate
a new rate

ARM DIFF BETWEEN
NXT CURRENT INDEX

NEW INDEX -
OLD INDEX

Difference between the next accrual index and current
accrual index

ARM DIFF BETWEEN
NXT ORIGINAL RATE

LNAMNA - 
LNAMOA

Difference between the next accrual rate and the original
rate

ARM GRADUATED
PMT INCREASE
PERCENT

LNAMGI The percentage the P/I payment will increase each P/I
payment change frequency

ARM INDEX
PUBLISHING
FREQUENCY

RTPBFQ Frequency the index is published (e.g., daily, weekly). This
information is entered on the Loans > System Setup
Screens > Interest Rate Table screen.

ARM INTEREST
ACCRUAL RATE

LNAMRT The rate at which interest should accrue for payment
method 7 loans

ARM INTEREST ONLY
P/I PAYMENT

LNIPIC The P/I payment required to satisfy the calculated interest

ARM INTEREST RATE
POINTER

LNAMPT The accrual rate pointer that is tied to the rate index
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Merge Field Field Mnemonic/
Calculation

Description

ARM NAME OF RATE
INDEX

RTCL34 Name of the index, such as LIBOR. This information is
entered on the Loans > System Setup Screens > Interest
Rate Table screen.

ARM NEW INDEX LNAPIN New index (last index)

ARM NEW INDEX
WITH OFFSET

LNAPIN +
LNAMOF

New index plus accrual rate offset/margin

ARM NEXT INTEREST
ACCRUAL RATE

LNAMNA Next accrual rate for this account

ARM NEXT RATE
CHANGE DATE

LNAMDT Date of the next rate change on the loan

ARM OLD INDEX TRLG Old (prior) index

ARM OLD P/I
PAYMENT

LNPICN Old P/I payment in effect prior to the new payment change

ARM OLD R1
PAYMENT

EFFECTIVE R1 Reserve 1 payment in effect prior to the new payment
change

ARM OLD R2
PAYMENT

EFFECTIVE R2 Reserve 2 payment in effect prior to the new payment
change

ARM OLD SUBSIDY
PAYMENT

EFFECTIVE SUBSIDY Subsidy payment if effect prior to the new payment change

ARM OLD TOTAL
PAYMENT

OLD P/I +
OLD R1 +
OLD R2 -
OLD SUBSIDY

Old P/I payment plus old Reserve 1 payment plus old
Reserve 2 payment minus old subsidy payment

ARM ORIGINAL RATE LNAMOA Original loan rate

ARM P/I PAYMENT
CHANGE COUNTER

LNAMCC Number of times the system calculates the next P/I
payment automatically

ARM P/I PAYMENT
CHANGE DATE

LNPIEF The date that the next P/I payment will replace the P/I
payment

ARM P/I PAYMENT
CHANGE
FREQUENCY

LNAMPC Number of months that should occur between payment
changes

ARM P/I PAYMENT
INCREASE LIMIT

LNAMPL The percentage the P/I payment can increase with a
payment change

ARM PAYMENT RATE LNRATE The payment rate of the loan

ARM RATE CHANGE
FREQUENCY

LNAMFQ Number of months that should occur between rate changes
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Merge Field Field Mnemonic/
Calculation

Description

ARM RATE CHANGE
MINIMUM

LNAMCM The minimum percentage by which the loan rate can be
changed

ARM REMAINING
TERM

LNMATD-
LNAMDT

Month’s difference between the maturity date and next
accrual rate change date. For bi-weekly loans, take the
term in months divided by 12 multiplied by 26 to get the
number of payments. Subtract the installment from the
number of payments to get remaining payments. Take
remaining payments divided by 26 then multiply by 12 to
get the remaining term in months.

ARM SOURCE OF
RATE INDEX

RTPBDS Publishing source of the index rate (e.g., Wall Street
Journal). This information is entered on the Loans >
System Setup Screens > Interest Rate Table screen.

DEFERRED
INTEREST

LNDEFI Deferred interest

PREPAYMENT
PENALTY END DATE

Calculated field End date of the prepayment penalty

PROJECTED PMT
PRINCIPAL PORTION

Calculated Principal portion of the projected new payment.

PROJECTED PMT
INTEREST PORTION

Calculated Interest portion of the projected new payment.

YTD DEFERRED
INTEREST

LNYTDD YTD deferred interest

Event 7, ARM Accrual Rate Down, Payment Change

This event is generated for ARM loans when the ARM accrual rate goes up and the borrower will have a principal
and interest change, according to the rate tables set up on the ARM Rates & P/I Tables tab on the Loans >
Account Information > ARM Information screen.

Merge Field Field Mnemonic/
Calculation

Description

ARM 2ND NEXT P/I
CHANGE DATE

LNPIEF +
LNAMPC

P/I effective date plus the P/I payment change frequency

ARM 2ND NEXT RATE
CHANGE DATE

LNAMDT +
LNAMFQ

Next accrual rate change date plus the rate change
frequency

ARM AMORTIZED P/I
PAYMENT

LNAPIC The P/I payment required to fully amortize the loan

ARM AMORTIZED
PRINCIPAL BALANCE

AMTZ PRIN The principal balance on which the new adjusted payment
is based
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Merge Field Field Mnemonic/
Calculation

Description

ARM BASE INDEX LNBINX Base index value used when calculating the new rate on
the loan account when the Use this Base Index Rate
option displays a checkmark

ARM DAYS BEFORE
RATE CHANGE

LNAMAD Days before the next accrual rate change date to calculate
a new rate

ARM DIFF BETWEEN
NXT CURRENT INDEX

NEW INDEX -
OLD INDEX

Difference between the next accrual index and current
accrual index

ARM DIFF BETWEEN
NXT ORIGINAL RATE

LNAMNA -
LNAMOA

Difference between the next accrual rate and the original
rate

ARM GRADUATED PMT
INCREASE PERCENT

LNAMGI The percentage the P/I payment will increase each P/I
payment frequency

ARM INDEX
PUBLISHING
FREQUENCY

RTPBFQ Frequency the index is published (e.g., weekly, daily).
This information is entered on the Loans > System Setup
Screens > Interest Rate Table screen.

ARM INTEREST
ACCRUAL RATE

LNAMRT The rate at which interest should accrue for payment
method 7 loans

ARM INTEREST ONLY
P/I PAYMENT

LNIPIC The P/I payment required to satisfy the calculated interest

ARM INTEREST RATE
POINTER

LNAMPT The accrual rate pointer that is tied to the rate index

ARM MOST RECENT P/I
CHANGE DATE

Newest P/I change date on the ARM Rates & P/I Tables
tab on the ARM Information screen.

ARM MOST RECENT P/I
PAYMENT

Newest P/I payment on the ARM Rates & P/I Tables tab
on the ARM Information screen.

ARM MOST RECENT
TOTAL PAYMENT

MOST RECENT P/I
+
NEW R1 +
NEW R2 -
NEW SUBSIDY

Newest P/I payment on the ARM Rates & P/I Tables tab
on the ARM Information screen, plus reserve 1 payment
effective for the newest payment change date plus reserve
2 payment effective for the newest payment change date
minus subsidy payment effective for the newest payment
change date

ARM NAME OF RATE
INDEX

RTCL34 Name of the index, such as LIBOR.

ARM NEW INDEX LNAPIN New index (last index)

ARM NEW INDEX WITH
OFFSET

LNAPIN +
LNAMOF

New index plus accrual rate offset/margin

ARM NEW P/I
PAYMENT

LNPINX Newly calculated P/I payment 
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Merge Field Field Mnemonic/
Calculation

Description

ARM NEW R1
PAYMENT

EFFECTIVE R1 Reserve 1 payment effective with the new payment change

ARM NEW R2
PAYMENT

EFFECTIVE R2 Reserve 2 payment effective with the new payment

ARM NEW SUBSIDY
PAYMENT

EFFECTIVE
SUBSIDY

The subsidy payment effective with the new payment

ARM NEW TOTAL
PAYMENT

NEW P/I +
NEW R1 +
NEW R2 -
NEW SUBSIDY

New P/I payment plus new Reserve 1 payment plus new
Reserve 2 payment minus new subsidy payment

ARM NEXT INTEREST
ACCRUAL RATE

LNAMNA Next accrual rate for this account

ARM NEXT RATE
CHANGE DATE

LNAMDT Date of the next rate change on the loan

ARM OLD INDEX TRLG Old (prior) index

ARM OLD P/I PAYMENT LNPICN Old P/I payment in effect prior to the new payment change

ARM OLD R1 PAYMENT EFFECTIVE R1 Reserve 1 payment in effect prior to the new payment
change

ARM OLD R2 PAYMENT EFFECTIVE R2 Reserve 2 payment in effect prior to the new payment
change

ARM OLD SUBSIDY
PAYMENT

EFFECTIVE
SUBSIDY 

Subsidy payment if effect prior to the new payment change

ARM OLD TOTAL
PAYMENT

OLD P/I +
OLD R1 +
OLD R2 -
OLD SUBSIDY

Old P/I payment plus old Reserve 1 payment plus old
Reserve 2 payment minus old subsidy payment

ARM ORIGINAL RATE LNAMOA Original loan rate

ARM P/I PAYMENT
BASED ON INC LMT

LNPICN *
LNAMPL

Old P/I payment multiplied by the P/I payment increase
limit

ARM P/I PAYMENT
CHANGE COUNTER

LNAMCC Number of times the system calculates the next P/I
payment automatically

ARM P/I PAYMENT
CHANGE DATE

LNPIEF The date that the next P/I payment will replace the P/I
payment

ARM P/I PAYMENT
CHANGE FREQUENCY

LNAMPC Number of months that should occur between payment
changes

ARM P/I PAYMENT
INCREASE LIMIT

LNAMPL The percentage the P/I payment can increase with a
payment change
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Merge Field Field Mnemonic/
Calculation

Description

ARM PAYMENT RATE LNRATE The payment rate on the loan 

ARM RATE CHANGE
FREQUENCY

LNAMFQ Number of months that should occur between rate
changes

ARM RATE CHANGE
MINIMUM

LNAMCM The minimum percentage by which the loan rate can be
changed

ARM REMAINING TERM LNMATD -
LNAMDT

Month’s difference between the maturity date and next
accrual rate change date. For bi-weekly loans, take the
term in months divided by 12 multiplied by 26 to get the
number of payments. Subtract the installment from the
number of payments to get remaining payments. Take
remaining payments divided by 26 then multiply by 12 to
get the remaining term in months.

ARM SOURCE OF RATE
INDEX

RTPBDS Publishing source of the index rate (e.g., Wall Street
Journal). This information is entered on the Loans >
System Setup Screens > Interest Rate Table screen.

PREPAYMENT
PENALTY END DATE

Calculated field End date of the prepayment penalty

PROJECTED PMT
PRINCIPAL PORTION

Calculated Principal portion of the projected new payment.

PROJECTED PMT
INTEREST PORTION

Calculated Interest portion of the projected new payment.

 

Event 10, ARM Accrual Rate Up

This event record is generated automatically when the ARM accrual rate goes up.

Merge Field Field Mnemonic/
Calculation

Description

ARM 2ND NEXT RATE
CHANGE DATE

LNAMDT +
LNAMFQ

Next accrual rate change date plus the rate
change frequency

ARM AMORTIZED P/I
PAYMENT

LNAPIC The P/I payment required to fully amortize the
loan

ARM AMORTIZED PRINCIPAL
BALANCE

AMTZ PRIN The principal balance on which the new adjusted
payment is based

ARM BASE INDEX LNBINX Base index value used when calculating the new
rate on the loan account when the Use this
Base Index Rate option displays a checkmark
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Merge Field Field Mnemonic/
Calculation

Description

ARM DAYS BEFORE RATE
CHANGE

LNAMAD Days before the next accrual rate change date
to calculate a new rate

ARM DIFF BETWEEN NXT
CURRENT INDEX

NEW INDEX -
OLD INDEX

Difference between the next accrual index and
current accrual index

ARM DIFF BETWEEN NXT
ORIGINAL RATE

LNAMNA -
LNAMOA

Difference between the next accrual rate and the
original rate

ARM GRADUATED PMT
INCREASE PERCENT

LNAMGI The percentage the P/I payment will increase
each P/I payment frequency

ARM INDEX PUBLISHING
FREQUENCY

RTPBFQ Frequency the index is published (e.g., daily,
weekly). This information is entered on the
Loans > System Setup Screens > Interest Rate
Table screen.

ARM INTEREST ACCRUAL
RATE

LNAMRT The rate at which interest should accrue for
payment method 7 loans

ARM INTEREST ONLY P/I
PAYMENT

LNIPIC The P/I payment required to satisfy the
calculated interest

ARM INTEREST RATE
POINTER

LNAMPT The accrual rate pointer that is tied to the rate
index

ARM NAME OF RATE INDEX RTCL34 Name of the index, such as LIBOR. This
information is entered on the Loans > System
Setup Screens > Interest Rate Table screen.

ARM NEW INDEX LNAPIN New index (last index)

ARM NEW INDEX WITH
OFFSET

LNAPIN +
LNAMOF

New index plus accrual rate offset/margin

ARM NEXT INTEREST
ACCRUAL RATE

LNAMNA Next accrual rate for this account

ARM NEXT RATE CHANGE
DATE

LNAMDT Date of the next rate change on the loan

ARM OLD INDEX TRLG Old (prior) index

ARM OLD P/I PAYMENT LNPICN Old P/I payment in effect prior to the new
payment change

ARM OLD R1 PAYMENT EFFECTIVE R1 Reserve 1 payment in effect prior to the new
payment change

ARM OLD R2 PAYMENT EFFECTIVE R2 Reserve 2 payment in effect prior to the new
payment change

ARM OLD SUBSIDY
PAYMENT

EFFECTIVE SUBSIDY Subsidy payment if effect prior to the new
payment change
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Merge Field Field Mnemonic/
Calculation

Description

ARM OLD TOTAL PAYMENT OLD P/I +
OLD R1 +
OLD R2 -
OLD SUBSIDY

Old P/I payment plus old Reserve 1 payment
plus old Reserve 2 payment minus old subsidy
payment

ARM ORIGINAL RATE LNAMOA Original loan rate

ARM P/I PAYMENT CHANGE
COUNTER

LNAMCC Number of times the system calculates the next
P/I payment automatically

ARM P/I PAYMENT CHANGE
DATE

LNPIEF The date that the next P/I payment will replace
the P/I payment

ARM P/I PAYMENT CHANGE
FREQUENCY

LNAMPC Number of months that should occur between
payment changes

ARM P/I PAYMENT
INCREASE LIMIT

LNAMPL The percentage the P/I payment can increase
with a payment change

ARM PAYMENT RATE LNRATE The payment rate on the loan 

ARM RATE CHANGE
FREQUENCY

LNAMFQ Number of months that should occur between
rate changes

ARM RATE CHANGE
MINIMUM

LNAMCM The minimum percentage by which the loan rate
can be changed

ARM REMAINING TERM LNMATD -
LNAMDT

Month’s difference between the maturity date
and next accrual rate change date. For bi-
weekly loans, take the term in months divided
by 12 multiplied by 26 to get the number of
payments. Subtract the installment from the
number of payments to get remaining payments.
Take remaining payments divided by 26 then
multiply by 12 to get the remaining term in
months.

ARM SOURCE OF RATE
INDEX

RTPBDS Publishing source of the index rate. This
information is entered on the Loans > System
Setup Screens > Interest Rate Table screen.

DEFERRED INTEREST LNDEFI Deferred interest

PREPAYMENT PENALTY END
DATE

Calculated field End date of the prepayment penalty

PROJECTED PMT PRINCIPAL
PORTION

Calculated Principal portion of the projected new payment.

PROJECTED PMT INTEREST
PORTION

Calculated Interest portion of the projected new payment.

YTD DEFERRED INTEREST LNYTDD YTD deferred interest
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Event 11, ARM Accrual Rate Up, Payment Change

This event record is generated automatically when the ARM accrual rate goes up and a new P/I payment is
calculated.

Merge Field Field Mnemonic/
Calculation

Description

ARM 2ND NEXT P/I
CHANGE DATE

LNPIEF +
LNAMPC

P/I effective date plus the P/I payment change frequency

ARM 2ND NEXT RATE
CHANGE DATE

LNAMDT +
LNAMFQ

Next accrual rate change date plus the rate change
frequency

ARM AMORTIZED P/I
PAYMENT

LNAPIC The P/I payment required to fully amortize the loan

ARM AMORTIZED
PRINCIPAL BALANCE

AMTZ PRIN The principal balance on which the new adjusted payment
is based

ARM BASE INDEX LNBINX Base index value used when calculating the new rate on the
loan account when the Use this Base Index Rate option
displays a checkmark

ARM DAYS BEFORE
RATE CHANGE

LNAMAD Days before the next accrual rate change date to calculate
a new rate

ARM DIFF BETWEEN
NXT CURRENT INDEX

NEW INDEX -
OLD INDEX

Difference between the next accrual index and current
accrual index

ARM DIFF BETWEEN
NXT ORIGINAL RATE

LNAMNA -
LNAMOA

Difference between the next accrual rate and the original
rate

ARM GRADUATED
PMT INCREASE
PERCENT

LNAMGI The percentage the P/I payment will increase each P/I
payment frequency

ARM INDEX
PUBLISHING
FREQUENCY

RTPBFQ Frequency the index is published (e.g., weekly, daily). This
information is entered on the Loans > System Setup
Screens > Interest Rate Table screen.

ARM INTEREST
ACCRUAL RATE

LNAMRT The rate at which interest should accrue for payment
method 7 loans

ARM INTEREST ONLY
P/I PAYMENT

LNIPIC The P/I payment required to satisfy the calculated interest

ARM INTEREST RATE
POINTER

LNAMPT The accrual rate pointer that is tied to the rate index

ARM MOST RECENT
P/I CHANGE DATE

Newest P/I change date on the ARM Rates & P/I Tables tab
on the ARM Information screen

ARM MOST RECENT
P/I PAYMENT

Newest P/I constant on the ARM Rates & P/I Tables tab on
the ARM Information screen
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Merge Field Field Mnemonic/
Calculation

Description

ARM MOST RECENT
TOTAL PAYMENT

MOST RECENT P/I
+
NEW R1 +
NEW R2 -
NEW SUBSIDY

Newest P/I payment on the ARM Rates & P/I Tables tab on
the ARM Information screen, plus Reserve 1 payment
effective for the newest payment change date plus Reserve
2 payment effective for the newest payment change date
minus subsidy payment effective for the newest payment
change date

ARM NAME OF RATE
INDEX

RTCL34 Name of the index, such as LIBOR. This information is
entered on the Loans > System Setup Screens > Interest
Rate Table screen.

ARM NEW INDEX LNAPIN New index (last index)

ARM NEW INDEX WITH
OFFSET

LNAPIN +
LNAMOF

New index plus accrual rate offset/margin

ARM NEW P/I
PAYMENT

LNPINX Newly calculated P/I payment 

ARM NEW R1
PAYMENT

EFFECTIVE R1 Reserve 1 payment effective with the new payment change

ARM NEW R2
PAYMENT

EFFECTIVE R2 Reserve 2 payment effective with the new payment

ARM NEW SUBSIDY
PAYMENT

EFFECTIVE
SUBSIDY

The subsidy payment effective with the new payment

ARM NEW TOTAL
PAYMENT

NEW P/I +
NEW R1 +
NEW R2 -
NEW SUBSIDY

New P/I payment plus new Reserve 1 payment plus new
Reserve 2 payment minus new subsidy payment

ARM NEXT INTEREST
ACCRUAL RATE

LNAMNA Next accrual rate for this account

ARM NEXT RATE
CHANGE DATE

LNAMDT Date of the next rate change on the loan

ARM OLD INDEX TRLG Old (prior) index

ARM OLD P/I
PAYMENT

LNPICN Old P/I payment in effect prior to the new payment change

ARM OLD R1
PAYMENT

EFFECTIVE R1 Reserve 1 payment in effect prior to the new payment
change

ARM OLD R2
PAYMENT

EFFECTIVE R2 Reserve 2 payment in effect prior to the new payment
change

ARM OLD SUBSIDY
PAYMENT

EFFECTIVE
SUBSIDY

Subsidy payment if effect prior to the new payment change
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Merge Field Field Mnemonic/
Calculation

Description

ARM OLD TOTAL
PAYMENT

OLD P/I +
OLD R1 +
OLD R2 -
OLD SUBSIDY

Old P/I payment plus old Reserve 1 payment plus old
Reserve 2 payment minus old subsidy payment

ARM ORIGINAL RATE LNAMOA Original loan rate

ARM P/I PAYMENT
BASED ON INC LMT

LNPICN *
LNAMPL

Old P/I payment multiplied by the P/I payment increase
limit

ARM P/I PAYMENT
CHANGE COUNTER

LNAMCC Number of times the system calculates the next P/I
payment automatically

ARM P/I PAYMENT
CHANGE DATE

LNPIEF The date that the next P/I payment will replace the P/I
payment

ARM P/I PAYMENT
CHANGE FREQUENCY

LNAMPC Number of months that should occur between payment
changes

ARM P/I PAYMENT
INCREASE LIMIT

LNAMPL The percentage the P/I payment can increase with a
payment change

ARM PAYMENT RATE LNRATE The payment rate on the loan

ARM RATE CHANGE
FREQUENCY

LNAMFQ Number of months that should occur between rate changes

ARM RATE CHANGE
MINIMUM

LNAMCM The minimum percentage by which the loan rate can be
changed

ARM REMAINING
TERM

LNMATD -
LNAMDT

Month’s difference between the maturity date and next
accrual rate change date. For bi-weekly loans, take the
term in months divided by 12 multiplied by 26 to get the
number of payments. Subtract the installment from the
number of payments to get remaining payments. Take
remaining payments divided by 26 then multiply by 12 to
get the remaining term in months.

ARM SOURCE OF
RATE INDEX

RTPBDS Publishing source of the index rate. This information is
entered on the Loans > System Setup Screens > Interest
Rate Table screen.

DEFERRED INTEREST LNDEFI Deferred interest

PREPAYMENT
PENALTY END DATE

Calculated field End date of the prepayment penalty

PROJECTED PMT
PRINCIPAL PORTION

Calculated Principal portion of the projected new payment.

PROJECTED PMT
INTEREST PORTION

Calculated Interest portion of the projected new payment.
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Merge Field Field Mnemonic/
Calculation

Description

YTD DEFERRED
INTEREST

LNYTDD YTD deferred interest

 

Event 13, Reserve Tax Payment Letter

This event record is generated when the system encounters tran codes 440 (reserve 1 disbursement), 448
(reserve 1 disbursement correction), 640 (reserve 2 disbursement), and 648 (reserve 2 disbursement correction)
for a single family owner-occupied loan (collateral code 1-4 and LNOWNR is checked) for any of the following
Reserve Disbursement Type codes:

Code Tax Code Description

10 Taxes paid from reserve funds

12 Additional taxes paid from reserve

16 Property taxes

17 Special assessments-property improvements

18 Special handling-taxes paid from multiple notices or on multiple properties

19 Delinquent taxes paid for prior years from reserve account

79 Property tax - town

80 Property tax - city

81 Property tax - school

82 Property tax - utility

An event letter will be generated for each separate reserve disbursement type code processed on the account. If
multiple disbursements are performed for the same disbursement type code, only one event letter will be
generated for the combined amount.

This event letter is automatically generated; it cannot be manually ordered.

Note: No event letter 13 will be generated if a tran code 448 or 648 is processed on the same day for the same
amount as the original transaction.

Merge Field Field Mnemonic/
Calculation

Description

TAX PAID AMOUNT TRNLOG Tax paid amount from reserve

TAX DESCRIPTION TABLE Tax code description pulled from the "Tax Code" table. These
are GOLDPoint Systems-defined codes.
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Event 14, Loan Payoff Event

This event record is not generated automatically. It must be requested; however, if no payoff record exists the
letter will not be created. This letter can also be requested by using the Letter Date and Letter Number fields
on the Loans > Payoff screen. Only event letter number 14 can be requested from that screen.

Example Event 14 Letter

Merge Field Field
Mnemonic/
Calculation

Description

PO ACCRUED
INTEREST

POACIN Accrued interest applied to payoff

PO AMOUNT POPOFF Payoff amount – includes all amounts applied to payoff. Refer to
the TOTAL WITH FUTURE LATE CHARGE field below for more
information regarding the PO AMOUNT.

PO CUSTOMER
MESSAGE LINE 1

POMES1 First customer message line from payoff record

PO CUSTOMER
MESSAGE LINE 2

POMES2 Second customer message line from payoff record

PO CUSTOMER
MESSAGE LINE 3

POMES3 Third customer message line from payoff record

PO DATE PODATE Payoff date

PO EXPIRATION
DATE

POEXPD Date the payoff expires

PO FEES POFEES Loan fees applied to payoff

PO INTEREST
CALCULATION
CODE

POIBAS Interest calculation method from the payoff record

PO INTEREST ON
NEGATIVE
RESERVES

POINRI Interest on negative reserves applied to payoff

PO LATE CHARGES POLATE Late charges applied to payoff

PO LIP ACCRUED
INTEREST

POLACC LIP accrued interest applied to payoff

PO LIP CUSTOMER
BALANCE

POCBAL LIP customer balance applied to payoff

PO LIP
UNDISBURSED
BALANCE

POLBAL LIP undisbursed balance applied to payoff

PO MISC
ADJUSTMENT AMT

POAMT1 Payoff miscellaneous adjustment amount 1



GOLDEvent Letters124

© 2019 GOLDPoint SystemsLast updated: 11/25/2019

Merge Field Field
Mnemonic/
Calculation

Description

1

PO MISC
ADJUSTMENT AMT
2

POAMT2 Payoff miscellaneous adjustment amount 2

PO MISC
ADJUSTMENT AMT
3

POAMT3 Payoff miscellaneous adjustment amount 3

PO MISC
ADJUSTMENT AMT
4

POAMT4 Payoff miscellaneous adjustment amount 4

PO MISC
ADJUSTMENT AMT
5

POAMT5 Payoff miscellaneous adjustment amount 5

PO MISC
ADJUSTMENT AMT
6

POAMT6 Payoff miscellaneous adjustment amount 6

PO MISC
ADJUSTMENT AMT
7

POAMT7 Payoff miscellaneous adjustment amount 7

PO MISC
ADJUSTMENT AMT
8

POAMT8 Payoff miscellaneous adjustment amount 8

PO MISC
ADJUSTMENT AMT
9

POAMT9 Payoff miscellaneous adjustment amount 9

PO MISC
ADJUSTMENT AMT
10

POAMT10 Payoff miscellaneous adjustment amount 10

PO MISC
ADJUSTMENT AMT
11

POAMT11 Payoff miscellaneous adjustment amount 11

PO MISC
ADJUSTMENT AMT
12

POAMT12 Payoff miscellaneous adjustment amount 12

PO MISC
DESCRIPTION 1

POFLD1 Payoff miscellaneous description 1

PO MISC
DESCRIPTION 2

POFLD2 Payoff miscellaneous description 2
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Merge Field Field
Mnemonic/
Calculation

Description

PO MISC
DESCRIPTION 3

POFLD3 Payoff miscellaneous description 3

PO MISC
DESCRIPTION 4

POFLD4 Payoff miscellaneous description 4

PO MISC
DESCRIPTION 5

POFLD5 Payoff miscellaneous description 5

PO MISC
DESCRIPTION 6

POFLD6 Payoff miscellaneous description 6

PO MISC
DESCRIPTION 7

POFLD7 Payoff miscellaneous description 7

PO MISC
DESCRIPTION 8

POFLD8 Payoff miscellaneous description 8

PO MISC
DESCRIPTION 9

POFLD9 Payoff miscellaneous description 9

PO MISC
DESCRIPTION 10

POFLD10 Payoff miscellaneous description 10

PO MISC
DESCRIPTION 11

POFLD11 Payoff miscellaneous description 11

PO MISC
DESCRIPTION 12

POFLD12 Payoff miscellaneous description 12

PO
MISCELLANEOUS
FUNDS

POMISC Miscellaneous funds applied to payoff

PO NAME LINE 1 PONLN1 Name line 1 from the payoff record

PO NAME LINE 2 PONLN2 Name line 2 from the payoff record

PO NAME LINE 3 PONLN3 Name line 3 from the payoff record

PO NAME LINE 4 PONLN4 Name line 4 from the payoff record

PO PARTIAL
PAYMENTS

POPRTL Partial payments applied to payoff

PO PER DIEM PODIEM One day’s accrued interest of the principal balance plus deferred
interest

PO PER DIEM
CALCULATION
CODE

POPDBS Interest method used to figure payoff per diem

PO PRINCIPAL
BALANCE

POPBAL +
PODEFI

Principal plus deferred interest applied to payoff
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Merge Field Field
Mnemonic/
Calculation

Description

PO RATE PORATE Payoff rate

PO RSV 1 AND RSV
2 BALANCES 

POR1BL +
POR2BL

Reserve 1 and 2 balances subtracted from payoff

PO RSV 1 AND RSV
2 INTEREST 

POR1AI +
POR2AI

Reserve 1 and 2 interest subtracted from payoff

PO SUBSIDY
BALANCE

POSBAL Subsidy balance subtracted from payoff when applied

FUTURE LATE
CHARGE

Calculated late
charge

The late charge is calculated in the GOLD EventLetters program. It
is not included in the PO AMOUNT. You should use the TOTAL
WITH FUTURE LATE CHARGE (see below) to disclose the payoff,
including the future late charge.

Note: To include future late charges in the payoff quote, institution
option OP06 AFLC must be set.

TOTAL WITH
FUTURE LATE
CHARGE

POPOFF plus
calculated late
charge

This is the PO AMOUNT plus the future late charge. Refer to the
PO AMOUNT field above for more information regarding this field.

Note: To include future late charges in the payoff quote, institution
option OP06 AFLC must be set.

Event 14 Sample Letter

See the following example of a loan payoff letter:

<<EVENT_DATE>>

<<PO_NAME_LINE_1>>
<<PO_NAME_LINE_2>>
<<PO_NAME_LINE_3>>
<<PO_NAME_LINE_4>>

RE: Loan Payoff Quote
Reference Number: 
Loan number: <<FORMATTED_LOAN_NUMBER>>
Customer Name: <<IRS_OWNER_FIRST_MIDDLE_LAST_NAME>>
Property Address: <<PROPERTY_ADDRESS_LINE1>>
     <<PROPERTY_ADDRESS_CITY_STATE_ZIP>>

Dear <<PO_NAME_LINE_1>>,

The following information is per your request for a loan payoff on <<PO_DATE>>. An itemized breakdown
of the payoff amount left on this loan is listed below.



GOLDEvent Letters 127

© 2019 GOLDPoint Systems Last updated: 11/25/2019

Principal Balance     . . . . . . . . . . . . . . . . . . . . . . . . . . . .  $<<PRINCIPAL_BALANCE>>

Accrued Interest      . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . $<<ACCRUED_INTEREST>>

<<PO_MISC_DESCRIPTION_1>> .  . . . .$<<PO_MISC_ADJUSTMENT AMOUNT_1>>

<<PO_MISC_DESCRIPTION_2>> . . . . . $<<PO_MISC_ADJUSTMENT AMOUNT_2>>

Late Charges . . . . . . . . . . . . . . . . . . . . . . . . . . . .     $<<LATE_CHARGES>>

Future Late Charges . . . . . . . . . . . . . . . . . . . . . . . . . . . . $<<FUTURE LATE CHARGE>>

Total with Future Late Charge . . . . . . . . . . . . . . .$<<TOTAL WITH FUTURE LATE CHARGE>>

Total Payoff Amount (without future late charge)  . . . . . . .     $<<PO_AMOUNT>>

The accrued interest shown above is calculated to <<PO_DATE>>. If the loan is paid off on a day other
than the payoff date, the interest owed will be adjusted by a daily amount of <<PER_DIEM>>. This quote
is valid until <<PO_EXPIRATION_DATE>>. Please call for an update if payoff will be received after this
date. This loan must be kept current or a late charge will be assessed. This payoff is subject to a final
audit.

Please deliver the payoff funds to the address below by <<PO_DATE>>. If possible, please provide us with
the borrower’s new address for follow-up documentation. Thank you.

Sincerely,

GOLDPoint Systems Finance Company
E14/L##

Event 15, LIP Billing Event

This event record is automatically generated when the Prior Unpaid Charges field on the LIP Information Fields
screen is changed. This event cannot be requested annually.

Example Event 15 Letter

Merge Field Field Mnemonic/
Calculation

Description

LIP CAP PERIOD
LENGTH

LNLPLN Length of the LIP rate cap period

LIP CHARGE
AMOUNT

LNLCGA LIP charge amount

LIP CURRENT
INTEREST DUE

TRNLOG Current LIP interest (same as last billed amount)

LIP DATE PERIOD
STARTS

LNLPSD Starting date of the current LIP rate cap period
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Merge Field Field Mnemonic/
Calculation

Description

LIP DAYS
BEFORE RATE
CHANGE

LNLDYS Days before the LIP rate change date to calc next rate

LIP INSPECTION
DATE

LNLIND LIP date of last or next inspection

LIP INTEREST
RETENTION

LNLRIN LIP interest retention amount
(To be used only if you do not use the LIP budgets)

LIP NEXT BILL OR
CHARGE DATE

LNLDUE Next date LIP interest is to be charged or billed

LIP NEXT
INTEREST RATE

LNLNXT Next LIP interest rate

LIP OLD BILL OR
CHARGE DATE

TRNLOG Current LIP billing date

LIP PERIODIC
RATE MAXIMUM

LNLPMX Maximum points per period the LIP rate can increase

LIP PERIODIC
RATE MINIMUM

LNLPMN Maximum points per period the LIP rate can decrease

LIP PERIODIC
START RATE

LNLPSR Starting rate of the rate cap period

LIP PRIOR UNPAID
NEW CHARGES

LNLPCG Prior unpaid interest after current LIP billing

LIP PRIOR UNPAID
OLD CHARGES

TRNLOG Prior unpaid interest before current LIP billing

LIP RATE
CHANGE DATE

LNLCHD Next date the LIP rate will change

LIP RATE
CHANGE
FREQUENCY

LNLFRQ Number of months that pass between rate rolls

LIP RETENTION
AMOUNT

LNLRET LIP retention amount (Funds to be held for miscellaneous
reasons. This should not be used if you use the LIP
budgets.)

LIP TOTAL DUE
WITH LATE AND
FEES

TRNLOG + LNLATE +
LNFEES

Total unpaid (current plus prior) interest plus late charges
and loan fees

LIP TOTAL DUE
WITH LATE CHGS

TRNLOG + LNLATE Total unpaid (current plus prior) interest plus late charges

LIP TOTAL
INTEREST DUE

TRNLOG Total unpaid interest due (current interest plus prior unpaid
interest)
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Event 15 Sample Letter

See the following example of an LIP billing letter:

<<EVENT_DATE>>

<<ACCOUNT_FIRST_MIDDLE_LAST_NAME_1>>
<<ACCOUNT_FIRST_MIDDLE_LAST_NAME_2>>
<<MAIL_ADDRESS_LINE1>>
<<MAIL_ADDRESS_CITY_STATE_ZIP>>

RE: Loan Number: <<FORMATTED_LOAN_NUMBER>>
Loan Balance: $<<PRINCIPAL_BALANCE>>
Property Address:
   <<PROPERTY_ADDRESS_LINE1>>
   <<PROPERTY_ADDRESS_CITY_STATE_ZIP>>

Dear Customer,

This letter is to inform you that the interest on your GOLDPoint Systems Finance Company construction
loan is due. The following is an itemized breakdown of what you owe.

LIP Prior Unpaid Charges Due: 
<<DUE_DATE_ALPHA>> <<LIP_PRIOR_UNPAID_OLD_CHARGES>>

Total Amount Due: 
<<LIP_NEXT_BILL_OR_CHARGE_DATE>>  $<<LIP_TOTAL_INTEREST_DUE>>

Grand Total Due: $<<LIP_TOTAL_DUE_WITH_LATE_CHGS>>

Please submit your payment to the address below by <<LIP_NEXT_BILL_OR_CHARGE_DATE>>. If you
have any questions regarding this payment or your construction loan, please contact the Construction
Department at (555) 555-5555. Thank you.

Sincerely,

GOLDPoint Systems Finance Company

E15/L##

Event 16, LIP Reminder Event

This event record is not generated automatically. It must be requested.

Example Event 16 Letter
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Merge Field Field Mnemonic/
Calculation

Description

LIP CAP PERIOD
LENGTH

LNLPLN Length of the LIP rate cap period

LIP CHARGE AMOUNT LNLCGA LIP charge amount

LIP DATE PERIOD
STARTS

LNLPSD Starting date of the current LIP rate cap period

LIP DAYS BEFORE
RATE CHANGE

LNLDYS Days before the LIP rate change date to calc next
rate

LIP INSPECTION DATE LNLIND LIP date of last or next inspection

LIP INTEREST
RETENTION

LNLRIN LIP interest retention amount (To be used only if you
do not use the LIP budgets.)

LIP LAST BILLED
AMOUNT

LNLSTB Last billed amount

LIP NEXT BILL OR
CHARGE DATE

LNLDUE Next date LIP interest is to be charged or billed

LIP NEXT INTEREST
RATE

LNLNXT Next LIP interest rate

LIP PERIODIC RATE
MAXIMUM

LNLPMX Maximum points per period the LIP rate can decrease

LIP PERIODIC START
RATE

LNLPMN Maximum points per period the LIP rate can decrease

LIP PERIODIC RATE
MINIMUM

LNLPSR Starting rate of the rate cap period

LIP PRIOR UNPAID
CHARGES

LNLPCG Prior unpaid interest after current LIP billing

LIP PRIOR UNPAID W
PROJECTED LATE

LNLPCG + CALC LATE Prior unpaid interest with projected late charges

LIP RATE CHANGE
DATE

LNLCHD Next date the LIP rate will change

LIP RATE CHANGE
FREQUENCY

LNLFRQ Number of months that pass between rate rolls

LIP RETENTION
AMOUNT

LNLRET LIP retention amount (Funds to be held for
miscellaneous reasons. This should not be used if
you use the LIP budgets.)

LIP TOTAL DUE WITH
LATE AND FEES

LNLPCG + LNLATE +
LNFEES

Total unpaid interest plus late charges and loan fees

LIP TOTAL DUE WITH
LATE CHGS

LNLPCG+LNLATE Total unpaid interest plus late charges
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Event 16 Sample Letter

See the following example of an LIP reminder letter:

<<EVENT_DATE>>

<<IRS_OWNER_FIRST_MIDDLE_LAST_NAME>>
<<MAIL_ADDRESS_LINE1>>
<<MAIL_ADDRESS_CITY_STATE_ZIP>>

RE: Loan Number: <<FORMATTED_LOAN_NUMBER>>
Loan Balance: <<PRINCIPAL_BALANCE>>
Property Address:
   <<PROPERTY_ADDRESS_LINE1>>
   <<PROPERTY_ADDRESS_CITY_STATE_ZIP>>

Dear <<IRS_OWNER_FIRST_MIDDLE_LAST_NAME>>

The interest on your GOLDPoint Systems Finance Company construction loan was due
<<DUE_DATE_ALPHA>>.

You still owe $<<LIP_TOTAL_DUE_WITH_LATE_CHGS>> before your account will become current.
Please submit the amount within five (5) days to avoid penalties. If you have any questions regarding this
payment, contact the Construction Department at (555) 555-5555. Thank you.

Sincerely,

GOLDPoint Systems Finance Company

E16/L##

Event 17, ARM Accrual Rate Up, Payment Change, Rate Caps,
Lifetime Caps

This event record is generated automatically when the accrual rate goes up, a new P/I payment is calculated,
periodic rate caps are used (Use Rate Cap field on the ARM Information screen (payment method 6 or 7 loans)
is checked) and lifetime rate caps are used (the new rate is equal to the lifetime minimum cap or the lifetime
maximum cap).

Merge Field Field Mnemonic/
Calculation

Description

ARM 2ND NEXT P/I
CHANGE DATE

LNPIEF + 
LNAMPC

P/I effective date plus the P/I payment change frequency
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Merge Field Field Mnemonic/
Calculation

Description

ARM 2ND NEXT RATE
CHANGE DATE

LNAMDT +
LNAMFQ

Next accrual rate change date plus the rate change
frequency

ARM AMORTIZED P/I
PAYMENT 

LNAPIC The P/I payment required to fully amortize the loan

ARM AMORTIZED
PRINCIPAL BALANCE

AMTZ PRIN The principal balance on which the new adjusted
payment is based

ARM BASE INDEX LNBINX Base index value used when calculating the new rate on
the loan account when the Use this Base Index Rate
option displays a checkmark

ARM DAYS BEFORE
RATE CHANGE

LNAMAD Days before the next accrual rate change date to
calculate a new rate

ARM DIFF BETWEEN
NXT CURRENT INDEX

NEW INDEX-
OLD INDEX

Difference between the next accrual index and current
accrual index

ARM DIFF BETWEEN
NXT ORIGINAL RATE

LNAMNA-
LNAMOA

Difference between the next accrual rate and the original
rate

ARM GRADUATED
PMT INCREASE
PERCENT

LNAMGI The percentage the P/I payment will increase each P/I
payment frequency

ARM INDEX PLUS
OFFSET LESS ACCR
RT

NEW INDEX+
LNAMOF-
LNAMRT

New index plus the accrual rate offset/margin minus
accrual rate

ARM INDEX
PUBLISHING
FREQUENCY

RTPBFQ Frequency the index is published (e.g., weekly, daily)

ARM INTEREST
ACCRUAL RATE

LNAMRT The rate at which interest should accrue for payment
method 7 loans

ARM INTEREST ONLY
P/I PAYMENT 

LNIPIC The P/I payment required to satisfy the calculated
interest

ARM INTEREST RATE
POINTER

LNAMPT The accrual rate pointer that is tied to the rate index

ARM MOST RECENT
P/I CHANGE DATE

Newest P/I change date on the ARM Rates & P/I Tables
tab on the ARM Information screen

ARM MOST RECENT
P/I PAYMENT 

Newest P/I payment in accrual rate and P/I change table
(ARM Rates & P/I Tables tab on the ARM Information
screen)

ARM MOST RECENT
TOTAL PAYMENT

MOST RECENT P/I +
NEW R1 +
NEW R2 -
NEW SUBSIDY

Newest P/I payment on the ARM Rates & P/I Tables tab
on the ARM Information screen, plus Reserve 1 payment
effective for the newest payment change date plus
Reserve 2 payment effective for the newest payment
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Merge Field Field Mnemonic/
Calculation

Description

change date minus subsidy payment effective for the
newest payment change date

ARM NAME OF RATE
INDEX

RTCL34 Name of the index, such as LIBOR. This information is
entered on the Loans > System Setup Screens >
Interest Rate Table screen.

ARM NEW INDEX LNAPIN New index (last index)

ARM NEW INDEX
WITH OFFSET

LNAPIN +
LNAMOF

New index plus accrual rate offset/margin

ARM NEW P/I
PAYMENT

LNPINX Newly calculated P/I payment 

ARM NEW R1
PAYMENT

EFFECTIVE R1 Reserve 1 payment effective with the new payment
change

ARM NEW R2
PAYMENT

EFFECTIVE R2 Reserve 2 payment effective with the new payment

ARM NEW SUBSIDY
PAYMENT 

EFFECTIVE SUBSIDY The subsidy payment effective with the new payment

ARM NEW TOTAL
PAYMENT

NEW P/I +
NEW R1 +
NEW R2 -
NEW SUBSIDY

New P/I payment plus new Reserve 1 payment plus new
Reserve 2 payment minus new subsidy payment

ARM NEXT INTEREST
ACCRUAL RATE

LNAMNA Next accrual rate for this account

ARM NEXT RATE
CHANGE DATE

LNAMDT Date of the next rate change on the loan

ARM OLD INDEX TRLG Old (prior) index

ARM OLD P/I
PAYMENT

LNPICN Old P/I payment in effect prior to the new payment
change

ARM OLD R1
PAYMENT

EFFECTIVE R1 Reserve 1 payment in effect prior to the new payment
change

ARM OLD R2
PAYMENT

EFFECTIVE R2 Reserve 2 payment in effect prior to the new payment
change

ARM OLD SUBSIDY
PAYMENT 

EFFECTIVE SUBSIDY Subsidy payment if effect prior to the new payment
change

ARM OLD TOTAL
PAYMENT

OLD P/I +
OLD R1 +
OLD R2 -
OLD SUBSIDY

Old P/I payment plus old Reserve 1 payment plus old
Reserve 2 payment minus old subsidy payment

ARM ORIGINAL RATE LNAMOA Original loan rate
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Merge Field Field Mnemonic/
Calculation

Description

ARM P/I PAYMENT
BASED ON INC LMT

LNPICN *
LNAMPL

Old P/I payment multiplied by the P/I payment increase
limit

ARM P/I PAYMENT
CHANGE COUNTER

LNAMCC Number of times the system calculates the next P/I
payment automatically

ARM P/I PAYMENT
CHANGE DATE

LNPIEF The date that the next P/I payment will replace the P/I
payment

ARM P/I PAYMENT
CHANGE
FREQUENCY

LNAMPC Number of months that should occur between payment
changes

ARM P/I PAYMENT
INCREASE LIMIT

LNAMPL The percentage the P/I payment can increase with a
payment change

ARM PAYMENT RATE LNRATE The payment rate on function 1 of the loan system

ARM RATE AT
PERIOD START

LNAMSY Rate at the start of the rate cap period

ARM RATE CHANGE
FREQUENCY

LNAMFQ Number of months that should occur between rate
changes

ARM RATE CHANGE
MINIMUM

LNAMCM The minimum percentage by which the loan rate can be
changed

ARM REMAINING
TERM

LNMATD -
LNAMDT

Month’s difference between the maturity date and next
accrual rate change date. For bi-weekly loans, take the
term in months divided by 12 multiplied by 26 to get the
number of payments. Subtract the installment from the
number of payments to get remaining payments. Take
remaining payments divided by 26 then multiply by 12 to
get the remaining term in months.

ARM SOURCE OF
RATE INDEX

RTPBFQ Publishing source of the index rate (e.g., Wall Street
Journal). This information is entered on the Loans >
System Setup Screens > Interest Rate Table screen.

ARM START OF
ACCRUAL PERIOD

LNAMPD Starting date of the current rate cap period

PREPAYMENT
PENALTY END DATE

Calculated field End date of the prepayment penalty

PROJECTED PMT
PRINCIPAL PORTION

Calculated Principal portion of the projected new payment.

PROJECTED PMT
INTEREST PORTION

Calculated Interest portion of the projected new payment.
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Event 18, ARM Accrual Rate Down, Payment Change, Rate
Caps, Lifetime Caps

This event record is generated automatically when the accrual rate goes down, a new P/I constant is calculated,
periodic rate caps are used (Use Rate Cap field displays a checkmark on the Loans > Account Information >
ARM Information screen for payment method 6 or 7 loans) and lifetime rate caps are used. (The new rate is
equal to the lifetime minimum cap or lifetime maximum cap.)

Merge Field Field Mnemonic/
Calculation

Description

ARM 2ND NEXT P/I
CHANGE DATE

LNPIEF +
LNAMPC

P/I effective date plus the P/I payment change
frequency

ARM 2ND NEXT RATE
CHANGE DATE

LNAMDT +
LNAMFQ

Next accrual rate change date plus the rate change
frequency

ARM AMORTIZED P/I
PAYMENT

LNAPIC The P/I payment required to fully amortize the loan

ARM AMORTIZED
PRINCIPAL BALANCE

AMTZ PRIN The principal balance on which the new adjusted
payment is based

ARM BASE INDEX LNBINX Base index value used when calculating the new
rate on the loan account when the Use this Base
Index Rate displays a checkmark

ARM DAYS BEFORE RATE
CHANGE

LNAMAD Days before the next accrual rate change date to
calculate a new rate

ARM DIFF BETWEEN NXT
CURRENT INDEX

NEW INDEX -
OLD INDEX

Difference between the next accrual index and
current accrual index

ARM DIFF BETWEEN NXT
ORIGINAL RATE

LNAMNA-
LNAMOA

Difference between the next accrual rate and the
original rate

ARM GRADUATED PMT
INCREASE PERCENT

LNAMGI The percentage the P/I payment will increase each
P/I payment frequency

ARM INDEX PLUS OFFSET
LESS ACCR RT

NEW INDEX +
LNAMOF -
LNAMRT

New index plus the accrual rate offset/margin minus
accrual rate

ARM INDEX PUBLISHING
FREQUENCY

RTPBFQ Frequency the index is published (e.g., daily,
weekly). This information is entered on the Loans >
System Setup Screens > Interest Rate Table
screen.

ARM INTEREST ACCRUAL
RATE

LNAMRT The rate at which interest should accrue for payment
method 7 loans

ARM INTEREST ONLY P/I
PAYMENT

LNIPIC The P/I payment required to satisfy the calculated
interest

ARM INTEREST RATE
POINTER

LNAMPT The accrual rate pointer that is tied to the rate index
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Merge Field Field Mnemonic/
Calculation

Description

ARM MOST RECENT P/I
CHANGE DATE

Newest P/I change date on the ARM Rates & P/I
Tables tab on the ARM Information screen

ARM MOST RECENT P/I
PAYMENT

Newest P/I payment on the ARM Rates & P/I Tables
tab on the ARM Information screen

ARM MOST RECENT
TOTAL PAYMENT

MOST RECENT P/I +
NEW R1 +
NEW R2 -
NEW SUBSIDY

Newest P/I payment on the ARM Rates & P/I Tables
tab on the ARM Information screen, plus Reserve 1
payment effective for the newest payment change
date plus Reserve 2 payment effective for the newest
payment change date minus subsidy payment
effective for the newest payment change date

ARM NAME OF RATE
INDEX

RTCL34 Name of the index, such as LIBOR. This information
is entered on the Loans > System Setup Screens >
Interest Rate Table screen.

ARM NEW INDEX LNAPIN New index (last index)

ARM NEW INDEX WITH
OFFSET

LNAPIN +
LNAMOF

New index plus accrual rate offset/margin

ARM NEW P/I PAYMENT LNPINX Newly calculated P/I payment 

ARM NEW R1 PAYMENT EFFECTIVE R1 Reserve 1 payment effective with the new payment
change

ARM NEW R2 PAYMENT EFFECTIVE R2 Reserve 2 payment effective with the new payment

ARM NEW SUBSIDY
PAYMENT

EFFECTIVE SUBSIDY The subsidy payment effective with the new payment

ARM NEW TOTAL
PAYMENT

NEW P/I +
NEW R1 +
NEW R2 -
NEW SUBSIDY

New P/I payment plus new Reserve 1 payment plus
new Reserve 2 payment minus new subsidy
payment

ARM NEXT INTEREST
ACCRUAL RATE

LNAMNA Next accrual rate for this account

ARM NEXT RATE CHANGE
DATE

LNAMDT Date of the next rate change on the loan

ARM OLD INDEX TRLG Old (prior) index

ARM OLD P/I PAYMENT LNPICN Old P/I payment in effect prior to the new payment
change

ARM OLD R1 PAYMENT EFFECTIVE R1 Reserve 1 payment in effect prior to the new
payment change

ARM OLD R2 PAYMENT EFFECTIVE R2 Reserve 2 payment in effect prior to the new
payment change
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Merge Field Field Mnemonic/
Calculation

Description

ARM OLD SUBSIDY
PAYMENT

EFFECTIVE SUBSIDY Subsidy payment if effect prior to the new payment
change

ARM OLD TOTAL
PAYMENT

OLD P/I +
OLD R1 +
OLD R2 -
OLD SUBSIDY

Old P/I payment plus old Reserve 1 payment plus
old Reserve 2 payment minus old subsidy payment

ARM ORIGINAL RATE LNAMOA Original loan rate

ARM P/I PAYMENT BASED
ON INC LMT

LNPICN *
LNAMPL

Old P/I payment multiplied by the P/I payment
increase limit

ARM P/I PAYMENT
CHANGE COUNTER

LNAMCC Number of times the system calculates the next P/I
payment automatically

ARM P/I PAYMENT
CHANGE DATE

LNPIEF The date that the next P/I payment will replace the
P/I payment

ARM P/I PAYMENT
CHANGE FREQUENCY

LNAMPC Number of months that should occur between
payment changes

ARM P/I PAYMENT
INCREASE LIMIT

LNAMPL The percentage the P/I payment can increase with a
payment change

ARM PAYMENT RATE LNRATE The payment rate on the loan 

ARM RATE AT PERIOD
START

LNAMSY Rate at the start of the rate cap period

ARM RATE CHANGE
FREQUENCY

LNAMFQ Number of months that should occur between rate
changes

ARM RATE CHANGE
MINIMUM

LNAMCM The minimum percentage by which the loan rate can
be changed

ARM REMAINING TERM LNMATD -
LNAMDT

Month’s difference between the maturity date and
next accrual rate change date. For bi-weekly loans,
take the term in months divided by 12 multiplied by
26 to get the number of payments. Subtract the
installment from the number of payments to get
remaining payments. Take remaining payments
divided by 26 then multiply by 12 to get the
remaining term in months.

ARM SOURCE OF RATE
INDEX

RTPBDS Publishing source of the index rate (e.g., Wall Street
Journal). This information is entered on the Loans >
System Setup Screens > Interest Rate Table
screen.

ARM START OF ACCRUAL
PERIOD

LNAMPD Starting date of the current rate cap period
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Merge Field Field Mnemonic/
Calculation

Description

PREPAYMENT PENALTY
END DATE

Calculated field End date of the prepayment penalty

PROJECTED PMT
PRINCIPAL PORTION

Calculated Principal portion of the projected new payment.

PROJECTED PMT
INTEREST PORTION

Calculated Interest portion of the projected new payment.

Event 19, ARM Accrual Rate Up, Payment Change, Lifetime
Caps

This event record is generated automatically when the ARM accrual rate goes up, a new P/I payment is
calculated, and lifetime rate caps are used (the new rate is equal to the lifetime minimum cap or the lifetime
maximum cap).

Merge Field Field Mnemonic/
Calculation

Description

ARM 2ND NEXT P/I
CHANGE DATE

LNPIEF +
LNAMPC

P/I effective date plus the P/I payment change frequency

ARM 2ND NEXT RATE
CHANGE DATE

LNAMDT +
LNAMFQ

Next accrual rate change date plus the rate change
frequency

ARM AMORTIZED P/I
PAYMENT

LNAPIC The P/I payment required to fully amortize the loan

ARM AMORTIZED
PRINCIPAL BALANCE

AMTZ PRIN The principal balance on which the new adjusted
payment is based

ARM BASE INDEX LNBINX Base index value used when calculating the new rate on
the loan account when the Use this Base Index Rate
field displays a checkmark

ARM DAYS BEFORE
RATE CHANGE

LNAMAD Days before the next accrual rate change date to
calculate a new rate

ARM DIFF BETWEEN
NXT CURRENT INDEX

NEW INDEX -
OLD INDEX

Difference between the next accrual index and current
accrual index

ARM DIFF BETWEEN
NXT ORIGINAL RATE

LNAMNA -
LNAMOA

Difference between the next accrual rate and the original
rate

ARM GRADUATED
PMT INCREASE
PERCENT

LNAMGI The percentage the P/I payment will increase each P/I
payment frequency

ARM INDEX
PUBLISHING

RTPBFQ Frequency the index is published. This information is
entered on the Loans > System Setup Screens >
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Merge Field Field Mnemonic/
Calculation

Description

FREQUENCY Interest Rate Table screen.

ARM INTEREST
ACCRUAL RATE

LNAMRT The rate at which interest should accrue for payment
method 7 loans

ARM INTEREST ONLY
P/I PAYMENT

LNIPIC The P/I payment required to satisfy the calculated
interest

ARM INTEREST RATE
POINTER

LNAMPT The accrual rate pointer that is tied to the rate index

ARM MOST RECENT
P/I CHANGE DATE

Newest P/I change date on the ARM Rates & P/I Tables
tab on the ARM Information screen

ARM MOST RECENT
P/I PAYMENT

Newest P/I payment on the ARM Rates & P/I Tables tab
on the ARM Information screen

ARM MOST RECENT
TOTAL PAYMENT

MOST RECENT P/I +
NEW R1 +
NEW R2 -
NEW SUBSIDY

Newest P/I payment on the ARM Rates & P/I Tables tab
on the ARM Information screen, plus Reserve 1 payment
effective for the newest payment change date plus
Reserve 2 payment effective for the newest payment
change date minus subsidy payment effective for the
newest payment change date

ARM NAME OF RATE
INDEX

RTCL34 Name of the index, such as LIBOR. This information is
entered on the Loans > System Setup Screens >
Interest Rate Table screen.

ARM NEW INDEX LNAPIN New index (last index)

ARM NEW INDEX
WITH OFFSET

LNAPIN +
LNAMOF

New index plus accrual rate offset/margin

ARM NEW P/I
PAYMENT

LNPINX Newly calculated P/I payment 

ARM NEW R1
PAYMENT

EFFECTIVE R1 The Reserve 1 payment effective with the new payment
change

ARM NEW R2
PAYMENT

EFFECTIVE R2 Reserve 2 payment effective with the new payment

ARM NEW SUBSIDY
PAYMENT

EFFECTIVE SUBSIDY The subsidy payment effective with the new payment

ARM NEW TOTAL
PAYMENT

NEW P/I +
NEW R1 +
NEW R2 -
NEW SUBSIDY

New P/I payment plus new Reserve 1 payment plus new
Reserve 2 payment minus new subsidy payment

ARM NEXT INTEREST
ACCRUAL RATE

LNAMNA Next accrual rate for this account
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Merge Field Field Mnemonic/
Calculation

Description

ARM NEXT RATE
CHANGE DATE

LNAMDT Date of the next rate change on the loan

ARM OLD INDEX TRLG Old (prior) index

ARM OLD P/I
PAYMENT

LNPICN Old P/I payment in effect prior to the new payment
change

ARM OLD R1
PAYMENT

EFFECTIVE R1 Reserve 1 payment in effect prior to the new payment
change

ARM OLD R2
PAYMENT

EFFECTIVE R2 Reserve 2 payment in effect prior to the new payment
change

ARM OLD SUBSIDY
PAYMENT

EFFECTIVE SUBSIDY Subsidy payment if effect prior to the new payment
change

ARM OLD TOTAL
PAYMENT

OLD P/I +
OLD R1 +
OLD R2 -
OLD SUBSIDY

Old P/I payment plus old Reserve 1 payment plus old
Reserve 2 payment minus old subsidy payment

ARM ORIGINAL RATE LNAMOA Original loan rate

ARM P/I PAYMENT
BASED ON INC LMT

LNPICN*
LNAMPL

Old P/I payment multiplied by the P/I payment increase
limit

ARM P/I PAYMENT
CHANGE COUNTER

LNAMCC Number of times the system calculates the next P/I
payment automatically

ARM P/I PAYMENT
CHANGE DATE

LNPIEF The date that the next P/I payment will replace the P/I
payment

ARM P/I PAYMENT
CHANGE
FREQUENCY

LNAMPC Number of months that should occur between payment
changes

ARM P/I PAYMENT
INCREASE LIMIT

LNAMPL The percentage the P/I payment can increase with a
payment change

ARM PAYMENT RATE LNRATE The payment rate on the loan 

ARM RATE CHANGE
FREQUENCY

LNAMFQ Number of months that should occur between rate
changes

ARM RATE CHANGE
MINIMUM

LNAMCM The minimum percentage by which the loan rate can be
changed

ARM REMAINING
TERM

LNMATD-
LNAMDT

Month’s difference between the maturity date and next
accrual rate change date. For bi-weekly loans, take the
term in months divided by 12 multiplied by 26 to get the
number of payments. Subtract the installment from the
number of payments to get remaining payments. Take
remaining payments divided by 26 then multiply by 12 to
get the remaining term in months.
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Merge Field Field Mnemonic/
Calculation

Description

ARM SOURCE OF
RATE INDEX

RTPBDS Publishing source of the index rate (e.g., Wall Street
Journal). This information is entered on the Loans >
System Setup Screens > Interest Rate Table screen.

PREPAYMENT
PENALTY END DATE

Calculated field End date of the prepayment penalty

PROJECTED PMT
PRINCIPAL PORTION

Calculated Principal portion of the projected new payment.

PROJECTED PMT
INTEREST PORTION

Calculated Interest portion of the projected new payment.

Event 20, ARM Accrual Rate Down, Payment Change, Lifetime
Caps

This event record is generated automatically when the ARM accrual rate goes down, a new P/I payment is
calculated, and lifetime rate caps are used (the new rate is equal to the lifetime minimum cap or the lifetime
maximum cap).

Merge Field Field Mnemonic/
Calculation

Description

ARM 2ND NEXT P/I
CHANGE DATE

LNPIEF +
LNAMPC

P/I effective date plus the P/I payment change
frequency

ARM 2ND NEXT RATE
CHANGE DATE

LNAMDT +
LNAMFQ

Next accrual rate change date plus the rate change
frequency

ARM AMORTIZED P/I
PAYMENT

LNAPIC The P/I payment required to fully amortize the loan

ARM AMORTIZED
PRINCIPAL BALANCE

AMTZ PRIN The principal balance on which the new adjusted
payment is based

ARM BASE INDEX LNBINX Base index value used when calculating the new rate
on the loan account when the Use this Base Index
Rate field displays a checkmark

ARM DAYS BEFORE
RATE CHANGE

LNAMAD Days before the next accrual rate change date to
calculate a new rate

ARM DIFF BETWEEN
NXT CURRENT INDEX

NEW INDEX-
OLD INDEX

Difference between the next accrual index and current
accrual index

ARM DIFF BETWEEN
NXT ORIGINAL RATE

LNAMNA-
LNAMOA

Difference between the next accrual rate and the
original rate

ARM GRADUATED PMT
INCREASE PERCENT

LNAMGI The percentage the P/I payment will increase each P/I
payment frequency
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Merge Field Field Mnemonic/
Calculation

Description

ARM INDEX
PUBLISHING
FREQUENCY

RTPBFQ Frequency the index is published (e.g., weekly, daily).
This information is entered on the Loans > System
Setup Screens > Interest Rate Table screen.

ARM INTEREST
ACCRUAL RATE

LNAMRT The rate at which interest should accrue for payment
method 7 loans

ARM INTEREST ONLY
P/I PAYMENT

LNIPIC The P/I payment required to satisfy the calculated
interest

ARM INTEREST RATE
POINTER

LNAMPT The accrual rate pointer that is tied to the rate index

ARM MOST RECENT P/I
CHANGE DATE

Newest P/I change date on the ARM Rates & P/I
Tables tab on the ARM Information screen

ARM MOST RECENT P/I
PAYMENT

Newest P/I payment on the ARM Rates & P/I Tables
tab on the ARM Information screen

ARM MOST RECENT
TOTAL PAYMENT

MOST RECENT P/I +
NEW R1 +
NEW R2 -
NEW SUBSIDY

Newest P/I payment on the ARM Rates & P/I Tables
tab on the ARM Information screen, plus Reserve 1
payment effective for the newest payment change date
plus Reserve 2 payment effective for the newest
payment change date minus subsidy payment effective
for the newest payment change date

ARM NAME OF RATE
INDEX

RTCL34 Name of the index, such as LIBOR. This information is
entered on the Loans > System Setup Screens >
Interest Rate Table screen.

ARM NEW INDEX LNAPIN New index (last index)

ARM NEW INDEX WITH
OFFSET

LNAPIN +
LNAMOF

New index plus accrual rate offset/margin

ARM NEW P/I
PAYMENT

LNPINX Newly calculated P/I payment 

ARM NEW R1
PAYMENT

EFFECTIVE R1 Reserve 1 payment effective with the new payment
change

ARM NEW R2
PAYMENT

EFFECTIVE R2 Reserve 2 payment effective with the new payment

ARM NEW SUBSIDY
PAYMENT

EFFECTIVE SUBSIDY The subsidy payment effective with the new payment

ARM NEW TOTAL
PAYMENT

NEW P/I +
NEW R1 +
NEW R2 -
NEW SUBSIDY

New P/I payment plus new Reserve 1 payment plus
new Reserve 2 payment minus new subsidy payment

ARM NEXT INTEREST
ACCRUAL RATE

LNAMNA Next accrual rate for this account
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Merge Field Field Mnemonic/
Calculation

Description

ARM NEXT RATE
CHANGE DATE

LNAMDT Date of the next rate change on the loan

ARM OLD INDEX TRLG Old (prior) index

ARM OLD P/I PAYMENT LNPICN Old P/I payment in effect prior to the new payment
change

ARM OLD R1 PAYMENT EFFECTIVE R1 Reserve 1 payment in effect prior to the new payment
change

ARM OLD R2 PAYMENT EFFECTIVE R2 Reserve 2 payment in effect prior to the new payment
change

ARM OLD SUBSIDY
PAYMENT

EFFECTIVE SUBSIDY Subsidy payment if effect prior to the new payment
change

ARM OLD TOTAL
PAYMENT

OLD P/I +
OLD R1 +
OLD R2 -
OLD SUBSIDY

Old P/I payment plus old Reserve 1 payment plus old
Reserve 2 payment minus old subsidy payment

ARM ORIGINAL RATE LNAMOA Original loan rate

ARM P/I PAYMENT
BASED ON INC LMT

LNPICN *
LNAMPL

Old P/I payment multiplied by the P/I payment
increase limit

ARM P/I PAYMENT
CHANGE COUNTER

LNAMCC Number of times the system calculates the next P/I
payment automatically

ARM P/I PAYMENT
CHANGE DATE

LNPIEF The date that the next P/I payment will replace the P/I
payment

ARM P/I PAYMENT
CHANGE FREQUENCY

LNAMPC Number of months that should occur between payment
changes

ARM P/I PAYMENT
INCREASE LIMIT

LNAMPL The percentage the P/I payment can increase with a
payment change

ARM PAYMENT RATE LNRATE The payment rate on the loan 

ARM RATE CHANGE
FREQUENCY

LNAMFQ Number of months that should occur between rate
changes

ARM RATE CHANGE
MINIMUM

LNAMCM The minimum percentage by which the loan rate can
be changed

ARM REMAINING TERM LNMATD-
LNAMDT

Month’s difference between the maturity date and next
accrual rate change date. For bi-weekly loans, take
the term in months divided by 12 multiplied by 26 to
get the number of payments. Subtract the installment
from the number of payments to get remaining
payments. Take remaining payments divided by 26
then multiply by 12 to get the remaining term in
months.
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Merge Field Field Mnemonic/
Calculation

Description

ARM SOURCE OF
RATE INDEX

RTPBDS Publishing source of the index rate (e.g., Wall Street
Journal). This information is entered on the Loans >
System Setup Screens > Interest Rate Table screen.

PREPAYMENT
PENALTY END DATE

Calculated field End date of the prepayment penalty

PROJECTED PMT
PRINCIPAL PORTION

Calculated Principal portion of the projected new payment.

PROJECTED PMT
INTEREST PORTION

Calculated Interest portion of the projected new payment.

Event 21, New Loan Event

This event record is generated when the system encounters tran code 680 (new loan) for ARM loans.

Example Event 21 Letter

Merge Field Field Mnemonic/
Calculation

Description

AUTO MAKE FIRST,

SECOND, THIRD

CFMAKE Make (Loans > Collateral Detail screen)

AUTO MODEL FIRST,

SECOND, THIRD

CFMODL Model (Loans > Collateral Detail screen)

AUTO YEAR FIRST,

SECOND, THIRD

CFYEAR Year (Loans > Collateral Detail screen)

DAYS BEFORE PAYMENT
CHANGE

LNAMID Days prior to next P/I change date to calculate
payment

DAYS BEFORE RATE
CHANGE

LNAMAD Days prior to next rate change date to calculate
rate

ROUND RATE E T Q LNRRND Round rate to the eighth, tenth, or quarter

VIN NUMBER FIRST,

SECOND, THIRD

CFVIN1 VIN (Loans > Collateral Detail screen)

The following merge fields are also available if you would like, but you will need to contact your GOLDPoint
Systems account manager to have these fields programmed for your institution.

Merge Field Field
Mnemonic/Calculation

Description
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DATE DUE DATE ROLLED LNROLL Date Due Last Rolled (Loans > Account

Information > Payment Information screen)

DATE LAST PAID LNDTLP Last Payment Date (Loans > Account

Information > Account Detail screen, Payment

Detail tab)

EMAIL E0EMEL Email Address (Customer Relationship

Management > Households screen)

FEES REMAINING AMOUNT LNFREM Remaining Fees (Loans > Account Information

> Deferred Fees screen)

FORCE NEXT FOLLOW-UP
DATE

QAFDTE Follow-up Date (Loans > Marketing and
Collections screen, Contact tab)

INTEREST START DATE OTINDT Interest Start Date (Loans > Cards and

Promotions screen, Disclosure Information tab)

LAST ACTIVITY LNACTV Last Activity (Loans > Account Information >

Account Detail screen, Account tab)

LAST PAID AMOUNT LNLPMA Last Payment Amount (Loans > Account

Information > Account Detail screen, Payment

Detail tab)

PAYOFF LNCLAT Payoff Amount (Loans > Account Information >

Additional Loan Fields screen,

Origination/Maturity tab)

Event 21 Sample Letters

See the following examples of new loan event letters:

Example 1: New Loan Account

<<EVENT_DATE>>

<<ACCOUNT_FIRST_MIDDLE_LAST_NAME_1>>
<<ACCOUNT_FIRST_MIDDLE_LAST_NAME_2>>
<<MAIL_ADDRESS_LINE1>>
<<MAIL_ADDRESS_CITY_STATE_ZIP>>  

RE: Account number <<FORMATTED_LOAN_NUMBER>>

Dear Borrower:

https://secure.goldpointsystems.com/gpsdocs/loans/LoansCIMGOLD/index.asp?miscdatapayoffamount_lalf.asp
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I would like to take this opportunity to thank you for allowing us to assist you in meeting your financial
needs. Your first payment will be due on <<DUE_DATE_ALPHA>>.

For your convenience we also have a pre-authorized payment plan which can be automatically withdrawn
from your checking account on a special date each month and applied to your loan.

Should you have any questions regarding this information, please feel free to call us at (555) 555-5555.

Sincerely,

Loan Servicing

E21/L##

Example 2: Welcome Letter

<<EVENT_DATE>>

<<ACCOUNT_FIRST_MIDDLE_LAST_NAME_1>>
<<ACCOUNT_FIRST_MIDDLE_LAST_NAME_2>>
<<MAIL_ADDRESS_LINE1>>
<<MAIL_ADDRESS_CITY_STATE_ZIP>>  

RE: Loan No.: <<FORMATTED_LOAN_NUMBER>>

Dear Customer(s):

Welcome to GOLDPoint Systems Finance Company. We are pleased that you chose GOLDPoint
Systems Finance Company for the recent financing of your loan. Please take the time to carefully review
the documents provided to you at closing. We are very enthusiastic about serving you and providing you
with excellent service.

Beginning <<DUE_DATE_ALPHA>>, your monthly loan payment will be in the amount of
<<NEXT_PAYMENT_DUE>>.

You will be receiving monthly billing statements about two (2) weeks before your due date. Please make
your check payable to GOLDPoint Systems Finance Company. If you are interested in our automatic
payment plan, please contact us.

We appreciate the opportunity to service you! Should you have any questions, please contact us at (555)
555-5555.

Sincerely,

John Doe
Title
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E21/L## 

Event 22, Closed Loan Event

This event record is generated when the system encounters tran code 580 (close loan).

Example Event 22 Letter

Merge Field Field Mnemonic/
Calculation

Description

PO ACCRUED INTEREST POACIN Accrued interest applied to payoff

PO AMOUNT POPOFF Payoff amount – includes all amounts applied to
payoff

PO CUSTOMER
MESSAGE LINE 1

POMES2 First customer message line from payoff record

PO CUSTOMER
MESSAGE LINE 2

POMES2 Second customer message line from payoff record

PO CUSTOMER
MESSAGE LINE 3

POMES3 Third customer message line from payoff record

PO DATE PODATE Payoff date

PO EXPIRATION DATE POEXPD Date the payoff expires

PO FEES POFEES Loan fees applied to payoff

PO INTEREST
CALCULATION CODE

POIBAS Interest calculation method from the payoff record

PO INTEREST ON
NEGATIVE RESERVES

POINRI Interest on negative reserves applied to payoff

PO LATE CHARGES POLATE Late charges applied to payoff

PO LIP ACCRUED
INTEREST

POLACC LIP accrued interest applied to payoff

PO LIP CUSTOMER
BALANCE

POCBAL LIP customer balance applied to payoff

PO LIP UNDISBURSED
BALANCE

POLBAL LIP undisbursed balance applied to payoff

PO MISC ADJUSTMENT
AMT 1

POAMT1 Payoff miscellaneous adjustment amount 1

PO MISC ADJUSTMENT
AMT 2

POAMT2 Payoff miscellaneous adjustment amount 2
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Merge Field Field Mnemonic/
Calculation

Description

PO MISC ADJUSTMENT
AMT 3

POAMT3 Payoff miscellaneous adjustment amount 3

PO MISC ADJUSTMENT
AMT 4

POAMT4 Payoff miscellaneous adjustment amount 4

PO MISC ADJUSTMENT
AMT 5

POAMT5 Payoff miscellaneous adjustment amount 5

PO MISC DESCRIPTION 1 POFLD1 Payoff miscellaneous description 1

PO MISC DESCRIPTION 2 POFLD2 Payoff miscellaneous description 2

PO MISC DESCRIPTION 3 POFLD3 Payoff miscellaneous description 3

PO MISC DESCRIPTION 4 POFLD4 Payoff miscellaneous description 4

PO MISC DESCRIPTION 5 POFLD5 Payoff miscellaneous description 5

PO MISCELLANEOUS
FUNDS

POMISC Miscellaneous fund applied to payoff

PO NAME LINE 1 PONLN1 Name line 1 from the payoff record

PO NAME LINE 2 PONLN2 Name line 2 from the payoff record

PO NAME LINE 3 PONLN3 Name line 3 from the payoff record

PO NAME LINE 4 PONLN4 Name line 4 from the payoff record

PO PARTIAL PAYMENTS POPRTL Partial payments applied to payoff

PO PER DIEM PODIEM One day’s accrued interest of the principal
balance plus deferred interest

PO PER DIEM
CALCULATION CODE

POPDBS Interest method used to figure payoff per diem

PO PRINCIPAL BALANCE POPBAL + PODEFI Principal plus deferred interest applied to payoff

PO RATE PORATE Payoff rate

PO RSV 1 AND RSV 2
BALANCES

POR1BL + POR2BL Reserve 1 and 2 balances subtracted from payoff

PO RSV 1 AND RSV 2
INTEREST

POR1AI + POR2AI Reserve 1 and 2 interest subtracted from payoff

PO SUBSIDY BALANCE POSBAL Subsidy balance subtracted from payoff when
applied

Event 22 Sample Letters

See the following examples of this event letter:

Example 1: Loan Payoff
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<<EVENT_DATE>>

<<ACCOUNT_FIRST_MIDDLE_LAST_NAME_1>>
<<ACCOUNT_FIRST_MIDDLE_LAST_NAME_2>>
<<MAIL_ADDRESS_LINE1>>
<<MAIL_ADDRESS_CITY_STATE_ZIP>>  

RE: Loan # <<FORMATTED_LOAN_NUMBER>>

Dear Borrower:

As your above numbered loan has been paid in full, we are enclosing the following documents for your files:

______ Deed of Reconveyance

______ Satisfaction of Mortgage

______ Abstract of Title

______ Insurance policy

______ Various Tax Receipts

______ Other

We would like to thank you for giving us the opportunity to serve you. If we can be of assistance in any
matter in the future, please feel free to call us at (555) 555-5555.

Sincerely,

Loan Servicing

E22/L##

Example 2: Loan Payoff

<<EVENT_DATE>>

<<ACCOUNT_FIRST_MIDDLE_LAST_NAME_1>>
<<ACCOUNT_FIRST_MIDDLE_LAST_NAME_2>>
<<MAIL_ADDRESS_LINE1>>
<<MAIL_ADDRESS_CITY_STATE_ZIP>>  
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RE: Loan No.: <<FORMATTED_LOAN_NUMBER>>
Property Address:   <<PROPERTY_ADDRESS_LINE1>>

     <<PROPERTY_ADDRESS_CITY_STATE_ZIP>>

Dear Customer:

As the above referenced loan has been paid in full, a Full Reconveyance will be issued and a copy
forwarded to you after it has been recorded.

I would like to thank you for allowing us this opportunity to assist you in meeting your financial needs. If
you have any questions about your loan, or any other services offered by GOLDPoint Systems Finance
Company, please feel free to call us at (555) 555-5555.

Sincerely,

Loan Servicing Department

E22/L##

Event 23, Delinquency Event

This event record is not generated automatically. It must be requested. The loan must be delinquent when this
event is ordered or the letters will not generate. (The due date must be in the past.)

Options: 

1. To stop a Delinquency Event letter from generating on a bankrupt account, check the Miscellaneous
Options 3 box on the Report Setup screen for FPSRP175.

2. See the PAYOFF_AMOUNT field below for special options affecting this event letter.

Example Event 23 Letter

Merge Field Field Mnemonic/
Calculation

Description

APPOINTMENT_DATE EVACDT This is the delinquency letter appointment date. This field is
entered when you select Action Code 210 on the Actions,
Holds, Event Letters screen. This is the date the account
owners should have contacted you or made a payment before
action is taken. See the Event 23 Sample Letters for an
example of how to use this field in your event letters. 

APPOINTMENT_TIME EVTIME This is the delinquency letter appointment time. This field is
entered when you select Action Code 211 on the Actions,
Holds, Event Letters screen. The delinquency letter time is



GOLDEvent Letters 151

© 2019 GOLDPoint Systems Last updated: 11/25/2019

Merge Field Field Mnemonic/
Calculation

Description

entered in the corresponding action date field as 01-HH-MM,
where 01 is the month (e.g., 01=January, 02=February,
03=March, etc.), HH = hours, and MM = minutes, used in
event 23 and 24 only).

C17 UFC17 This is a user-defined field entered on the Actions/Holds/Event
Letters screen. You can enter any information in those fields
on that screen, and that information can be included in event
letters if you include this merge field.

These fields are only available for events 23 and 24.

C34 UFC34 This is a user-defined field entered on the Actions/Holds/Event
Letters screen. You can enter any information in those fields
on that screen, and that information can be included in event
letters if you include this merge field.

These fields are only available for events 23 and 24.

DATE LAST PAID LNDTLP This field shows the date that the last payment was posted. If
a payment reversal (tran code 608) occurs, the system will
look in the collection history for the previous last payment
date and enter that date in this field. The last payment date is
reported to the credit bureau. It is updated as payment activity
occurs on the loan. 

This is pulled from the Last Payment Date field (LNDTLP),
which is found in the Payment Information field group on the
Loans > Account Information > Account Detail screen >
Payment Detail tab. 

DELINQUENCY
DEMAND DATE

Date calculated using demand days (see below); alpha or
numeric

DELINQUENCY
DEMAND DAYS

Number of days that will be added to the date the event letter
is created. Demand days are set up by loan type on the
Delinquency Demand Days screen (function 805/806) in
GOLD Services (Application 8). 

Example: Loan type 12 is set up for 10 demand days. The
night the event letter is created, the program adds 10 days to
the current run date and displays that date here. 

DUE DATE DAY LNDUDY Loan due date day

FIRST DUE DATE LN1DUE First payment due date on the loan

LAST PAYMENT
AMOUNT

LNLPMA This is the amount of the last payment pulled from the Last
Payment Amount field on the Loans > Account Information >
Account Detail screen > Payment Detail tab.
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Merge Field Field Mnemonic/
Calculation

Description

LATE CHARGE
VARIANCE

LNPDUE Late charge variance–the amount of the regular payment that
has not been paid because late charges were paid

ORIGINAL ADD ON
AMOUNT

LNOADD Total of amounts added to the principal

PAYOFF AMOUNT This is the Payoff amount as of the date the event is created.
This field is pulled from the Payoff Amount field on the Loans
> Payoff screen, Balances tab.

Note: If you want to use the <<PAYOFF_AMOUNT>> merge
field on this event, the following needs to take place:

1. You must contact GOLDPoint Systems and have your
account manager set the fifth Miscellaneous Option for
the Event Letter Report (FPSRP175). If this option is not
set, nothing will print in the <<PAYOFF_AMOUNT>>
field when the letter is merged with real data.

2. The Include Payoff box must be checked on the Loans
> System Setup Screens > Event Letter Descriptions
screen.

TOTAL LATE CHARGE
AND FEE VARIANCE

CALC Late charge variance plus total loan fee variance

TOTAL LOAN FEES
VARIANCE

LNVPRN Total loan fees variance–the amount of the regular payment
that was not paid because of loan fees

AUTO MAKE FIRST,
SECOND, THIRD

CFMAKE Make (Loans > Collateral Detail screen)

AUTO MODEL FIRST,
SECOND, THIRD

CFMODL Model (Loans > Collateral Detail screen)

AUTO YEAR FIRST,
SECOND, THIRD

CFYEAR Year (Loans > Collateral Detail screen)

VIN NUMBER FIRST,
SECOND, THIRD

CFVIN1 VIN (Loans > Collateral Detail screen)

The following merge fields are also available if you would like, but you will need to contact your GOLDPoint
Systems account manager to have these fields programmed for your institution.

DATE DUE DATE

ROLLED

LNROLL Date Due Last Rolled (Loans > Account Information >
Payment Information screen)

DATE LAST PAID LNDTLP Last Payment Date (Loans > Account Information > Account
Detail screen, Payment Detail tab)

EMAIL E0EMEL Email Address (Customer Relationship Management >
Households screen)

https://secure.goldpointsystems.com/gpsdocs/loans/LoanReports/llr175.asp
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Merge Field Field Mnemonic/
Calculation

Description

FEES REMAINING
AMOUNT

LNFREM Remaining Fees (Loans > Account Information > Deferred
Fees screen)

FORCE NEXT
FOLLOW-UP DATE

QAFDTE Follow-up Date (Loans > Marketing and Collections screen,
Contact tab)

INTEREST START
DATE

OTINDT Interest Start Date (Loans > Cards and Promotions screen,
Disclosure Information tab)

LAST ACTIVITY LNACTV Last Activity (Loans > Account Information > Account Detail
screen, Account tab)

LAST PAID AMOUNT LNLPMA Last Payment Amount (Loans > Account Information >
Account Detail screen, Payment Detail tab)

PAYOFF LNCLAT Payoff Amount (Loans > Account Information > Additional

Loan Fields screen, Origination/Maturity tab)

Event 23 Sample Letters

See the following examples of different delinquency letters:

For Bi-Weekly Loans

<<EVENT_DATE>>

<<ACCOUNT_FIRST_MIDDLE_LAST_NAME_1>>
<<ACCOUNT_FIRST_MIDDLE_LAST_NAME_2>>
<<MAIL_ADDRESS_LINE1>>
<<MAIL_ADDRESS_CITY_STATE_ZIP>>  

RE: Loan No. <<FORMATTED_LOAN_NUMBER>>

Dear Borrower(s):

According to the terms of your Note, you are to maintain an account with sufficient funds to pay the full
amount of each bi-weekly payment on its due date. Our records indicate that your loan, referenced above,
is seriously delinquent.

TOTAL PAYMENTS DUE: $<<TOTAL_PAYMENTS_DUE>>
LATE CHARGES DUE: $<<LATE_CHARGES>>

TOTAL AMOUNT DUE: $<<TOTAL_PMTS_WITH_LATE_CHARGES>>

https://secure.goldpointsystems.com/gpsdocs/loans/LoansCIMGOLD/index.asp?miscdatapayoffamount_lalf.asp
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Payments and late charges which become due after the date of this letter must also be included.

It is imperative that an immediate deposit be made into the designated account to cure your default. Failure
to cure said default by <<APPOINTMENT_DATE>> may result in the immediate termination of the bi-
weekly payments according to the terms of your note.

If you have any questions regarding this matter, please do not hesitate to call our Loan Service Department
at (555) 555-5555.

Sincerely,

Jane Doe
Loan Service Representative

E23/L##

Foreclosure

NOTICE OF INTENT TO BEGIN FORECLOSURE

<<EVENT_DATE>>

<<ACCOUNT_FIRST_MIDDLE_LAST_NAME_1>>
<<ACCOUNT_FIRST_MIDDLE_LAST_NAME_2>>
<<MAIL_ADDRESS_LINE1>>
<<MAIL_ADDRESS_CITY_STATE_ZIP>>  

Re: Loan no. <<FORMATTED_LOAN_NUMBER>>

Dear Borrower(s):

Our records reflect that your loan of $<<PRINCIPAL_BALANCE>>, plus interest thereon became due and
payable on <<MATURITY_DATE_ALPHA>>. The total amount due must be paid by CERTIFIED FUNDS no
later than <<APPOINTMENT_DATE>>. Partial amounts will not be accepted.

If your loan is not paid off, we will instruct our Trustee to proceed in filing a Notice of Default and may
invoke the power of sale and any other remedies permitted by applicable law without further notification to
you.

After the Notice of Default is filed, you have three months to pay off the balance, interest, Trustee’s fees
and other costs by CERTIFIED FUNDS. After the three-month period, the Association has the right to
cause a Trustee’s sale to be scheduled and held  sometime subsequent to the expiration of twenty-one
(21) days from the publication of the Notice of Trustee’s Sale.

You have the right to file court action to assert the non-existence of a default or any other defense to the
acceleration of your loan and sale of your property.
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It is imperative you contact us immediately to verify the amount due to pay off your loan. Please call our
Loan Service Department at (555) 555-5555.

Sincerely,

Delinquency Counselor

E23/L##

Foreclosure

<<EVENT_DATE>>

<<ACCOUNT_FIRST_MIDDLE_LAST_NAME_1>>
<<ACCOUNT_FIRST_MIDDLE_LAST_NAME_2>>
<<MAIL_ADDRESS_LINE1>>
<<MAIL_ADDRESS_CITY_STATE_ZIP>>  

PROPERTY ADDRESS:
<<PROPERTY_ADDRESS_LINE1>>
<<PROPERTY_ADDRESS_CITY_STATE_ZIP>>

Re: Loan No. <<FORMATTED_LOAN_NUMBER>>

Dear Borrower(s):

You have failed to meet the terms of payment on your loan and, as a result, your loan has been placed in
foreclosure.

After the Notice of Default is filed, there is a three-month redemption period in which there will be Trustee’s
fees that are due in addition to your delinquent payments, late charges and other fees. After the three-
month redemption period, the association has the right to cause a Trustee’s sale to be scheduled and held
sometime subsequent to the expiration of twenty-one (21) days from the date of the publication of the
Notice of the Trustee’s Sale.

If you intend to bring your loan current, please contact our office for the amount needed, which must be
paid by CERTIFIED FUNDS ONLY.

If you have any other questions regarding this matter, please call our Loan Service Department at (555)
555-5555.

Sincerely,

Jane Doe
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Delinquency Counselor

E23/L##

Negative Credit Report

<<EVENT_DATE>>

<<ACCOUNT_FIRST_MIDDLE_LAST_NAME_1>>
<<ACCOUNT_FIRST_MIDDLE_LAST_NAME_2>>
<<MAIL_ADDRESS_LINE1>>
<<MAIL_ADDRESS_CITY_STATE_ZIP>>

RE: Loan No. <<FORMATTED_LOAN_NUMBER>>

Dear Borrowers:

We at GOLDPoint Systems Finance Company are concerned that your loan payment is now thirty (30)
days delinquent.

As required by law, you are hereby notified that a negative credit report reflecting on your credit record may
be submitted to a credit reporting agency if you fail to fulfill the terms of your credit obligations.

As you are aware, your payments are to be made regularly each month on your scheduled due date. The
following amounts are due at this time.

Payments . . . . . . . . . . . $<<TOTAL_PAYMENTS_DUE>>

Late Charges due . . . . . . . $<<LATE_CHARGES>>

Total due . . . . . . . $<<TOTAL_PMTS_WITH_LATE_CHARGES>>

We are sure you want to bring your account current and avoid additional delinquency costs. If your account
remains delinquent for ninety (90) days, we may be required to proceed with foreclosure or other legal
action.

Please contact me immediately to resolve this matter.

Sincerely,

John Doe
Collections Department

E23/L##
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Payment Past Due/Late Charge

CERTIFIED MAIL 
RETURN RECEIPT REQUESTED

<<EVENT_DATE>>

<<ACCOUNT_FIRST_MIDDLE_LAST_NAME_1>>
<<ACCOUNT_FIRST_MIDDLE_LAST_NAME_2>>
<<ACCOUNT_FIRST_MIDDLE_LAST_NAME_3>>
<<ACCOUNT_FIRST_MIDDLE_LAST_NAME_4>>
<<MAIL_ADDRESS_LINE1>>
<<MAIL_ADDRESS_LINE2>>
<<MAIL_ADDRESS_CITY_STATE_ZIP>>

Re: Loan No.  <<FORMATTED_LOAN_NUMBER>>

Dear Customer:

Your loan remains delinquent for the payments that were due beginning <<DUE_DATE_ALPHA>>. The
total amount due, including late charges, is <<TOTAL_DUE>>.

Demand is hereby made upon you to pay GOLDPoint Systems Finance Company within seven (7) days
from the date hereof. All delinquent installments on or before Month X, 200X should be made to the
attention of Jane Doe, Loan Officer, 1525 West 820 North, Provo, Utah 84601.

You are further notified that failure to pay the delinquent installments as demanded within the time
prescribed, will result in GOLDPoint Systems Finance Company taking whatever legal action is deemed
necessary to protect its interest as set forth in the Promissory Note dated <<DATE_OPENED_ALPHA>>.

Sincerely,

Jane Doe
Loan Officer

E23/L##

Payment Past Due

<<EVENT_DATE>>

<<ACCOUNT_FIRST_MIDDLE_LAST_NAME_1>>
<<ACCOUNT_FIRST_MIDDLE_LAST_NAME_2>>
<<ACCOUNT_FIRST_MIDDLE_LAST_NAME_3>>
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<<ACCOUNT_FIRST_MIDDLE_LAST_NAME_4>>
<<MAIL_ADDRESS_LINE1>>
<<MAIL_ADDRESS_LINE2>>
<<MAIL_ADDRESS_CITY_STATE_ZIP>>

Re: Loan No.  <<FORMATTED_LOAN_NUMBER>>

Dear Customer:

Your loan remains delinquent for the payments that were due beginning <<DUE_DATE_ALPHA>>.

Unless we receive your remittance for the entire amount due on or before Month X, 200X, we will assign this
matter of collection to our attorneys for legal action as outlined in our Promissory note.

If your loan is turned over to an attorney for collection, it will be necessary that you pay all attorney fees
incurred in that process.

Please see that your loan is brought current prior to the above date to avoid the action outlined.

If you wish to communicate with us about this matter, please phone our office at (555) 555-5555 between
the hours of #:## am and #:## pm, Monday through Friday.

Sincerely,

John Doe
Loan Officer

E23/L##

Payment Past Due/Late Charges

<<EVENT_DATE>>

<<ACCOUNT_FIRST_MIDDLE_LAST_NAME_1>>
<<ACCOUNT_FIRST_MIDDLE_LAST_NAME_2>>
<<ACCOUNT_FIRST_MIDDLE_LAST_NAME_3>>
<<ACCOUNT_FIRST_MIDDLE_LAST_NAME_4>>
<<MAIL_ADDRESS_LINE1>>
<<MAIL_ADDRESS_LINE2>>
<<MAIL_ADDRESS_CITY_STATE_ZIP>>

Re: Loan No.  <<FORMATTED_LOAN_NUMBER>>

Dear Customer:
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Your payment on this loan is due as follows:

Amount of Payments Due: <<TOTAL_PAYMENTS_DUE>>
Late Charges: <<LATE_CHARGES>>

____________________    
Total Due: <<TOTAL_PMTS_WITH_LATE_CHARGES>>

Payments are due on the first of each month, and late charges are assessed for payments received after
the 15th.

Please send the total amount due promptly to avoid any additional charges.

If you have any questions, please call us at (555) 555-5555.

Loan Servicing Department

E24/L##

Promissory Note in Default

<<EVENT_DATE>>

<<ACCOUNT_FIRST_MIDDLE_LAST_NAME_1>>
<<ACCOUNT_FIRST_MIDDLE_LAST_NAME_2>>
<<MAIL_ADDRESS_LINE1>>
<<MAIL_ADDRESS_LINE2>>
<<MAIL_ADDRESS_CITY_STATE_ZIP>>

RE: Acceleration of all payments and calling in note #X

Dear Customer:

You are hereby notified that the above referenced promissory note is in default due to your failure to pay the
required monthly installments of <<TOTAL_PAYMENTS_DUE>>. The note is presently three (3) months
delinquent, as you have failed to make the payment due on <<DUE_DATE_ALPHA>>, and the payment
due for each monththereafter.  GOLDPoint Systems Finance Company does hereby accelerate all
remaining installments and calls the entire note due and payable.

Demand is hereby made upon you to pay GOLDPoint Systems Finance Company within ten (10) days
from the date hereof the entire note balance of <<TOTAL_DUE_TO_BALLOON_OR_MATURITY>>. Your
payment of this note on or before Month X, 200X should be made to the attention of Mr. John Doe, Loan
Officer at GOLDPoint Systems Finance Company, 1525 West 820 North, Provo, Utah 84601.

If the matured note remains unpaid at the close of the business day on Month X, 200X, then it will be
necessary for you to deliver to GOLDPoint Systems Finance Company the collateral securing this note
which is:
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LOAN ITEM(S)

Your failure to deliver the collateral to the association will result in GOLDPoint Systems Finance Company
taking whatever legal action is deemed necessary to protect its interest including repossession and the
sale of the collateral and filing suit for any deficiency balance due on the note, plus interest and late
charges accrued thereon, together with all reasonable attorney’s fees and court costs as provided in the
note.

Sincerely,

John Doe
Loan Officer

E23/L##

Property Taxes

<<EVENT_DATE>>

NOTICE OF INTENT TO BEGIN FORECLOSURE

<<ACCOUNT_FIRST_MIDDLE_LAST_NAME_1>>
<<ACCOUNT_FIRST_MIDDLE_LAST_NAME_2>>
<<MAIL_ADDRESS_LINE1>>
<<MAIL_ADDRESS_LINE2>>
<<MAIL_ADDRESS_CITY_STATE_ZIP>>

Re: Loan No.  <<FORMATTED_LOAN_NUMBER>>

Property Address: <<PROPERTY_ADDRESS_LINE1>>
<<PROPERTY_ADDRESS_CITY_STATE_ZIP>>

Dear Borrower(s):

Records received from the County Tax Assessor reflect the property taxes on your mobile home are
seriously delinquent. According to your Security Agreement, you are required to pay promptly all taxes
levied or assessed to said mobile home.  Failure to meet terms places your loan in default and subject to
foreclosure.

If these taxes are not paid and receipt evidencing such payment are not provided to us, in addition to all
payments and late charges by <<APPOINTMENT_DATE>>, we will initiate foreclosure proceedings without
further notification to you. Payments will not be accepted unless accompanied by proof your delinquent
taxes have been paid.

AMOUNT OF PAYMENTS DUE: <<TOTAL_PAYMENTS_DUE>>
LATE CHARGES DUE: <<LATE_CHARGES>>
TOTAL AMOUNT DUE: <<TOTAL_PMTS_WITH_LATE_CHARGES>>
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PAYMENTS AND LATE CHARGES WHICH BECOME DUE AFTER THE DATE OF THIS LETTER MUST
ALSO BE PAID. PARTIAL AMOUNTS WILL NOT BE ACCEPTED. PAYMENT BY CERTIFIED FUND
ONLY.

     PARCEL NUMBER     YR. OF DELINQUENCY    AMT. TO REDEEM TO:
     -------------     ------------------    ------------------

If you have any questions regarding this matter, please call our Loan Service Department at (XXX) 555-5555
or TOLL FREE at (800) 555-5555.

Sincerely,

Jane Doe
Delinquency Counselor
E23/L##

Property Taxes

NOTICE OF INTENT TO BEGIN FORECLOSURE

<<EVENT_DATE>>

<<ACCOUNT_FIRST_MIDDLE_LAST_NAME1>>
<<ACCOUNT_FIRST_MIDDLE_LAST_NAME2>>
<<MAIL_ADDRESS_LINE1>>
<<MAIL_ADDRESS_CITY_STATE_ZIP>>  

   Re: Loan No. <<FORMATTED_LOAN_NUMBER>>

Dear Borrower(s):

Records received from the County Tax Assessor reflect your property taxes are seriously delinquent. 
According to your Deed of Trust, you are required to pay all taxes and assessment affecting your property.
 Failure to meet terms places your loan in default and subject to foreclosure.

If these taxes are not paid and receipt evidencing such payment is not provided to us by
<<APPOINTMENT_DATE>>, we will instruct our Trustee to proceed in filing a Notice of Default and may
invoke the power of sale and any other remedies permitted by applicable law. Payments and late charges
which become due after the date of this letter must also be paid. Payments will not be accepted unless
accompanied by proof that your delinquent taxes have been paid.

PARCEL NUMBER     YR. OF DELINQUENCY    AMT. TO REDEEM TO
-------------     ------------------    ------------------

After the Notice of Default is filed, you may have the legal right to bring your loan in good standing by
paying all of your past due payments plus permitted costs and expenses within the time permitted by law
for reinstatement of your loan, normally five (5) business days prior to the date set for the sale of your
property. No sale date may be set until three months from the date the Notice of Default is filed.
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You have the right to file court action to assert the non-existence of a default or any other defense to the
acceleration of your loan and sale of your property.

If you have any questions regarding this matter, please call our Loan Service Department at (555) 555-5555
or TOLL FREE at (800) 555-5555.

Sincerely,

Jane Doe
Delinquency Counselor
E23/L##

Repossession

<<EVENT_DATE>>

NOTICE OF INTENT TO BEGIN FORECLOSURE

<<ACCOUNT_FIRST_MIDDLE_LAST_NAME_1>>
<<ACCOUNT_FIRST_MIDDLE_LAST_NAME_2>>
<<ACCOUNT_FIRST_MIDDLE_LAST_NAME_3>>
<<ACCOUNT_FIRST_MIDDLE_LAST_NAME_4>>
<<MAIL_ADDRESS_LINE1>>
<<MAIL_ADDRESS_LINE2>>
<<MAIL_ADDRESS_CITY_STATE_ZIP>>

Re: Loan No.  <<FORMATTED_LOAN_NUMBER>>

Dear Customer,

You are hereby notified that the undersigned has taken possession of the security described in the security
agreement executed by you to the undersigned dated X, a list of which is as follows:

Unless, on or before the X day of Month, 200x, payment is made of $X on your account, plus any collection
or repossession expenses, said security will be sold on the X day of MONTH, 200x, at X a.m. at the
following place to-wit:

GOLDPoint Systems Finance Company
1525 WEST 820 NORTH
PROVO, UTAH 84601

The above described chattel sells for less than $###.##, plus all interest, collection fees and repossession
expenses, as well as  the amount now due on your note.  You will be liable for any deficiency resulting
from the sale.

GOLDPoint Systems Finance Company
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By:                                   

Certified Mail #xxx
Return Receipt Requested
E23/L##

Event 24, Specialty Request Letter

This is reserved for letters that are a special request of your institution. More than one letter per loan can be
generated on the same day. 

Note: An afterhours update option is available (Remove SAC Action Code 74 and Date, code 95) that
automatically removes Action Code 74 when an account is more than 20 days past the next due date (non-
graded). The account essentially loses the same-as-cash offer. The system also sets up the Specialty Request
Letter record (event 24) on the account, so you can generate event letter 24 for this account and send account
owners a letter notifying them of the action. Additionally, if institution option LSAC is set, then the system does
not remove Action Code 74 unless the loan is both 20 days past the next due date and the account has had at
least one late charge (LNLTNO is not equal to 0).

See the PAYOFF AMOUNT field below for special options affecting this event letter.

Example Event 24 Letter

Merge Field Field Mnemonic/
Calculation

Description

APPOINTMENT_DATE EVACDT This is the delinquency letter appointment date.
This field is entered when you select Action
Code 210 on the Actions, Holds, Event Letters
screen. This is the date the account owners
should have contacted you or made a payment
before action is taken. See the Event 23 Sample
Letters for an example of how to use this field in
your event letters. 

APPOINTMENT_TIME EVTIME This is the delinquency letter appointment time.
This field is entered when you select Action
Code 211 on the Actions, Holds, Event Letters
screen. The delinquency letter time is entered in
the corresponding action date field as 01-HH-
MM, where 01 is the month (e.g., 01=January,
02=February, 03=March, etc.), HH = hours, and
MM = minutes, used in event 23 and 24 only).

ARM 2ND NEXT RATE CHANGE
DATE

LNAMDT + LNAMFQ Next rate change date plus a rate change
frequency

ARM 2ND P/I CHANGE DATE LNPIEF + LNAMPC Next payment change date plus a payment
change frequency
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Merge Field Field Mnemonic/
Calculation

Description

ARM NEXT ACCRUAL RATE LNAMNA Next accrual rate

ARM NEXT P/I PAYMENT LNPINX Next principal/interest payment

AUTO MAKE FIRST, SECOND,

THIRD

CFMAKE Make (Loans > Collateral Detail screen)

AUTO MODEL FIRST, SECOND,

THIRD

CFMODL Model (Loans > Collateral Detail screen)

AUTO YEAR FIRST, SECOND,

THIRD

CFYEAR Year (Loans > Collateral Detail screen)

DATE LAST PAID LNDTLP This field shows the date that the last payment
was posted. If a payment reversal (tran code
608) occurs, the system will look in the
collection history for the previous last payment
date and enter that date in this field. The last
payment date is reported to the credit bureau. It
is updated as payment activity occurs on the
loan. 

This is pulled from the Last Payment Date field
(LNDTLP), which is found in the Payment
Information field group on the Loans > Account
Information > Account Detail screen > Payment
Detail tab.

Note: The loan transaction 590 (Charge LIP
Interest to LIP Undisbursed Balance) also
updates the date of last payment. However, the
reversal of this transaction will not change the
last payment date.

The results for this field are a numeric date, as
in:

05-25-2015

DATE LAST PAID ALPHA LNDTLP This field is identical to the one above, but the
results will be alphanumeric, as in:

May 25, 2015.

DELINQUENCY DEMAND DATE Date calculated using demand days (see below);
alpha or numeric.

DELINQUENCY DEMAND DAYS Number of days that will be added to the date
the event letter is created. Demand days are set
up by loan type on the Delinquency Demand
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Merge Field Field Mnemonic/
Calculation

Description

Days screen (function 805/806) in GOLD
Services (Application 8). 

Example: Loan type 12 is set up for 10 demand
days. The night the event letter is created, the
program adds 10 days to the current run date
and displays that date here. 

FHA/VA ACCOUNT NUMBER LNFVNO This is the FHA- or VA-assigned number for this
loan.

Note: The institution’s FHA servicer number is
set up with institution option H FHAC. If you are
servicing FHA loans, this must be set up in
order for it to appear on the event letter. If you
would like this option, please send in a work
order.

INVESTOR ACCOUNT NUMBER LNIACT This is the account number assigned by the
investor to this loan, if there is one.

LAST INDEX LNAPIN Last Index Rate on Loans > Account
Information > ARM Information screen, ARM
Detail tab

LATE CHARGE VARIANCE LNPDUE Late charge variance–amount of the regular
payment not paid because late charges were
paid

NEW TOTAL PAYMENT LNPINX+LNR1NX+LN
R2NX-LNSNXT

Next P/I payment + next reserve 1 payment +
next reserve 2 payment - next subsidy payment.
If next payments are zero, then current
payments are used for calculating new total
payment.

OLD TOTAL PAYMENT LNPICN+LNR1CN+
LNR2CN-LNSCON

P/I payment + reserve 1 payment + reserve 2
payment - subsidy payment

ORIGINAL ADD ON AMOUNT LNOADD Total of amounts added on to the principal

ORIGINAL APR LNOAPR Annual percentage rate of the loan

PAYOFF AMOUNT POPOFF This is the Payoff amount as of the date the
event is created. This field is pulled from the
Payoff Amount field on the Loans > Payoff
screen, Balances tab.

Note: If you want to use the
<<PAYOFF_AMOUNT>> merge field on this
event, the following needs to take place:
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Merge Field Field Mnemonic/
Calculation

Description

1. You must contact GOLDPoint Systems
and have your account manager set the
fourth Miscellaneous Option for the Event
Letter Report (FPSRP175). If this option is
not set, nothing will print in the
<<PAYOFF_AMOUNT>> field when the
letter is merged with real data.

2. The Include Payoff box must be checked
on the Loans > System Setup Screens >
Event Letter Descriptions screen.

PREVIOUS YEAR YTD INTEREST LNPYTD This is the total amount of interest paid during
the previous year. If includes any subsidy portion
and any prepaid interest paid during the previous
year. This information is pulled from the Loans >
Account Information > Account Detail screen >
Statistics tab > Current & Prior Year-to-Date
tab.

SOLD AS OF DATE LNASOF This field will show the date the loan is sold as
of, whether it is a due date, paid-to-date, or an
actual date when the loan is sold using the
Loans > Investor Reporting > Sell Loan to
Investor function.

TOTAL LATE CHARGE AND FEE
VARIANCE

CALC Late charge variance plus total loan fee variance

TOTAL LOAN FEES VARIANCE LNVPRN Total loan fees variance–the amount of the
regular payment that was not paid because of
loan fees

USER-DEFINED C17 UFC17 This is a user-defined field entered on the
Actions/Holds/Event Letters screen. You can
enter any information in those fields on that
screen, and that information can be included in
event letters if you include this merge field.

These fields are only available for events 23 and
24.

USER-DEFINED C34 UFC34 This is a user-defined field entered on the
Actions/Holds/Event Letters screen. You can
enter any information in those fields on that
screen, and that information can be included in
event letters if you include this merge field.

These fields are only available for events 23 and
24.

https://secure.goldpointsystems.com/gpsdocs/loans/LoanReports/llr175.asp
https://secure.goldpointsystems.com/gpsdocs/loans/LoanReports/llr175.asp
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Merge Field Field Mnemonic/
Calculation

Description

The following merge fields are also available if you would like, but you will need to contact your GOLDPoint
Systems account manager to have these fields programmed for your institution.

DATE DUE DATE ROLLED LNROLL Date Due Last Rolled (Loans > Account

Information > Payment Information screen)

DATE LAST PAID LNDTLP Last Payment Date (Loans > Account

Information > Account Detail screen, Payment

Detail tab)

EMAIL E0EMEL Email Address (Customer Relationship

Management > Households screen)

FEES REMAINING AMOUNT LNFREM Remaining Fees (Loans > Account Information

> Deferred Fees screen)

FORCE NEXT FOLLOW-UP DATE QAFDTE Follow-up Date (Loans > Marketing and
Collections screen, Contact tab)

INTEREST START DATE OTINDT Interest Start Date (Loans > Cards and

Promotions screen, Disclosure Information tab)

LAST ACTIVITY LNACTV Last Activity (Loans > Account Information >

Account Detail screen, Account tab)

LAST PAYMENT AMOUNT LNLPMA Last Payment Amount (Loans > Account

Information > Account Detail screen, Payment

Detail tab)

PAYOFF LNCLAT Payoff Amount (Loans > Account Information >

Additional Loan Fields screen,

Origination/Maturity tab)

VIN NUMBER FIRST, SECOND,

THIRD

CFVIN1 VIN (Loans > Collateral Detail screen)

Event 24 Sample Letters

See the following examples of different types of specialty request letters:

Example 1: Draft Authorization Card

<<EVENT_DATE>>

<<ACCOUNT_FIRST_MIDDLE_LAST_NAME_1>>

https://secure.goldpointsystems.com/gpsdocs/loans/LoansCIMGOLD/index.asp?miscdatapayoffamount_lalf.asp
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<<ACCOUNT_FIRST_MIDDLE_LAST_NAME_2>>
<<MAIL_ADDRESS_LINE1>>
<<MAIL_ADDRESS_CITY_STATE_ZIP>>  

RE: Loan # <<FORMATTED_LOAN_NUMBER>>
Property Address: <<PROPERTY_ADDRESS_LINE1>>

<<PROPERTY_ADDRESS_CITY_STATE_ZIP>>

Dear Mortgage Loan Customer,

The enclosed Draft Authorization Card is provided per your request. After completing the form, please return
it, along with a voided check or deposit slip in the enclosed prepaid envelope.

If you have any questions regarding this automatic draft, please call us at (555) 555-5555.

Sincerely,

LOAN SERVICING DEPARTMENT

E24/L##

Example 2: Cancellation of Automatic Loan Payment

<<EVENT_DATE>>

<<ACCOUNT_FIRST_MIDDLE_LAST_NAME_1>>
<<ACCOUNT_FIRST_MIDDLE_LAST_NAME_2>>
<<MAIL_ADDRESS_LINE1>>
<<MAIL_ADDRESS_CITY_STATE_ZIP>>  

RE: Loan # <<FORMATTED_LOAN_NUMBER>>
Automatic Draft

Dear Loan customer,

Per your request, your mortgage payment will no longer be drafted automatically from your account.

You will be receiving a monthly billing notice in the future. Your loan is now due for the
<<DUE_DATE_ALPHA>> payment.

If you have any questions regarding this automatic draft, please call us at (555) 555-5555.
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Sincerely,

LOAN SERVICING DEPARTMENT

E24/L##

Example 3: Escrow

<<EVENT_DATE>>

<<ACCOUNT_FIRST_MIDDLE_LAST_NAME_1>>
<<ACCOUNT_FIRST_MIDDLE_LAST_NAME_2>>
<<MAIL_ADDRESS_LINE1>>
<<MAIL_ADDRESS_CITY_STATE_ZIP>>

RE: <<FORMATTED_LOAN_NUMBER>>

Dear Mortgagor(s):

Because of a recent disbursement from your escrow account, the account has a negative balance of
<<RESERVE_1_BALANCE>>.

In order to minimize your shortage at escrow analysis, please remit the amount indicated.

A postage paid envelope has been enclosed for your convenience. If you have any other questions, please
feel free to contact us at (555) 555-5555.

Sincerely,

LOAN SERVICING DEPARTMENT

E24/L##

Example 4: Insurance (Lack of Current Coverage)

<<EVENT_DATE>>

<<ACCOUNT_FIRST_MIDDLE_LAST__NAME1>>
<<ACCOUNT_FIRST_MIDDLE_LAST_NAME2>>
<<MAIL_ADDRESS_LINE1>>
<<MAIL_ADDRESS_CITY_STATE_ZIP>>  
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RE: Loan # <<FORMATTED_LOAN_NUMBER>>

Dear <<ACCOUNT_FIRST_NAME_1>>:

Our records indicate that we do not have confirmation of current coverage on your home, and must assume
that no coverage is in effect.

You have the option of furnishing your own insurance either by assignment of existing policies or by
procuring and furnishing to us equivalent coverage through any insurance company authorized to transact
business in the State of X.

Any policy purchased by you must contain a long form Loss Payable Clause in our favor.

If you have any questions, please call me at (555) 555-5555.

Sincerely,

John Doe
Loan Officer

TAH/mc

E24/L##

Example 5: Loan Credit/Payment History

<<EVENT_DATE>>

<<ACCOUNT_FIRST_MIDDLE_LAST_NAME_1>>
<<ACCOUNT_FIRST_MIDDLE_LAST_NAME_2>>
<<MAIL_ADDRESS_LINE1>>
<<MAIL_ADDRESS_CITY_STATE_ZIP>>  

RE: Loan # <<FORMATTED_LOAN_NUMBER>>
Property address: <<PROPERTY_ADDRESS_LINE1>>

<<PROPERTY_ADDRESS_CITY_STATE_ZIP>>

Dear Account Holder:

As requested, we are furnishing the following information:

(    ) Amortization Schedule
(    ) Annual Loan Statement
(    ) Escrow Analysis Statement
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(    ) Copy of Note and/or Deed of Trust
(    ) Annual Ledger(s)
(    ) Other

If we can be of further service, please do not hesitate to call us at (555) 555-5555.

Sincerely,

LOAN SERVICING DEPARTMENT

E24/L##

Example 6: Loan Credit/Payment History

<<EVENT_DATE>>

<<ACCOUNT_FIRST_MIDDLE_LAST_NAME_1>>
<<ACCOUNT_FIRST_MIDDLE_LAST_NAME_2>>
<<MAIL_ADDRESS_LINE1>>
<<MAIL_ADDRESS_CITY_STATE_ZIP>>

Following your request, listed below is the current status and credit/payment history for our referenced
loan.

Loan Number <<FORMATTED_LOAN_NUMBER>>
Date of Loan <<DATE_OPENED>>
Original Loan Amt. $<<ORIGINAL_AMOUNT>>
Principal Balance $<<PRINCIPAL_BALANCE>>
P & I Payment $<<P_I_PAYMENT>>
Monthly Impound $<<RESERVE_1_CON_PLUS_RESERVE_2_CON>>
Next Due Date <<DUE_DATE_ALPHA>>

TIMES LATE:
Last Two Years <<TIMES_LATE_LAST_2_YEARS>>
Life of Loan <<TIMES_LATE>>

This information is provided to you as a courtesy to our borrowers. Please contact them directly if you have
any questions about the data in this report.

Sincerely,

E24/L##
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Event 25, Prenotification of Loan Maturity

This letter can be generated any number of days before the maturity date. You must inform GOLDPoint
Systems of the number of days prior to maturity the letters should be generated. The system defaults to 120
days.

Example Event 25 Letter

Merge Field Field
Mnemonic/
Calculation

Description

ROUND RATE E
T Q

LNRRND Round rate to the eighth, tenth, or quarter.

TOTAL DUE AT
MATURITY

LETT01 Total amount due at maturity date. (Amortizes payments to maturity
date. Also adds late charges, fees, subsidies, and negative interest,
then subtracts reserve balance. Accrues interest to the maturity date.

Payment method 5 loans include the current and prior finance charges.

Note: When the payments are amortized, the system makes pseudo-
payments so the principal balance used is the amortized balance
instead of the current principal balance. 

GOLDPoint Systems ONLY 

MDYS  Set this option (days before maturity for event letter) to
have the letters run a specified number of days before
the maturity.

Event 25 Sample Letters

See the following examples of prenotification of loan maturity letters:

Example 1: Loan Maturity

<<EVENT_DATE>>

<<ACCOUNT_FIRST_MIDDLE_LAST_NAME_1>>
<<ACCOUNT_FIRST_MIDDLE_LAST_NAME_2>>
<<MAIL_ADDRESS_LINE1>>
<<MAIL_ADDRESS_CITY_STATE_ZIP>>

RE: Matured Loan Number     <<FORMATTED_LOAN_NUMBER>>

Dear Customer:
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Your loan matured Month X, 200X and is now in default. We ask that you contact us by Month X, 200X so
that this problem can be resolved.

At present, the following is the amount due, and interest is assessed daily at the rate of <<PER_DIEM>>
per diem.

PRINCIPAL BALANCE <<PRINCIPAL_BALANCE>>
INTEREST PAID TO DATE <<DATE_INTEREST_PAID_TO_ALPHA>>

I would appreciate your immediate attention to this matter, and ask that you contact me at (555) 555-5555
on or before Month X, 200X between the hours of #:## am and #:## pm Monday through Friday.

Sincerely,

John Doe
Loan Officer

TAH/mc

E25/L##

Example 2: Loan Maturity

MATURING NOTICE

<<EVENT_DATE>>

<<ACCOUNT_FIRST_MIDDLE_LAST_NAME_1>>
<<ACCOUNT_FIRST_MIDDLE_LAST_NAME_2>>
<<MAIL_ADDRESS_LINE1>>
<<MAIL_ADDRESS_CITY_STATE_ZIP>>

RE: Loan Number <<FORMATTED_LOAN_NUMBER>>
Principal Balance $<<PRINCIPAL_BALANCE>>

Dear <<ACCOUNT_FIRST_MIDDLE_LAST_NAME_1>>:

A payment on your note referenced above will mature on <<MATURITY_DATE_ALPHA>>.  In the event
that you are unable to pay the full amount due and to assure full consideration for renewal of your note,
please provide us with the following:

- Updated Loan Application (enclosed)
- Current Financial Statements (personal and/or business)
- Proposed principal reduction
- Interest payment to maturity
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If you require additional information or have any questions on any of the foregoing, please call me.

Very truly yours,

John Doe
Assistant Vice-President

E25/L##

Example 3: Loan Maturity

<<EVENT_DATE>>

<<ACCOUNT_FIRST_MIDDLE_LAST_NAME_1>>
<<ACCOUNT_FIRST_MIDDLE_LAST_NAME_2>>
<<MAIL_ADDRESS_LINE1>>
<<MAIL_ADDRESS_CITY_STATE_ZIP>>  

RE: Loan # <<FORMATTED_LOAN_NUMBER>>
Property Address: <<PROPERTY_ADDRESS_LINE1>>

<<PROPERTY_ADDRESS_CITY_STATE_ZIP>>

Dear Account Holder,

Please be advised that the above referenced loan is due to mature on <<MATURITY_DATE_ALPHA>>.

You will receive an itemized payoff statement approximately thirty (30) days prior to the maturity date.

If you have any questions, please contact us at (555) 555-5555.

Sincerely,

LOAN SERVICING DEPARTMENT

E25/L##

Example 4: Loan Maturity

<<EVENT_DATE>>

<<IRS_OWNER_FIRST_MIDDLE_LAST_NAME>>
<<MAIL_ADDRESS_LINE1>>
<<MAIL_ADDRESS_CITY_STATE_ZIP>>
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RE: Pre-notification of maturity
Loan Number: <<FORMATTED_LOAN_NUMBER>>
Property Address:

<<PROPERTY_ADDRESS_LINE1>>
<<PROPERTY_ADDRESS_CITY_STATE_ZIP>>

Dear <<IRS_OWNER_FIRST_MIDDLE_LAST_NAME>>,

Your loan on the above referenced property will mature and be due and payable on
<<MATURITY_DATE_ALPHA>>. The amount due on that date will be the outstanding principal balance
plus accrued interest, late charges, advances and appropriate fees plus or minus any impound balance, if
applicable.

Please contact this office for the total amount due prior to sending your final payment. You should initiate
loan application promptly if refinancing will be necessary to pay this loan off. 

If you have any questions, please contact our Loan Servicing Department at (555) 555-5555.

Sincerely,

Loan Servicing

E25/L##

Example 5: Loan Maturity

<<EVENT_DATE>>

<<IRS_OWNER_FIRST_MIDDLE_LAST_NAME>>
<<MAIL_ADDRESS_LINE1>>
<<MAIL_ADDRESS_CITY_STATE_ZIP>> 

RE: Loan Maturity Notice
Loan Number: <<FORMATTED_LOAN_NUMBER>>
Property Address:

<<PROPERTY_ADDRESS_LINE1>>
<<PROPERTY_ADDRESS_CITY_STATE_ZIP>>

Dear <<IRS_OWNER_FIRST_MIDDLE_LAST_NAME>>,
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Our records indicate that the loan referenced above matures on <<MATURITY_DATE_ALPHA>>. The
payoff amount will include a principal balance of $<<PRINCIPAL_BALANCE>>, interest as of the quoted
payoff date and other fees. 

Please contact our Loan Servicing Department at (555) 555-5555 as soon as possible for the total amount
required to payoff your loan. 

Thank you.

Sincerely,

Loan Servicing

E25/L##

Event 26, Loan Maturity Event Letter

This letter will be generated on the maturity date.

Merge Field Field Mnemonic/
Calculation

Description

ROUND RATE E T Q LNRRND Round rate to the eighth, tenth, or quarter.

TOTAL DUE AT
MATURITY

LETT01 Total amount due at maturity date. (Amortizes payments to
maturity date. Also adds late charges, fees, subsidies, and
negative interest, then subtracts reserve balance. Accrues
interest to the maturity date.

Payment method 5 loans include the current and prior
finance charges.

Note: When the payments are amortized, the system
makes pseudo-payments so the principal balance used is
the amortized balance instead of the current principal
balance. 

 

Event 27, Loan Balloon Payment Letter

This letter will print when there is a "1" in the Action Code field on the Letters & Actions tab, and the date of
the action code is today’s date. Action code 1 stops all activity on the loan. This letter can be generated from 1
to 99 days before the balloon date. You must inform GOLDPoint Systems of the number of days (01–99) prior to
the balloon date the letters should be generated.
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GOLDPoint Systems Only: Miscellaneous Parameters 1-2 on the Loan Report

Setup screen for FPSRP175, Event Letter Report, store the number of days prior to the
balloon date to create the letter. 

Merge Field Field Mnemonic/
Calculation

Description

ROUND RATE E T Q LNRRND Round rate to the eighth, tenth, or quarter.

TOTAL DUE AT
BALLOON DATE

LETT01 Total amount due at balloon date. (Amortizes payments to
balloon date. Also adds late charges, fees, subsidies, and
negative interest, then subtracts reserve balance. Accrues
interest to the balloon date.

Payment method 5 loans include the current and prior
finance charges.

Note: When the payments are amortized, the system
makes pseudo-payments so the principal balance used is
the amortized balance instead of the current principal
balance. 

Event 28, Beneficiary Statement

This letter is generated upon request. However, if no payoff record exists, it will not be created.

Merge Field Field Mnemonic/
Calculation

Description

PO ACCRUED INTEREST POACIN Accrued interest applied to payoff

PO AMOUNT POPOFF Payoff amount – includes all amounts applied
to payoff

PO CUSTOMER MESSAGE
LINE 1

PEMES1 First customer message line from payoff record

PO CUSTOMER MESSAGE
LINE 2

PEMES2 Second customer message line from payoff
record

PO CUSTOMER MESSAGE
LINE 3

PEMES3 Third customer message line from payoff record

PODATE PODATE Payoff date

PO EXPIRATION DATE POEXPD Date the payoff expires

PO FEES POFEES Loan fees applied to payoff

PO INTEREST CALCULATION
CODE

POIBAS Interest calculation method from the payoff
record
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Merge Field Field Mnemonic/
Calculation

Description

PO INTEREST ON NEGATIVE
RESERVES

POINRI Interest on negative reserves applied to payoff

PO LATE CHARGES POLATE Late charges applied to payoff

PO LIP ACCRUED INTEREST POLACC LIP accrued interest applied to payoff

PO LIP CUSTOMER BALANCE POCBAL LIP customer balance applied to payoff

PO LIP UNDISBURSED
BALANCE

POLBAL LIP undisbursed balance applied to payoff

PO MISC ADJUSTMENT AMT 1 POAMT1 Payoff miscellaneous adjustment amount 1

PO MISC ADJUSTMENT AMT 2 POAMT2 Payoff miscellaneous adjustment amount 2

PO MISC ADJUSTMENT AMT 3 POAMT3 Payoff miscellaneous adjustment amount 3

PO MISC ADJUSTMENT AMT 4 POAMT4 Payoff miscellaneous adjustment amount 4

PO MISC ADJUSTMENT AMT 5 POAMT5 Payoff miscellaneous adjustment amount 5

PO MISC DESCRIPTION 1 POFLD1 Payoff miscellaneous description 1

PO MISC DESCRIPTION 2 POFLD2 Payoff miscellaneous description 2

PO MISC DESCRIPTION 3 POFLD3 Payoff miscellaneous description 3

PO MISC DESCRIPTION 4 POFLD4 Payoff miscellaneous description 4

PO MISC DESCRIPTION 5 POFLD5 Payoff miscellaneous description 5

PO MISCELLANEOUS FUNDS POMISC Miscellaneous funds applied to payoff

PO NAME LINE 1 PONLN1 Name line 1 from the payoff record

PO NAME LINE 2 PONLN2 Name line 2 from the payoff record

PO NAME LINE 3 PONLN3 Name line 3 from the payoff record

PO NAME LINE 4 PONLN4 Name line 4 from the payoff record

PO PARTIAL PAYMENTS POPRTL Partial payments applied to payoff

PO PER DIEM PODIEM One day’s accrued interest of principal plus
deferred

PO PER DIEM CALCULATION
CODE

POPDBS Interest method used to figure payoff per diem

PO PRINCIPAL BALANCE POPBAL + PODEFI Principal plus deferred interest applied to payoff

PO RATE PORATE Payoff rate

PO RSV 1 AND RSV 2
BALANCES

POR1BL + POR2A1 Reserve 1 and 2 balance subtracted from payoff
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Merge Field Field Mnemonic/
Calculation

Description

PO RSV 1 AND RSV 2
INTEREST

POR1A1 + POR2A1 Reserve 1 and 2 interest subtracted from payoff

PO SUBSIDY BALANCE POSBAL Subsidy balance subtracted from payoff when
applied

Event 29, Loan Sold

This letter is generated when a loan is sold to allow you to inform all associated with the loan that it was sold.
Information found on the Loans > Payee Information screen can be used with this event letter. This event can be
created with information regarding the company that reserve disbursements are sent to. This event creates
multiple letters; e.g., if you have three insurance companies set up, you will receive three separate letters.
Institution option T EV29 will stop letters from being created for disbursement types 10 through 19 (taxes). If you
would like this option, submit a work order. This letter must be ordered manually.

Example Event 29 Letter

Merge Field Field Mnemonic/
Calculation

Description

AMOUNT TO BE
DISBURSED

RDAMNT Amount that will be disbursed on the reserve

COMPANY ADDRESS
1

CAADD1 Payee address line 1

COMPANY ADDRESS
2

CAADD2 Payee address line 2

COMPANY ADDRESS
3

CAADD3 Payee address line 3

COMPANY CITY
STATE ZIP

CACITY, CASTAT, CAZIPC Payee’s city, state, and ZIP

COMPANY CONTACT CACONT Contact for the payee

COMPANY NAME CANAME Payee’s name

COMPANY NUMBER RDCONO Number assigned to payee information

COMPANY PHONE
NUMBER

CAPHNE Payee’s phone number

DISBURSE
EXPIRATION DATE

RDSEXP Reserve disbursement expiration date

INVESTOR ADDRESS
1

IMA11 Investor address 1
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Merge Field Field Mnemonic/
Calculation

Description

INVESTOR ADDRESS
2

IMA12 Investor address 2

INVESTOR ADDRESS
3

IMA13 Investor address 3

INVESTOR ADDRESS
4

IMA14 Investor address 4

INVESTOR ADDRESS
5

IMA15 Investor address 5

POLICY COVERAGE
AMOUNT

RDPCVR Amount of the policy or coverage on the property

POLICY NUMBER RDPLCY Insurance policy number

Event 29 Sample Letters

See the following examples of sold loan letters:

Example 1: Letter to Insurance Company Concerning New Loan

<<EVENT_DATE>>

<<COMPANY_NAME>>
<<COMPANY_ADDRESS_1>>
<<COMPANY_ADDRESS_2>>
<<COMPANY_ADDRESS_3>>
<<COMPANY_CITY_STATE_ZIP>>   

RE: Loan No: <<FORMATTED_LOAN_NUMBER>>
Policy: <<POLICY_NUMBER>>
Insured: <<ACCOUNT_FIRST_MIDDLE_LAST_NAME_1>>
Property: <<PROPERTY_ADDRESS_LINE1>>

<<PROPERTY_ADDRESS_CITY_STATE_ZIP>>

Dear Borrower(s):

Please be advised that effective Month X, 200X the above referenced loan is being transferred to GOLDPoint
Systems Finance Company. Please change the Mortgagee Clause on the insurance policy to read as
follows:

GOLDPoint Systems Finance Company
1525 West 820 North
Provo, Utah 84601
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If your records do not reflect the policy on this account as currently in force, please contact a
representative of GOLDPoint Systems Finance Company at (555) 555-5555. Otherwise, please send the
endorsement for the requested change, as well as all future correspondence and notices, to GOLDPoint
Systems Finance Company. Please reference our loan number <<FORMATTED_LOAN_NUMBER>>.

Sincerely,

John Doe
Title

E29/L##

Example 2: Sale of Servicing

<<EVENT_DATE>>

<<COMPANY_NAME>>
<<COMPANY_ADDRESS_1>>
<<COMPANY_ADDRESS_2>>
<<COMPANY_ADDRESS_3>>
<<COMPANY_CITY_STATE_ZIP>>

RE:   Loan # <<FORMATTED_LOAN_NUMBER>>

Dear Borrower:

It is customary practice in the Mortgage Lending Industry for lenders to purchase or sell servicing rights.

The servicing of the above mentioned loan will be transferred to GOLDPoint Systems Finance Company.
Your <<DUE_DATE>> payment should be sent to GOLDPoint Systems Finance Company, who maintains
an effective Customer Service Department that will answer any questions or assist in the resolution of any
problems that may develop related to your loan. The Customer Service number is 1-800-555-5555,
extension #5555.

In the immediate future, GOLDPoint Systems Finance Company will furnish you with information as to their
procedures and payment instructions. Prior to the receipt of this information from them, your payment
should be directed to GOLDPoint Systems Finance Company, 1525 West 820 North, Provo, Utah 84601.

Please include your current payment coupon until new coupons are issued by GOLDPoint Systems
Finance Company. All payments that have been directed to Old Savings Finance Company prior to the
receipt of this letter will be promptly credited and it will not be necessary for you to communicate with us in
this regard. All information concerning your loan file has been transferred to GOLDPoint Systems Finance
Company. A statement reflecting year-to-date interest paid to Old Savings Finance Company for the
current year through the date of transfer will be provided by Old Savings Finance Company.

Sincerely,
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Old Savings Finance Company

E29/L##

Event 30, Buydown Payment Change

This letter is generated one month prior to the new subsidy effective date in the Loan system.

Merge Field Field Mnemonic/
Calculation

Description

DAYS BEFORE
PAYMENT
CHANGE

LNAMID Days prior to next P/I change date to calculate pmt

DAYS BEFORE
RATE CHANGE

LNAMAD Days prior to next rate change date to calculate rate

NEW PAYMENT
WITHOUT
SUBSIDY

LNPICN + EFF
LNR1CN + EFF
LNR2CN

P/I payment + effective Reserve 1 payment + effective Reserve
2 payment
***new payment amounts are calculated using payments that
are in effect as of the subsidy effective date

NEW PAYMENT
WITH SUBSIDY

LNPICN + EFF
LNR1CN + EFF
LNR2CN - LNSNXT

P/I payment + effective Reserve 1 payment + effective Reserve
2 payment - next subsidy payment
***new payment amounts are calculated using payments that
are in effect as of the subsidy effective date

NEXT SUBSIDY
PAYMENT

LNSNXT Next subsidy payment

ROUND RATE E T
Q

LNRRND Round rate to the eighth, tenth or quarter

SUBSIDY
ACCRUED
INTEREST

LNSACI Subsidy accrued interest

SUBSIDY
EFFECTIVE DATE

LNSEFF Subsidy effective date

SUBSIDY
EXPIRATION DATE

LNSEXP Subsidy expiration date

 

Event 31, Buydown Expiration Letter

This letter is generated one month prior to the subsidy expiration date. 
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Merge Field Field Mnemonic/
Calculation

Description

DAYS BEFORE
PAYMENT CHANGE

LNAMID Days prior to next P/I change date to calculate pmt

DAYS BEFORE RATE
CHANGE

LNAMAD Days prior to next rate change date to calculate rate

NEW PAYMENT
WITHOUT SUBSIDY

LNPICN + EFF
LNR1CN + EFF
LNR2CN

P/I payment + effective Reserve 1 payment + effective
Reserve 2 payment

*** new payment amounts are calculated using payments
that are in effect as of the subsidy effective date

NEW PAYMENT WITH
SUBSIDY

LNPICN + EFF
LNR1CN + EFF
LNR2CN - LNSNXT

P/I payment + effective Reserve 1 payment + effective
Reserve 2 payment - next subsidy payment

*** new payment amounts are calculated using payments
that are in effect as of the subsidy effective date

NEXT SUBSIDY
PAYMENT

LNSNXT Next subsidy payment

ROUND RATE E T Q LNRRND Round rate to the eighth, tenth, or quarter

SUBSIDY ACCRUED
INTEREST

LNSAC1 Subsidy accrued interest

SUBSIDY EFFECTIVE
DATE

LNSEFF Subsidy effective date

SUBSIDY EXPIRATION
DATE

LNSEXP Subsidy expiration date

Event 32, Insurance Letter (before expiration date)

This event will automatically generate letters for reserve disbursement types 20-28 and 40-49 that will expire
within 75 days. A separate letter is created for each reserve disbursement item. Note: This event can also be
manually requested within 75 days prior to the expiration date or any time after the expiration date. 

This event will generate a letter to inform the customer that a reserve disbursement item is about to expire. The
letter will generate a specific number of days before the expiration date.

Note: This event can be manually ordered after the loan is closed for 60 days. This would be used, for example,
to notify the insurance company to remove the Finance Company as the mortgagee on the policy.

Options:

· A report option is available which indicates how many days prior to the expiration date a letter will be
automatically generated; if this option is not set the letter will generate on the expiration date. 
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GOLDPoint Systems Only: Miscellaneous Parameters 3-4 in the Report Setup

Screen for FPSRP175 stores the number of days prior to the expiration date to create
the letter.  

 
· Institution options RDEX and RDE2 are available to store the reserve disbursement types for which the

institution would like letters to be automatically generated. For example, if you only want letters for reserve
disbursement types 20-25 or 40-45.

Information used in the letters is pulled from Loans > Reserves > Account Reserve Detail screen. This event
must be requested through a work order.  

Merge Field Field
Mnemonic/Calculation

Description

AMOUNT TO BE
DISBURSED

RDAMNT Amount that will be disbursed on the reserve

COMPANY ADDRESS
1

CAADD1 Payee address line 1

COMPANY ADDRESS
2

CAADD2 Payee address line 2

COMPANY ADDRESS
3

CAADD3 Payee address line 3

COMPANY CITY STATE
ZIP

CACITY, CASTAT,
CAZIPC

Payee’s city, state, and ZIP

COMPANY CONTACT CACONT Contact for the payee

COMPANY NAME CANAME Payee’s name

COMPANY NUMBER RDCONO Number assigned to payee information

COMPANY PHONE
NUMBER

CAPHNE Payee’s phone number

DISBURSE
EXPIRATION DATE

RDSEXP Reserve disbursement expiration date

INVESTOR ADDRESS 1 IMA11 Investor address 1

INVESTOR ADDRESS 2 IMA12 Investor address 2

INVESTOR ADDRESS 3 IMA13 Investor address 3

INVESTOR ADDRESS 4 IMA14 Investor address 4

INVESTOR ADDRESS 5 IMA15 Investor address 5

POLICY COVERAGE
AMOUNT

RDPCVR Amount of the policy or coverage on the property

POLICY NUMBER RDPLCY Insurance policy number

Examples of Event 32 letters.
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Event 32 Sample Letters

See the following examples of event letter 32:

Example 1: Insurance (Expiration of Hazard)

<<EVENT_DATE>>

<<ACCOUNT_FIRST_MIDDLE_LAST_NAME_1>>
<<COMPANY_ADDRESS_1>>
<<COMPANY_ADDRESS_2>>
<<COMPANY_CITY_STATE_ZIP>>

RE: Loan Number: <<FORMATTED_LOAN_NUMBER>>      
Insured: <<ACCOUNT_FIRST_MIDDLE_LAST_NAME_1>>
Policy # <<POLICY_NUMBER>>
Property: <<PROPERTY_ADDRESS_LINE1>>
Expiration date: <<DISBURSE_EXPIRATION_DATE>>

Your hazard insurance policy will expire on the date indicated above. Your mortgage loan agreement
requires that you provide us with a renewal policy prior to expiration.

To date, we have not received a renewal policy from your insurance agent. If you have not received a
renewal notice, please have your agent or company send us a renewal policy immediately and advice them
of the proper mortgage clause as follows:

GOLDPoint Systems Finance Company
Its Successors and/or Assigns
1525 West 820 North
Provo, Utah 84601

If your loan does not provide an escrow account for hazard insurance, please forward evidence of coverage
immediately. If we do not receive a renewal policy within fifteen (15) days or by the date of expiration, we
will purchase a fire policy in the amount of your principal balance to protect our interest in the property.
Your escrow account will be charged accordingly. If you do not have an escrow account, one will be
created for you. Any renewal policy received after we have issued fire coverage, with an agent of our choice,
must be accompanied by a paid receipt for the first year, plus a $10.00 substitution fee.

Should you require additional information, please contact us at (555) 555-5555.

Sincerely,

LOAN SERVICING DEPARTMENT

E32/L##
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Example 2: Insurance (Loan Paid in Full)

<<EVENT_DATE>>

<<ACCOUNT_FIRST_MIDDLE_LAST_NAME_1>>
<<ACCOUNT_FIRST_MIDDLE_LAST_NAME_2>>
<<MAIL_ADDRESS_LINE1>>
<<MAIL_ADDRESS_CITY_STATE_ZIP>>  

RE: Loan # <<FORMATTED_LOAN_NUMBER>>
Policy # <<POLICY_NUMBER>>
Insured: <<ACCOUNT_FIRST_MIDDLE_LAST_NAME_1>>

Dear Account Holder:

We are returning the above mentioned policy. This loan has been paid in full and GOLDPoint Systems
Finance Company no longer receives mortgage payments from the insured on this loan.

Sincerely,

LOAN SERVICING DEPARTMENT

E32/L##

Example 3: Lapse in Coverage

<<EVENT_DATE>>

<<ACCOUNT_FIRST_MIDDLE_LAST_NAME_1>>
<<ACCOUNT_FIRST_MIDDLE_LAST_NAME_2>>
<<MAIL_ADDRESS_LINE1>>
<<MAIL_ADDRESS_CITY_STATE_ZIP>>  

PROPERTY ADDRESS:
<<PROPERTY_ADDRESS_LINE1>>
<<PROPERTY_ADDRESS_CITY_STATE_ZIP>>

Re: Loan No. <<FORMATTED_LOAN_NUMBER>>

Dear Borrower(s):

We have received the new policy/binder from _________________ effective <<APPOINTMENT_DATE>>
and have cancelled the Rocky Mountain Insurance Company policy as of that date.
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Due to the lapse in coverage from ______________ to ___________, we are charging your loan for
$______________, which represents the earned premium on the Rocky Mountain Company policy. The
amount of $_______________ must be included with your net payment.

If you have any questions regarding this matter, please do not hesitate to contact our Loan Service
Department at (555) 555-5555.

Sincerely,

Jane Doe
Loan Service Representative

E32/L##

Event 33, Over-Credit-Limit Notification for Line-of-Credit Loans

This letter is generated when the credit limit for line-of-credit loans has been exceeded. The letter will
automatically be created when the date of the last transaction is today and the principal balance exceeds the
credit limit. Note: A letter will be created each time the date of the last transaction changes; this may result in
more than one letter being created within several days. (The date of the last transaction is for monetary activity
only.) The letter can also be ordered manually.

If the loan is a non-revolving line-of-credit, this letter is not available.

Merge Field Field Mnemonic/
Calculation

Description

AMOUNT OVER CREDIT
LIMIT

LNPBAL-LNRLCL Amount over the credit limit: principal balance - credit
limit

Event 34, ARM P/I Payment Changes Only Letter

All P/I change fields are checked for a change, and any change is reported on the letter. No rate changes are
included in this letter.

Merge Field Field Mnemonic/
Calculation

Description

ARM 2ND NEXT P/I
CHANGE DATE

LNPIEF +
LNAMPC

P/I effective date plus the P/I payment change frequency

ARM AMORTIZED
P/I PAYMENT

LNAPIC The P/I payment required to fully amortize the loan

ARM AMORTIZED
PRINCIPAL
BALANCE

AMTZ PRIN The principal balance on which the new adjusted payment is
based
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Merge Field Field Mnemonic/
Calculation

Description

ARM GRADUATED
PMT INCREASE
PERCENT

LNAMGI The percentage the P/I payment will increase each P/I
payment frequency

ARM INTEREST
ACCRUAL RATE

LNAMRT The rate at which interest should accrue for payment method
7 loans

ARM INTEREST
ONLY P/I PAYMENT

LNIPIC The P/I payment required to satisfy the calculated interest

ARM INTEREST
RATE POINTER

LNAMPT The accrual rate pointer that is tied to the rate index

ARM NEW INDEX LNAPIN New index (last index)

ARM NEW P/I
PAYMENT

LNPINX Newly calculated P/I payment 

ARM NEW R1
PAYMENT

EFFECTIVE R1 The Reserve 1 payment effective with the new payment
change

ARM NEW R2
PAYMENT

EFFECTIVE R2 The Reserve 2 payment effective with the new payment

ARM NEW SUBSIDY
PAYMENT

EFFECTIVE SUBSIDY The subsidy payment effective with the new payment

ARM NEW TOTAL
PAYMENT

NEW P/I +
NEW R1 +
NEW R2 -
NEW SUBSIDY

New P/I payment plus new Reserve 1 payment plus new
Reserve 2 payment minus new subsidy payment

ARM OLD P/I
PAYMENT

LNPICN Old P/I payment in effect prior to the new payment change

ARM OLD R1
PAYMENT

EFFECTIVE R1 Reserve 1 payment in effect prior to the new payment change

ARM OLD R2
PAYMENT

EFFECTIVE R2 Reserve 2 payment in effect prior to the new payment change

ARM OLD SUBSIDY
PAYMENT

EFFECTIVE SUBSIDY Subsidy payment if effect prior to the new payment change

ARM OLD TOTAL
PAYMENT

OLD P/I +
OLD R1 +
OLD R2 -
OLD SUBSIDY

Old P/I payment plus old Reserve 1 payment plus old
Reserve 2 payment minus old subsidy payment

ARM P/I PAYMENT
BASED ON INC LMT

LNPICN*
LNAMPL

Old P/I payment multiplied by the P/I payment increase limit

ARM P/I PAYMENT
CHANGE COUNTER

LNAMCC Number of times the system calculates the next P/I payment
automatically
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Merge Field Field Mnemonic/
Calculation

Description

ARM P/I PAYMENT
CHANGE DATE

LNPIEF The date that the next P/I payment will replace the P/I
payment

ARM P/I PAYMENT
CHANGE
FREQUENCY

LNAMPC Number of months that should occur between payment
changes

ARM P/I PAYMENT
INCREASE LIMIT

LNAMPL The percentage the P/I payment can increase with a
payment change

ARM REMAINING
TERM

LNMATD -
LNAMDT

Month’s difference between the maturity date and next
accrual rate change date. For bi-weekly loans, take the term
in months divided by 12 multiplied by 26 to get the number of
payments. Subtract the installment from the number of
payments to get remaining payments. Take remaining
payments divided by 26 then multiply by 12 to get the
remaining term in months.

PROJECTED PMT
PRINCIPAL
PORTION

Calculated Principal portion of the projected new payment.

PROJECTED PMT
INTEREST PORTION

Calculated Interest portion of the projected new payment.

Event 35, FHA Loan Payoff Letter (Insured Prior to August 2,
1985)

This letter is sent once a year as required by the National Affordable Housing Act, section 329 and follows the
format defined by HUD. In the afterhours on the date requested by the institution, the system automatically
selects letter 35 or 36 using the Date Opened field (LNOPND). The letter prints the payoff amount, the fees
pertaining to the payoff either as part of the total payoff amount or as a separate amount, and any requirements
the borrower must fulfill to prevent accrual of interest on the mortgage loan after the pre-payment date. 

To request this letter, submit a work order to GOLDPoint Systems indicating the telephone number of your Loan
Service Department for the borrower to call, the name and title of the employee who signs the letter, and how
the payoff fees are disclosed. 

To manually generate this letter, set up the event in the Event Letters, Numbers & Dates fields on the
Actions/Holds/Events tab on various screens in CIM GOLD. The payoff is calculated to the end of the month
following the date that the event letter is requested.

The payoff is calculated as follows: Principal Balance on the date the letter is created multiplied by the
Interest Rate, then divided by 12 (months). The system then adjusts the interest amount for prepaid or
delinquent loans. The interest is always calculated through the end of the month following the month the letter
was created. 

Example: If the letter was created in December, the calculation is through January 31. Reserves are not
subtracted from the payoff amount.
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For ease in your being able to tie to our figures, the reserves are not subtracted from the payoff amount (you
don’t have to worry about interest on reserves). The event will only generate on loans with an Insurer code
(LNINSU) of 1 (FHA) found on the Loans > Account Information > Account Detail screen. 

Merge Field Field Mnemonic/
Calculation

Description

FHA ACCOUNT
NUMBER

LNFVNO FHA account number

FHA PAYOFF
AMOUNT

LNPBAL * CALC
INT + LNLATE +
LNFEES

principal balance + interest (principal * loan rate / 12 * # of
months prepaid or delinquent) + late charges + total loan fees

FHA PAYOFF
DATE

RUN DATE + 1 MON
THEN MAKE END OF
MONTH

Date the payoff is calculated to (end of the month following the
month the letter was created)

FHA PO
AMOUNT WITH
PO FEE

LNPBAL * CALC INT +
LNLATE + LNFEES +
OPT FHAF

FHA PAYOFF AMOUNT plus payoff fee from inst options

FHA PO FEE OPT FHAF Payoff fee from the institution option

GOLDPoint Systems ONLY
 

FHAD Set this option (FHA Disclosure letter run
date MMDD) to have the letters run every
year on the same month and day.

FHAF Set this option (FHA Disclosure extra fee)
to disclose the fees pertaining to the
payoff.

Event 36, FHA Loan Payoff Letter (Insured on or after August 2,
1985)

This letter is generated and calculated the same as event 35 with the following exception: This letter is for
FHA loans insured on or after August 2, 1985.

Merge Field Field Mnemonic/
Calculation

Description

FHA ACCOUNT
NUMBER

LNFVNO FHA account number

FHA PAYOFF
AMOUNT

LNPBAL * CALC INT +
LNLATE + LNFEES

principal balance + interest (principal * loan rate / 12 * # of
months prepaid or delinquent) + late charges + total loan fees
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Merge Field Field Mnemonic/
Calculation

Description

FHA PAYOFF
DATE

RUN DATE + 1 MON
THEN MAKE END OF
MONTH

Date the payoff is calculated to (end of the month following the
month the letter was created)

FHA PO
AMOUNT WITH
PO FEE

LNPBAL * CALC INT +
LNLATE + LNFEES +
OPT FHAF

FHA PAYOFF AMOUNT plus payoff fee from inst options

FHA PO FEE OPT FHAF Payoff fee from institution options

Event 40, ARM Accrual Rate Up/Down, Payment Change, Rate
Caps, Lifetime Rate Caps

All P/I change fields are checked for a change, and any change is reported on the letter. The letter includes a
summary of interest rate changes that have occurred since the last P/I change. This letter can only be
generated if the Use Event Letter 40 field on the Rate Caps & Negative Amortization tab is checkmarked
(Loans > Account Information > ARM Information screen in CIM GOLD), the Rate Change Frequency is not
the same as the P/I Change Frequency, and you have requested the event letter by work order.

For example, if the next P/I change is on April 1, the last P/I change was April 1, and the interest rate does not
change on April 1, the event letter will generate showing the next P/I change date and amount and all the rate
changes since April 1. 

If this letter is turned on, a new section of the Event Letter Report (FPSRP175) is created called "Account with
Accrual Rate Change Only." See the Loan Reports manual for more information.

Merge Field Field Mnemonic/
Calculation

Description

ARM 2ND NEXT P/I
CHANGE DATE

LNPIEF +
LNAMPC

Next P/I Change Date plus the P/I Change Frequency
on the Loans > Account Information > ARM Information
screen > ARM Rates & P/I Tables tab.

ARM 2ND NEXT RATE
CHANGE DATE

LNAMDT +
LNAMFQ

Next Rate Change Date plus the Rate Change
Frequency on the Loans > Account Information > ARM
Information screen > ARM Rates & P/I Tables tab.

ARM ACCRUAL INDEX 1 LNNDX1 Oldest index in Rate Table on the Loans > Account
Information > ARM Information screen > ARM Rates & P/I
Tables tab.

ARM ACCRUAL RATE 1 LNANR1 Oldest accrual rate in Rate Table on the Loans > Account
Information > ARM Information screen > ARM Rates & P/I
Tables tab.

ARM ACCRUAL RATE
EFFECTIVE DATE 1

LNADT1 Oldest accrual rate effective date in Rate Table on the
Loans > Account Information > ARM Information screen >
ARM Rates & P/I Tables tab.

https://secure.goldpointsystems.com/gpsdocs/loans/LoansCIMGOLD/index.asp?useeventletter40_laais.asp
https://secure.goldpointsystems.com/gpsdocs/loans/LoanReports/llr175.asp
https://secure.goldpointsystems.com/gpsdocs/loans/LoanReports/llr175.asp
https://secure.goldpointsystems.com/gpsdocs/loans/LoansCIMGOLD/index.asp?armratespipmttablestab_laais.asp
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Merge Field Field Mnemonic/
Calculation

Description

ARM ACCRUAL INDEX 2 LNNDX2 Index 2 in Rate Table on the Loans > Account Information
> ARM Information screen > ARM Rates & P/I Tables tab.

ARM ACCRUAL RATE 2 LNANR2 Accrual rate 2 in Rate Table on the Loans > Account
Information > ARM Information screen > ARM Rates & P/I
Tables tab.

ARM ACCRUAL RATE
EFFECTIVE DATE 2

LNADT2 Accrual rate 2 effective date in Rate Table on the Loans >
Account Information > ARM Information screen > ARM
Rates & P/I Tables tab.

ARM ACCRUAL INDEX 3 LNNDX3 Index 3 in Rate Table on the Loans > Account Information
> ARM Information screen > ARM Rates & P/I Tables tab.

ARM ACCRUAL RATE 3 LNANR3 Accrual rate 3 in Rate Table on the Loans > Account
Information > ARM Information screen > ARM Rates & P/I
Tables tab.

ARM ACCRUAL RATE
EFFECTIVE DATE 3

LNADT3 Accrual rate 3 effective date in Rate Table on the Loans >
Account Information > ARM Information screen > ARM
Rates & P/I Tables tab.

ARM ACCRUAL INDEX 4 LNNDX4 Index 4 in Rate Table on the Loans > Account Information
> ARM Information screen > ARM Rates & P/I Tables tab.

ARM ACCRUAL RATE 4 LNANR4 Accrual rate 4 in Rate Table on the Loans > Account
Information > ARM Information screen > ARM Rates & P/I
Tables tab.

ARM ACCRUAL RATE
EFFECTIVE DATE 4

LNADT4 Accrual rate 4 effective date in Rate Table on the Loans >
Account Information > ARM Information screen > ARM
Rates & P/I Tables tab.

ARM ACCRUAL INDEX 5 LNNDX5 Index 5 is in Rate Table on the Loans > Account
Information > ARM Information screen > ARM Rates & P/I
Tables tab.

ARM ACCRUAL RATE 5 LNANR5 Accrual rate 5 in table on the Loans > Account Information
> ARM Information screen > ARM Rates & P/I Tables tab.

ARM ACCRUAL RATE
EFFECTIVE DATE 5

LNADT5 Accrual rate 5 effective date in table on the Loans >
Account Information > ARM Information screen > ARM
Rates & P/I Tables tab.

ARM ACCRUAL INDEX 6 LNNDX6 Index 6 in rate table on the Loans > Account Information >
ARM Information screen > ARM Rates & P/I Tables tab.

ARM ACCRUAL RATE 6 LNANR6 Accrual rate 6 in table on the Loans > Account Information
> ARM Information screen > ARM Rates & P/I Tables tab.

ARM ACCRUAL RATE
EFFECTIVE DATE 6

LNADT6 Accrual rate 6 effective date in table on the Loans >
Account Information > ARM Information screen > ARM
Rates & P/I Tables tab.
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Merge Field Field Mnemonic/
Calculation

Description

ARM ACCRUAL INDEX 7 LNNDX7 Index 7 in rate table on the Loans > Account Information >
ARM Information screen > ARM Rates & P/I Tables tab.

ARM ACCRUAL RATE 7 LNANR7 Accrual rate 7 in table on the Loans > Account Information
> ARM Information screen > ARM Rates & P/I Tables tab.

ARM ACCRUAL RATE
EFFECTIVE DATE 7

LNADT7 Accrual rate 7 effective date in table on the Loans >
Account Information > ARM Information screen > ARM
Rates & P/I Tables tab.

ARM ACCRUAL INDEX 8 LNNDX8 Index 8 in rate table on the Loans > Account Information >
ARM Information screen > ARM Rates & P/I Tables tab.

ARM ACCRUAL RATE 8 LNANR8 Accrual rate 8 in table on the Loans > Account Information
> ARM Information screen > ARM Rates & P/I Tables tab.

ARM ACCRUAL RATE
EFFECTIVE DATE 8

LNADT8 Accrual rate 8 effective date in table on the Loans >
Account Information > ARM Information screen > ARM
Rates & P/I Tables tab.

ARM ACCRUAL INDEX 9 LNNDX9 Index 9 in rate table on the Loans > Account Information >
ARM Information screen > ARM Rates & P/I Tables tab.

ARM ACCRUAL RATE 9 LNANR9 Accrual rate 9 in table on the Loans > Account Information
> ARM Information screen > ARM Rates & P/I Tables tab.

ARM ACCRUAL RATE
EFFECTIVE DATE 9

LNADT9 Accrual rate 9 effective date in table on the Loans >
Account Information > ARM Information screen > ARM
Rates & P/I Tables tab.

ARM ACCRUAL INDEX 10 LNNDXA Index 10 in rate table on the Loans > Account Information
> ARM Information screen > ARM Rates & P/I Tables tab.

ARM ACCRUAL RATE 10 LNANRA Accrual rate 10 in table on the Loans > Account
Information > ARM Information screen > ARM Rates & P/I
Tables tab.

ARM ACCRUAL RATE
EFFECTIVE DATE 10

LNADTA Accrual rate 10 effective date in table on the Loans >
Account Information > ARM Information screen > ARM
Rates & P/I Tables tab.

ARM ACCRUAL INDEX 11 LNNDXB Index 11 in rate table on the Loans > Account Information
> ARM Information screen > ARM Rates & P/I Tables tab.

ARM ACCRUAL RATE 11 LNANRB Accrual rate 11 in table on the Loans > Account
Information > ARM Information screen > ARM Rates & P/I
Tables tab.

ARM ACCRUAL RATE
EFFECTIVE DATE 11

LNADTB Accrual rate 11 effective date in table on the Loans >
Account Information > ARM Information screen > ARM
Rates & P/I Tables tab.

ARM ACCRUAL INDEX 12 LNNDXC Index 12 in rate table on the Loans > Account Information
> ARM Information screen > ARM Rates & P/I Tables tab.



GOLDEvent Letters194

© 2019 GOLDPoint SystemsLast updated: 11/25/2019

Merge Field Field Mnemonic/
Calculation

Description

ARM ACCRUAL RATE 12 LNANRC Accrual rate 12 in table on the Loans > Account
Information > ARM Information screen > ARM Rates & P/I
Tables tab.

ARM ACCRUAL RATE
EFFECTIVE DATE 12

LNADTC Accrual rate 12 effective date in table on the Loans >
Account Information > ARM Information screen > ARM
Rates & P/I Tables tab.

ARM AMORTIZED P/I
PAYMENT

LNAPIC or LNPINX Amortized P/I field: The P/I payment required to fully
amortize the loan. If this amount is zero, the amount in the
Next P/I field (LNPINX) will be used.

ARM AMORTIZED
PRINCIPAL BALANCE

AMTZ PRIN The principal balance on which the new adjusted payment
is based.

ARM BASE INDEX LNBINX Base index value used when calculating the new rate on
the loan account when the Use this Base Index option is
checked.

ARM DAYS BEFORE
RATE CHANGE

LNAMAD Days Before Rate Change field: Days before the next
accrual rate change date to calculate a new rate.

ARM DIFF BETWEEN
NXT CURRENT INDEX

NEW INDEX-
OLD INDEX

Difference between the next accrual index and current
accrual index

ARM DIFF BETWEEN
NXT ORIGINAL RATE

LNAMNA-
LNAMOA

Difference between the next accrual rate and the original
rate

ARM GRADUATED PMT
INCREASE PERCENT

LNAMGI Repay Percent field: The percentage the P/I payment that
will increase each P/I change frequency. This field is
obsolete.

ARM INDEX PUBLISHING
FREQUENCY

RTPBFQ Frequency the index is published (e.g., weekly, daily).
This information is entered on the Loans > System Setup
Screens > Interest Rate Table screen.

ARM INTEREST
ACCRUAL RATE

LNAMRT Current Rate field: The rate at which interest is accruing
for this ARM loan.

ARM INTEREST ONLY P/I
PAYMENT

LNIPIC Interest Only P/I field: The P/I payment required to satisfy
the calculated interest.

ARM INTEREST RATE
POINTER

LNAMPT Index Rate Pointer field: The accrual rate pointer that is
tied to the rate index.

ARM LENGTH OF RATE
CAP PERIOD

LNAMLP Length of Rate Cap Period field

ARM NAME OF RATE
INDEX

RTCL34 Name of the index, such as LIBOR. This information is
entered on the Loans > System Setup Screens > Interest
Rate Table screen.

ARM NEW INDEX LNAPIN Last Index Rate field
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Merge Field Field Mnemonic/
Calculation

Description

ARM NEW INDEX WITH
OFFSET

LNAPIN+
LNAMOF

Last Index Rate plus Interest Rate Margin

ARM NEW P/I PAYMENT LNPINX Next P/I field: Newly calculated P/I payment.

ARM NEW R1 PAYMENT Effective Reserve 1
Payment

Reserve 1 payment effective with the new loan payment
change.

ARM NEW R2 PAYMENT Effective Reserve 2
Payment

Reserve 2 payment effective with the new loan payment.

ARM NEW SUBSIDY
PAYMENT

Effective Subsidy
Payment

The subsidy payment effective with the new loan payment.

ARM NEW TOTAL
PAYMENT

NEW P/I+
NEW R1+
NEW R2-
NEW SUBSIDY

New P/I payment plus new Reserve 1 payment plus new
Reserve 2 payment minus new Subsidy payment.

ARM NEXT INTEREST
ACCRUAL RATE

LNAMNA Next Rate field: Next accrual rate for this account.

ARM NEXT RATE
CHANGE DATE

LNAMDT Next Rate Change Date field

ARM OLD INDEX TRLG Old (prior) index

ARM OLD P/I PAYMENT LNPICN Current P/I payment in effect prior to the new payment
change. 

ARM OLD R1 PAYMENT Effective Reserve 1
Payment

Reserve 1 payment in effect prior to the new loan payment
change.

ARM OLD R2 PAYMENT Effective Reserve 2
Payment

Reserve 2 payment in effect prior to the new loan payment
change

ARM OLD SUBSIDY
PAYMENT

Effective Subsidy Subsidy payment in effect prior to the new loan payment
change.

ARM OLD TOTAL
PAYMENT

OLD P/I +
OLD R1 +
OLD R2 -
OLD SUBSIDY

Old P/I loan payment plus old Reserve 1 payment plus old
Reserve 2 payment minus old Subsidy payment.

ARM ORIGINAL RATE LNAMOA Original Rate field

ARM P/I PAYMENT
BASED ON INC LMT

LNPICN *
LNAMPL

Current P/I payment multiplied by the P/I Increase Limit

ARM P/I PAYMENT
CHANGE COUNTER

LNAMCC P/I Change Counter field: Number of times the system
calculates the next P/I payment automatically.

ARM P/I PAYMENT
CHANGE DATE

LNPIEF Next P/I Change Date field: The date that the next P/I
payment will replace the current P/I payment.
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Merge Field Field Mnemonic/
Calculation

Description

ARM P/I PAYMENT
CHANGE FREQUENCY

LNAMPC P/I Change Frequency field: Number of months that
should occur between payment changes.

ARM P/I PAYMENT
INCREASE LIMIT

LNAMPL P/I Increase Limit field: The percentage the P/I payment
can increase with a payment change.

ARM PAYMENT RATE LNRATE Payment Rate field

ARM RATE AT PERIOD
START

LNAMSY Rate at Period Start field: Interest rate at the start of the
rate cap period.

ARM RATE CHANGE
FREQUENCY

LNAMFQ Rate Change Frequency field: Number of months that
should occur between rate changes.

ARM RATE CHANGE
MINIMUM

LNAMCM Rate Change Minimum field: The minimum percentage
by which the loan rate can be changed

ARM REMAINING TERM LNMATD-
LNAMDT

Month’s difference between the maturity date and next
accrual rate change date. For bi-weekly loans, take the
term in months divided by 12 multiplied by 26 to get the
number of payments. Subtract the installment from the
number of payments to get remaining payments. Take
remaining payments divided by 26 then multiply by 12 to
get the remaining term in months.

ARM START OF
ACCRUAL PERIOD

LNAMPD Start of Accrual Period field: Starting date of the current
rate cap period.

ARM SOURCE OF RATE
INDEX

RTPBDS Publishing source of the index rate (e.g., Wall Street
Journal). This information is entered on the Loans >
System Setup Screens > Interest Rate Table screen.

DEFERRED INTEREST LNDEFI Deferred Interest field

PREPAYMENT PENALTY
END DATE

Calculated field End date of the prepayment penalty

YTD DEFERRED
INTEREST

LNYTDD Year-to-Date Deferred Interest Paid field

PROJECTED PMT
PRINCIPAL PORTION

Calculated Principal portion of the projected new payment.

PROJECTED PMT
INTEREST PORTION

Calculated Interest portion of the projected new payment.

 

Event 41, Payment Change when LIP

Event 41 calculates the new P/I while the loan is still in the construction process. If the LIP method code is 1 or
101 and the loan fields on the ARM Loan Information screen (payment method 6 or 7 loans) call for a P/I
change, the system will calculate the new loan accrual rate and P/I constant. 
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WARNING

While the loan is in the construction process and payments are posted, the
installment number (on the Loans > Account Information > Account Detail, Payment
Detail tab) does not increase (it remains zero). Depending on the number of
remaining months to be used in the P/I calculation, you may have to manually enter
the installment number either from the pattern or prior to the system calculation.
Example: You have a construction/permanent loan with a term of 360 months. The
first 9 months is the construction period. The mortgage payments on the permanent
loan are to amortize over 351 months. In order for the new P/I to be calculated
correctly, the installment number should be 9. 

Merge Field Field Mnemonic/
Calculation

Description

ARM 2ND NEXT P/I
CHANGE DATE

LNPIEF +
LNAMPC

P/I effective date plus the P/I payment change
frequency

ARM 2ND NEXT RATE
CHANGE DATE

LNAMDT +
LNAMFQ

Next accrual rate change date plus the rate change
frequency

ARM AMORTIZED P/I
PAYMENT

LNAPIC The P/I payment required to fully amortize the loan

ARM AMORTIZED
PRINCIPAL BALANCE

AMTZ PRIN The principal balance on which the new adjusted
payment is based

ARM DAYS BEFORE
RATE CHANGE

LNAMAD Days before the next accrual rate change date to
calculate a new rate

ARM DIFF BETWEEN NXT
CURRENT INDEX

NEW INDEX -
OLD INDEX

Difference between the next accrual index and
current accrual index

ARM DIFF BETWEEN NXT
ORIGINAL RATE

LNAMNA -
LNAMOA

Difference between the next accrual rate and the
original rate

ARM GRADUATED PMT
INCREASE PERCENT

LNAMGI The percentage the P/I payment will increase each
P/I payment frequency

ARM INDEX PLUS
OFFSET LESS ACCR RT

NEW INDEX +
LNAMOF -
LNAMRT

New index plus the accrual rate offset/margin
minus accrual rate

ARM INTEREST ACCRUAL
RATE 

LNAMRT The rate at which interest should accrue for
payment method 7 loans

ARM INTEREST ONLY P/I
PAYMENT

LNIPIC The P/I payment required to satisfy the calculated
interest

ARM LENGTH OF RATE
CAP PERIOD

LNAMLP Length of rate cap period 

ARM MOST RECENT P/I
CHANGE DATE

Newest P/I change date on the ARM Rates & P/I
Tables tab on the ARM Information screen
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Merge Field Field Mnemonic/
Calculation

Description

ARM MOST RECENT P/I
PAYMENT

Newest P/I payment on the ARM Rates & P/I
Tables tab on the ARM Information screen

ARM MOST RECENT
TOTAL PAYMENT 

MOST RECENT P/I +
NEW R1 +
NEW R2 -
NEW SUBSIDY

Newest P/I payment on the ARM Rates & P/I
Tables tab on the ARM Information screen, plus
Reserve 1 payment effective for the newest
payment change date plus Reserve 2 payment
effective for the newest payment change date
minus subsidy payment effective for the newest
payment change date

ARM NEW INDEX LNAPIN New index (last index)

ARM NEW INDEX WITH
OFFSET

LNAPIN +
LNAMOF

New index plus accrual rate offset/margin

ARM NEW P/I PAYMENT LNPINX Newly calculated P/I payment 

ARM NEW R1 PAYMENT EFFECTIVE R1 The Reserve 1 payment effective with the new
payment change

ARM NEW R2 PAYMENT EFFECTIVE R2 The Reserve 2 payment effective with the new
payment

ARM NEW SUBSIDY
PAYMENT

EFFECTIVE SUBSIDY The subsidy payment effective with the new
payment

ARM NEW TOTAL
PAYMENT

NEW P/I +
NEW R1 +
NEW R2 -
NEW SUBSIDY

New P/I payment plus new Reserve 1 payment plus
new Reserve 2 payment minus new subsidy
payment

ARM NEXT INTEREST
ACCRUAL RATE

LNAMNA Next accrual rate for this account

ARM NEXT RATE CHANGE
DATE

LNAMDT Date of the next rate change on the loan

ARM OLD INDEX TRLG Old (prior) index

ARM OLD P/I PAYMENT LNPICN Old P/I payment in effect prior to the new payment
change

ARM OLD R1 PAYMENT EFFECTIVE R1 Reserve 1 payment in effect prior to the new
payment change

ARM OLD R2 PAYMENT EFFECTIVE R2 Reserve 2 payment in effect prior to the new
payment change

ARM OLD SUBSIDY
PAYMENT

EFFECTIVE SUBSIDY Subsidy payment if effect prior to the new payment
change

ARM OLD TOTAL
PAYMENT

OLD P/I +
OLD R1 +

Old P/I payment plus old Reserve 1 payment plus
old Reserve 2 payment minus old subsidy payment
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Merge Field Field Mnemonic/
Calculation

Description

OLD R2 -
OLD SUBSIDY

ARM ORIGINAL RATE LNAMOA Original loan rate

ARM P/I PAYMENT
BASED ON INC LMT

LNPICN *
LNAMPL

Old P/I payment multiplied by the P/I payment
increase limit

ARM P/I PAYMENT
CHANGE COUNTER

LNAMCC Number of times the system calculates the next P/I
payment automatically

ARM P/I PAYMENT
CHANGE DATE

LNPIEF The date that the next P/I payment will replace the
P/I payment

ARM P/I PAYMENT
CHANGE FREQUENCY

LNAMPC Number of months that should occur between
payment changes

ARM P/I PAYMENT
INCREASE LIMIT

LNAMPL The percentage the P/I payment can increase with
a payment change

ARM PAYMENT RATE LNRATE The payment rate on the loan 

ARM RATE AT PERIOD
START

LNAMSY Rate at the start of the rate cap period

ARM RATE CHANGE
FREQUENCY

LNAMFQ Number of months that should occur between rate
changes

ARM RATE CHANGE
MINIMUM

LNAMCM The minimum percentage by which the loan rate
can be changed

ARM REMAINING TERM LNMATD -
LNAMDT

Month’s difference between the maturity date and
next accrual rate change date. For bi-weekly loans,
take the term in months divided by 12 multiplied by
26 to get the number of payments. Subtract the
installment from the number of payments to get
remaining payments. Take remaining payments
divided by 26 then multiply by 12 to get the
remaining term in months.

ARM START OF ACCRUAL
PERIOD

LNAMPD Starting date of the current rate cap period

LIP NEXT RATE LNLNXT Next LIP rate

LIP NEXT INDEX LNLNPR Base index used to calculate the next LIP interest
rate

LIP PREVIOUS INDEX LNLPIN Base index used to calculate the current LIP
interest rate

LIP RATE CHANGE DATE LNLCHD Effective date of the next LIP rate change
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Event 42, LIP Rate Change Letter

Event 42 will generate an LIP rate change letter if the LIP rate changes are based on either a rate change date
or rate sensitive loans. This letter will only create if the LIP method code is 1 or 101.

Merge Field Field Mnemonic/
Calculation

Description

LIP NEXT RATE LNLNXT Next LIP rate

LIP NEXT INDEX LNLNPR Base index used to calculate the next LIP interest
rate

LIP PREVIOUS INDEX LNLPIN Base index used to calculate the current LIP interest
rate 

LIP RATE CHANGE
DATE 

LNLCHD Effective date of the next LIP rate change

 
 

Event 43, Charge Interest on Negative Reserves

Event 43 will generate a billing letter for charging interest on negative reserves. Must order letter manually.

Merge Field Field Mnemonic/
Calculation

Description

NEG R1 ACCRUED
INTEREST

NIR1AC Reserve 1 accrued interest on negative reserve balance

NEG R1 BALANCE NIR1BA Reserve 1 balance

NEG R1 DATE LAST
ACCRUED

NIR1DT Reserve 1 date last accrued

NEG R1 INTEREST
PAID

NIR1PD Reserve 1 interest paid on negative reserve balance

NEG R1 INTEREST
RATE

NIR1RT OR LNRATE
OR LNAMRT

Reserve 1 interest rate

***If the Use This Interest Rate field is selected on the
Loans > Account Information > Reserves > Account
Reserve Detail screen, Negative Reserve Interest tab, the
effective rate on the loan will be used.

NEG R2 ACCRUED
INTEREST

NIR2AC Reserve 2 accrued interest on negative reserve 2 balance

NEG R2 BALANCE NIR2BA Reserve 2 balance

NEG R2 DATE LAST
ACCRUED

NIR2DT Reserve 2 date last accrued
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Merge Field Field Mnemonic/
Calculation

Description

NEG R2 INTEREST
PAID

NIR2PD Reserve 2 interest paid

NEG R2 INTEREST
RATE

NIR2RT OR LNRATE
OR LNAMRT

Reserve 2 interest rate

***If the Use This Interest Rate field is selected on the
Loans > Account Information > Reserves > Account
Reserve Detail screen, Negative Reserve Interest tab, the
effective rate on the loan will be used.

NEG RSV YTD INT
PAID LAST YEAR

NIRYTD YTD reserve interest paid last year

NEG RSV YTD INT
PAID THIS YEAR

NICYTD YTD reserve interest paid this year

 

Event 44, First Late Notice Event

Event 44 will generate a letter for the first late notice. We recommend you use 3-up notices for these late
notices. Refer to the Past Due Notices section previously in this document for more information.

Merge Field Field Mnemonic/
Calculation

Description

ACCOUNT
NUMBER

LN4NBR This is the loan account number without the check digit. It
shows the office number and account number, like this:

1234555666

If you would rather use the formatted loan number that does
include the check digit, use the FORMATTED LOAN NUMBER
merge field described in the Basic Loan Fields section.

FOLLOW UP DATE CALC This field will calculate a date in the future that can be printed on
the letter.

If the letter is a notice of default, for example, you can have the
letter display the date by which the account must be current.
The date can be displayed in either alphanumeric or numeric
characters. If the date is 4-14 and the option is 30 days, then
the follow-up date would be 5-14. The original date of 4-14 isn't
included in the calculation.

To use this merge field, you must have a report option turned on.
Please contact your GOLDPoint Systems account manager.
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Merge Field Field Mnemonic/
Calculation

Description

GOLDPoint Systems Only: To create a follow-up date for
events, enter a number from 0 to 99 in positions 5–6 of the
Miscellaneous Parameters field. 

LATE CHARGE
VARIANCE

LNPDUE Late charge variance—amount of the regular payment not paid
because late charges were paid

LOAN COLLECTION
OFFICER

LNCTOR Collector number assigned to the loan

LOAN NEXT
PAYMENT DUE

LNLSTB For non-LIP loans, this is the same as the common field Next
Payment Due. 

For LIP loans, this contains the last billed amount from the
Loans > Construction > Account Construction Detail screen,
Balances, Rates & Billing tab.

LOAN P/I
PAYMENT

LNLSTB For non-LIP loans, this is the same as the common field P/I
Payment. 

LOAN TOTAL DUE LNLPCG + LNLATE For non-LIP loans, this is the same as the common field TOTAL
DUE. 

For LIP loans, this contains the Prior Unpaid Charges + Late
Charges Due.

LOAN TOTAL DUE
AFTER GRACE

LNLPCG + LNLATE
+ CALC

For non-LIP loans, this is the same as the common field TOTAL
DUE AFTER GRACE.

For LIP loans, this contains the Prior Unpaid Charges + Late
Charges Due + current calculated late charges on the Last
Billed Amount.

LOAN TOTAL PMTS
W FEES AND
PARTIAL

LNLPCG + LNFEES
- LNPRTL

For non-LIP loans, this is the same as the common field TOTAL
PMTS W FEES AND PARTIAL.

For LIP loans, this contains the Prior Unpaid Charges + Total
Loan Fees - Partial Payments.

LOAN TOTAL PMTS
W FEES W LATE
CHGS

LNLPCG + LNFEES
+ LNLATE

For non-LIP loans, this is the same as the common field TOTAL
PMTS W FEES AND LATE CHGS.

For LIP loans, this contains the Prior Unpaid Charges + Total
Loan Fees + Late Charges Due.

LOAN TOTAL PMTS
W LATE AND
PARTIAL

LNLPCG + LNLATE
- LNPRTL

For non-LIP loans, this is the same as the common field TOTAL
PMTS W LATE AND PARTIAL.

For LIP loans, this contains the Prior Unpaid Charges + Late
Charges Due - Partial Payments.

LOAN TOTAL PMTS
WITH LATE

LNLPCG + LNLATE For non-LIP loans, this is the same as the common field TOTAL
PMTS WITH LATE CHARGES.
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Merge Field Field Mnemonic/
Calculation

Description

CHARGES
For LIP loans, this contains the Prior Unpaid Charges + Late
Charges Due.

LOAN TOTAL PMTS
WITH LOAN FEES

LNLPCG + LNFEES For non-LIP loans, this is the same as the common field TOTAL
PMTS WITH LOAN FEES.

For LIP loans, this contains the Prior Unpaid Charges + Total
Loan Fees.

LOAN TOTAL PMTS
WITH PARTIAL

LNLPCG + LNPRTL For non-LIP loans, this is the same as the common field TOTAL
PMTS WITH PARTIAL.

For LIP loans, this contains the Prior Unpaid Charges +
Partial Payments.

TOTAL LATE
CHARGE AND FEE
VARIANCE

CALC Late charge variance plus total loan fees variance

TOTAL LOAN FEES
VARIANCE

LNVPRN Total loan fees variance—the amount of the regular payment that
was not paid because of loan fees

 

Event 45, Second Late Notice Event

Event 45 will generate a letter for the second late notice. We recommend you use 3-up notices for these late
notices. Refer to the Past Due Notices section previously in this document for more information.

Merge Field Field Mnemonic/
Calculation

Description

ACCOUNT NUMBER LN4NBR This is the loan account number without the check digit. It
shows the office number and account number, like this:

1234555666

If you would rather use the formatted loan number that
does include the check digit, use the FORMATTED LOAN
NUMBER merge field described in the Basic Loan Fields
section.

FOLLOW-UP DATE CALC This field will calculate a date in the future that can be
printed on the letter.

If the letter is a notice of default, for example, you can have
the letter display the date by which the account must be
current. The date can be displayed in either alphanumeric
characters. If the date is 4-14 and the option is 30 days,
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Merge Field Field Mnemonic/
Calculation

Description

then the follow-up date would be 5-14. The original date of
4-14 isn't included in the calculation.

To use this merge field, you must have a report option
turned on. Please contact your GOLDPoint Systems
account manager.

GOLDPoint Systems Only: To create a follow-up date for
events, enter a number from 0 to 99 in positions 5–6 of the
Miscellaneous Parameters field. 

LATE CHARGE
VARIANCE

LNPDUE Late charge variance—amount of the regular payment not
paid because late charges were paid

LOAN COLLECTION
OFFICER

LNCTOR Collector number assigned to the loan

LOAN NEXT
PAYMENT DUE

LNLSTB For non-LIP loans, this is the same as the common field
Next Payment Due.

For LIP loans, this contains the last billed amount from the
Loans > Construction > Account Construction Detail
screen, Balances, Rates & Billing tab.

LOAN P/I PAYMENT LNLSTB For non-LIP loans, this is the same as the common field
P/I Payment. 

LOAN TOTAL DUE LNLPCG + LNLATE For non-LIP loans, this is the same as the common field
Total Due. 

For LIP loans, this contains the Prior Unpaid Charges +
Late Charges Due.

LOAN TOTAL DUE
AFTER GRACE

LNLPCG + LNLATE +
CALC

For non-LIP loans, this is the same as the common field
Total Due After Grace.

For LIP loans, this contains the Prior Unpaid Charges +
Late Charges Due + current calculated late charges on the
Last Billed Amount.

LOAN TOTAL PMTS W
FEES AND PARTIAL

LNLPCG + LNFEES -
LNPRTL

For non-LIP loans, this is the same as the common field
Total Payment with Fees and Partial Payments.

For LIP loans, this contains the Prior Unpaid Charges +
Total Loan Fees - Partial Payments.

LOAN TOTAL PMTS W
FEES W LATE CHGS

LNLPCG + LNFEES +
LNLATE

For non-LIP loans, this is the same as the common field
Total Payment with Fees and Late Charges.

For LIP loans, this contains the Prior Unpaid Charges +
Total Loan Fees + Late Charges Due.
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Merge Field Field Mnemonic/
Calculation

Description

LOAN TOTAL PMTS W
LATE AND PARTIAL

LNLPCG + LNLATE -
LNPRTL

For non-LIP loans, this is the same as the common field
Total Payment with Fees and Partial Payments.

For LIP loans, this contains the Prior Unpaid Charges +
Late Charges Due - Partial Payments.

LOAN TOTAL PMTS
WITH LATE CHARGES

LNLPCG + LNLATE For non-LIP loans, this is the same as the common field
Total Payment with Late Charges.

For LIP loans, this contains the Prior Unpaid Charges +
Late Charges Due.

LOAN TOTAL PMTS
WITH LOAN FEES

LNLPCG + LNFEES For non-LIP loans, this is the same as the common field
Total Payment with Fees.

For LIP loans, this contains the Prior Unpaid Charges +
Total Loan Fees.

LOAN TOTAL PMTS
WITH PARTIAL

LNLPCG + LNPRTL For non-LIP loans, this is the same as the common field
Total Payment with Partial Payments.

For LIP loans, this contains the Prior Unpaid Charges +
Partial Payments.

TOTAL LATE CHARGE
AND FEE VARIANCE

CALC Late charge variance plus total loan fees variance

TOTAL LOAN FEES
VARIANCE

LNVPRN Total loan fees variance—the amount of the regular
payment that was not paid because of loan fees

Event 46, Third Late Notice Event

Event 46 will generate a letter for the third late notice. We recommend you use 3-up notices for these late
notices. Refer to the Past Due Notices section previously in this document for more information.

 

Field Specific to Event 46:

Merge Field Field Mnemonic/
Calculation

Description

ACCOUNT NUMBER LN4NBR This is the loan account number without the check digit. It
shows the office number and account number, like this:

1234555666

If you would rather use the formatted loan number that does
include the check digit, use the FORMATTED LOAN
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Merge Field Field Mnemonic/
Calculation

Description

NUMBER merge field described in the Basic Loan Fields
section.

FOLLOW-UP DATE or
FOLLOW-UP DATE
ALPHA

CALC This field will calculate a date in the future that can be
printed on the letter.
If the letter is a notice of default, for example, you can have
the letter display the date by which the account must be
current. The date can be displayed in alphanumeric
characters. If the date is 4-14 and the option is 30 days,
then the follow-up date would be 5-14. The original date of 4-
14 isn't included in the calculation.

If you choose the FOLLOW-UP DATE ALPHA field, the
system will print the date in alphanumeric form (e.g., June
22, 2017). The FOLLOW-UP DATE field prints in date format
(e.g., 06-22-2017).

To use this merge field, you must have a report option turned
on. Please contact your GOLDPoint Systems account
manager.

GOLDPoint Systems Only: To create a follow-up date for
events, enter a number from 0 to 99 in positions 5–6 of the
Miscellaneous Parameters field. 

LATE CHARGE
VARIANCE

LNPDUE Late charge variance—amount of the regular payment not
paid because late charges were paid

LOAN COLLECTION
OFFICER

LNCTOR Collector number assigned to the loan. This is pulled from
the Collector field on the Loan > Marketing and Collections
screen > Delinquent Payments tab.

LOAN NEXT
PAYMENT DUE

LNLSTB For non-LIP loans, this is the same as the common field
Next Payment Due.

LOAN P/I PAYMENT LNLSTB For non-LIP loans, this is the same as the common field P/I
Payment. 

LOAN TOTAL DUE LNLPCG + LNLATE For non-LIP loans, this is pulled from the Total Due field. 

For LIP loans, this contains the Prior Unpaid Charges +
Late Charges Due.

LOAN TOTAL DUE
AFTER GRACE

LNLPCG + LNLATE +
CALC

This is the total amount due after grace days is included with
the calculation. 

For LIP loans, this contains the Prior Unpaid Charges +
Late Charges Due + current calculated late charges on the
Last Billed Amount.

LOAN TOTAL PMTS
W FEES AND

LNLPCG + LNFEES -
LNPRTL

This is the total amount due including any outstanding
miscellaneous fees minus any partial payments.

https://secure.goldpointsystems.com/gpsdocs/loans/LoansCIMGOLD/index.asp?collector_lmac.asp
https://secure.goldpointsystems.com/gpsdocs/loans/LoansCIMGOLD/index.asp?totaldue1-4_pdfg.asp
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Merge Field Field Mnemonic/
Calculation

Description

PARTIAL
For LIP loans, this contains the Prior Unpaid Charges +
Total Loan Fees - Partial Payments.

LOAN TOTAL PMTS
W FEES W LATE
CHGS

LNLPCG + LNFEES
+ LNLATE

This is the total amount due including any fees and late
charges.

For LIP loans, this contains the Prior Unpaid Charges +
Total Loan Fees + Late Charges Due.

LOAN TOTAL PMTS
W LATE AND
PARTIAL

LNLPCG + LNLATE -
LNPRTL

This is the total amount due including late charges minus
any partial payments.

For LIP loans, this contains the Prior Unpaid Charges +
Late Charges Due - Partial Payments.

LOAN TOTAL PMTS
WITH LATE
CHARGES

LNLPCG + LNLATE This is the total amount due including late charges.

For LIP loans, this contains the Prior Unpaid Charges +
Late Charges Due.

LOAN TOTAL PMTS
WITH LOAN FEES

LNLPCG + LNFEES This is the total amount due including miscellaneous fees.

For LIP loans, this contains the Prior Unpaid Charges +
Total Loan Fees.

LOAN TOTAL PMTS
WITH PARTIAL

LNLPCG + LNPRTL This is the total amount of outstanding payments due minus
any partial payments.

For LIP loans, this contains the Prior Unpaid Charges +
Partial Payments.

TOTAL LATE CHARGE
AND FEE VARIANCE

CALC Late charge variance plus total loan fees variance

TOTAL LOAN FEES
VARIANCE

LNVPRN Total loan fees variance—the amount of the regular payment
that was not paid because of loan fees

Event 47, Consumer Insurance Event

Event 47 will generate a letter anytime an insurance policy expires or a Force Place Insurance transaction (tran
code 2870) is run.

Merge Field Field Mnemonic/
Calculation

Description

OPENING BALANCE INOBAL This field displays the add-on insurance premium
amount. It is pulled from the Original Premium field
on the Loans > Insurance > Policy Detail screen.
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Merge Field Field Mnemonic/
Calculation

Description

POLICY NUMBER INPLCY This displays the policy number of the insurance
policy.

DATE OPENED LNOPND This field displays, in MMDDYY format, the date the
loan was opened or funded. 

INSURANCE
EXPIRATION DATE 

POEXPD The date in this field has two purposes: 

1. It is the date the payoff quote record expires. The
system will save the payoff quote record until the
afterhours of the date in this field, then it will
automatically be dropped from the Loan system in
the afterhours processing. 

2. It is the expiration date of the lock-in, if the loan
record is locked-in. The lock-in will be released
after this date. 

DESCRIPTION INDESC This field is used to specify the insurance company or
to describe the type of insurance. The description
placed in this field is automatically entered in the
Amount column on the Adjustments tab of the Loans
> Payoff screen.

TERM IN MONTHS INTERM This field contains the term of the insurance policy in
months. 

ACCOUNT TYPE INTYPC This is the type of insurance set up for this loan. 

AGENT NUMBER INAGNO This field displays the code number of the insurance
agent. 

COMPANY NUMBER INCONO This field displays the company number of the
insurance company. 

NEXT PRINCIPAL AND
INTEREST PAYMENT

LNPINX This is the amount of the next payment due. It may
include principal, interest, late charges, or any other
factors pertinent to an individual loan, such as
reserves, based on what is entered in the Payment
Application field on the Loans > Account Information
> Account Detail screen.

ORIGINAL FINANCE
CHARGE 

INNORG This field displays the original amount of the
insurance finance charge. 

These fields are used in connection with Forced-
placed VSI insurance for loans with precomputed
interest (payment method 3). 

The finance charge is the amount of interest added to
the VSI premium. This amount is amortized each
month and posted to the General Ledger. In addition,
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Merge Field Field Mnemonic/
Calculation

Description

if the policy is cancelled using the Cancel VSI
transaction (tran code 2890-00), the unamortized
amount is refunded to the borrower as a principal
decrease.

See also the Force Place VSI transaction (tran code
2870-00). 

REMAINING TERM
BEFORE EXPIRATION 

Calculation Field When using premium rate tables, this is the rate
pulled out of the table, based on the remaining term of
the insurance policy. It will only appear if using
amortization method 3 (renegotiable rate) and a valid
table number is in the Premium Rate Table field
(INTBLN) on the Loans > Insurance > Policy Detail
screen, Miscellaneous Fields tab.

Event 48, Fee Assessment Letter

This event record is generated when the system encounters tran code 660 (fee assessed), 668 (fee corrected),
670 (fee waived), 678 (fee waive corrected), 850 (fee paid), 858 (fee paid corrected). This event will generate
multiple letters per account if the fee code changes.

This event letter is automatically generated; it cannot be manually ordered. If you manually request event 48, the
system will automatically create event 49 instead.

Merge Field Field Mnemonic/
Calculation

Description

FEE ASSESSMENT
AMOUNT

TRNLOG Fee assessment amount

FEE DESCRIPTION TABLE Fee description pulled from the "Fee Code" table. These
are GOLDPoint Systems defined codes.

 

Event 49, Fee Reminder Letter

This event letter must be manually requested.

NOTE

If you manually request event 48 (meaning you enter event 48 on the
Actions/Holds/Events tab), the system will generate event 49 instead.

https://secure.goldpointsystems.com/gpsdocs/loans/LoanSystem/llsapas2s2890m00.asp
https://secure.goldpointsystems.com/gpsdocs/loans/LoanSystem/llsapas2s2890m00.asp
https://secure.goldpointsystems.com/gpsdocs/loans/LoanSystem/llsapas2s2870m00.asp
https://secure.goldpointsystems.com/gpsdocs/loans/LoanSystem/llsapas2s2870m00.asp
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Merge Field Mnemonic Description

FEE DESCRIPTION LNFEES Fee description. In the letter it will display
"Miscellaneous Fee." (No individual fee descriptions are
used.)

Event 50, PMI Letter

This letter must be requested manually. This letter is used when a borrower requests that PMI be canceled
off their loan. Information for this letter is pulled from the Loans > Account Information > Reserves > Private
Mortgage Insurance screen.

Merge Field Mnemonic Description

CANCEL REQUEST
DATE

PICRQU Date letter received requesting PMI be canceled.

78 PERCENT DATE PI78DT First date scheduled to reach 78% loan to value

80 PERCENT DATE PI80DT First date scheduled to reach 80% loan to value

80 PERCENT AMOUNT PI8AMT Balance when the loan will reach 80% loan to value

Event 51, Late Charge Assessment

This event is created automatically any time an account is assessed a late charge (tran code 560). If you
want to use this event letter, please submit a work order. We can set this event up to run for accounts from
specific states.

The following fields are specific for this event. See Common Event Fields, CIS Fields, and Basic Loan Fields
for other merge fields available for events.

Merge Field Mnemonic Description

LATE CHARGE
ASSESSMENT AMOUNT

LNLATE When the Assess Late Charge transaction (tran code 560) is run,
the teller or employee enters the assessment amount in the
provided field. See the following example of this transaction:
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Merge Field Mnemonic Description

DATE OF LATE CHARGE
ASSESSMENT

This is the As Of Date when the Assess Late Charge transaction
was run (see above).

Event 60, One-time Electronic Payment

The One-Time Electronic Payment (event 60) record is automatically generated when your customers approve of
future one-time ACH loan payments. This event is created after employees click <Submit Payment> after
creating a future one-time payment on the Loans > Transactions > EZPay screen in CIM GOLD. Additionally,
this letter is not included on the Event Letter Report (FPSRP175).

In order to use this event letter, your GOLDPoint Systems customer support representative must set up the
EZPay option EZWREL (Write Event Letters) in the EZPay IMAC tables in CIM GOLD. Once the option is set
up, GOLD EventLetters will generate and download event 60 immediately after an ACH payment is submitted.

See the One-time Future Payments topic in the EZPay help.

The following table lists all the merge fields available specifically for this letter. Note: See also Event 61, Cancel
Event Letter for a letter generated when future payments are canceled.

For a list of common merge fields and where they are pulled, see Common Fields, CIF Fields, and Basic Loan
Fields.

Example of One-Time Electronic Payment 

Merge Field Mnemoni
c

From Screen Description

CONFIRMATION_NUMBER ASREFN Loans >
Transactions >
EZPay

This is the confirmation number that
appears after the one-time payment
transaction is submitted from the EZPay
screen.

CREDITED_TO_ACCOUNT_
NUMBER_MASKED

ASANBR This is the account number on the loan.
On the letter, only the last four digits of

https://secure.goldpointsystems.com/gpsdocs/loans/LoansCIMGOLD/index.asp?easypayscreen.asp
https://secure.goldpointsystems.com/gpsdocs/loans/LoanReports/llr175.asp
https://secure.goldpointsystems.com/gpsdocs/loans/LoansCIMGOLD/index.asp?onetimefuturepmts_ezps.asp
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Merge Field Mnemoni
c

From Screen Description

the account number will print. The first
digits will appear as X's.

ACH_PMT_EFFECTIVE_DATE ASEFDT EZPay This is the effective date of when the
one-time payment was submitted (e.g.,
05-12-2012). 

ACH_PMT_EFFECTIVE_
DATE_ALPHA

ASEFDT EZPay This is the effective date (in alphabetic
form) of when the one-time payment was
submitted (e.g., May 12, 2012).

ACH_PMT_EFF_DT_PLUS_1 ASEFDT EZPay This is the day after the effective date of
when the one-time payment was
submitted (e.g., 05-12-2012).

ACH_PMT_EFF_DT_
PLUS_1_ALPHA

ASEFDT EZPay This is the day after the effective date (in
alphabetic form) of when the one-time
payment was submitted (e.g., May 12,
2012).

INVESTOR_ADDRESS_4 Do not use this field. 

EXTERNAL_BANK_NAME ASABNK EZPay > External
Accounts for ACH 
(e-Check)

This is the external institution name
where the ACH payment is pulled from.
This information is added on the EZPay
screen using the External Accounts
link, then using that account to make a
future ACH payment.

EXTERNAL_BANK_ACCOUNT ASANBR EZPay > External
Accounts for ACH 
(e-check)

This is the external account number
where the ACH payment is pulled from.
This information is added on the EZPay
screen using the External Accounts
link, then using that account to make a
future ACH payment.

When this merge field is used, the
account number only displays the last
four numbers of the account number,
preceded by XXX's.

https://secure.goldpointsystems.com/gpsdocs/remote/InternetPhoneCIMGOLD/index.asp?externalaccountsscreen.asp
https://secure.goldpointsystems.com/gpsdocs/remote/InternetPhoneCIMGOLD/index.asp?externalaccountsscreen.asp
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Tip: If you get the following message in Word after clicking <Preview Selected> on the
Print Event Letters screen,

Do the following:

1. From the Field delimiter field, select "Tab."
2. From the Record delimiter field, select "(enter)."
3. Click <OK>.

This error is a Word error that usually no longer appears after designated the above fields.
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Event 60 Sample Letter

ONE-TIME ELECTRONIC PAYMENT 

October 30, 2018

«EVENT_DATE» «EVENT_NUMBER» 

«BRANCH_NAME» 
«BRANCH_ADDRESS_LINE_1» 
«BRANCH_ADDRESS_LINE_2» 
«BRANCH_CITY_STATE_ZIP» 

«MAIL_ADDRESS_LINE1» 
«MAIL_ADDRESS_LINE2» 
«MAIL_ADDRESS_CITY_STATE_ZIP» 

Dear «ACCOUNT_FIRST_NAME_1» «ACCOUNT_LAST_NAME_1»,

Thank you for your electronic payment scheduled for «ACH_PMT_EFFECTIVE_DATE_ALPHA» using
account number ending in «EXTERNAL_BANK_ACCOUNT» from «EXTERNAL_BANK_NAME». For your
records, your confirmation number for this transaction is: «CONFIRMATION_NUMBER». If this payment
has been made in error, contact our office before «ACH_PMT_EFFECTIVE_DATE_ALPHA».

If you would like to have future payments handled by electronic funds transfer, please call us. If you have
any questions about this transaction, please call us at «BRANCH_PHONE_NUMBER».

Sincerely,

«BRANCH_MANAGER_NAME», Branch Manager

ï Return to Event 60
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Event 61, Cancelled Event Letter

The Cancelled Event Letter (event 61) record is automatically generated when your customers cancel one-time
ACH payments. This letter will not generate for same-day cancellation of ACH payments. Additionally, this letter
is not included on the Event Letter Report (FPSRP175).

In order to use this event letter, your GOLDPoint Systems customer support representative must set up the
EZPay option EZWCEL (Write Event Letter When Cancelled) in the EZPay IMAC tables in CIM GOLD. Once the
option is set up, GOLD EventLetters will generate and download the new event 61, Cancelled Event Letter,
immediately after an ACH payment is cancelled by your customers (and at least one day later from when the
ACH payment was created). 

If ACH payments have not yet posted, you can cancel them using the Loans > Transactions > EZPay screen.
See the One-time Future Payments topic in the EZPay help for more information.

The following table lists all the merge fields available specifically for this letter. See also: Event 60, One-time
Electronic Payment.

For a list of common merge fields and where they are pulled, see Common Fields, CIF Fields, and Basic Loan
Fields.

Example of Cancelled Event Letter

Merge Field Mnemonic/
Calculation

From Screen Description

CONFIRMATION_NUMBER ASREFN Loans >
Transactions >
EZPay

This is the confirmation number that
appears after the one-time payment
transaction is submitted from the
EZPay screen.

CREDITED_TO_ACCOUNT_
NUMBER_MASKED

ASANBR This is the account number on the
loan. On the letter, only the last four
digits of the account number will print.
The first digits will appear as X's.

ACH_PMT_EFFECTIVE_DATE ASEFDT EZPay This is the effective date of when the
one-time payment was submitted
(e.g., 05-12-2012). 

ACH_PMT_EFFECTIVE_
DATE_ALPHA

ASEFDT EZPay This is the effective date (in alphabetic
form) of when the one-time payment
was submitted (e.g., May 12, 2012).

ACH_PMT_EFF_DT_PLUS_1 ASEFDT EZPay This is the day after the effective date
of when the one-time payment was
submitted (e.g., 05-12-2012).

ACH_PMT_EFF_DT_
PLUS_1_ALPHA

ASEFDT EZPay This is the day after the effective date
(in alphanetic form) of when the one-
time payment was submitted (e.g.,
May 12, 2012).

https://secure.goldpointsystems.com/gpsdocs/loans/LoanReports/llr175.asp
https://secure.goldpointsystems.com/gpsdocs/loans/LoansCIMGOLD/index.asp?easypayscreen.asp
https://secure.goldpointsystems.com/gpsdocs/loans/LoansCIMGOLD/index.asp?onetimefuturepmts_ezps.asp
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Tip: If you get the following message in Word after clicking <Preview Selected> on the
Print Event Letters screen,

Do the following:

1. From the Field delimiter field, select "Tab."
2. From the Record delimiter field, select "(enter)."
3. Click <OK>.

This error is a Word error that usually no longer appears after designated the above fields.

Event 61 Sample Letter

ELECTRONIC FUNDS TRANSFER CANCELLATION VERIFICATION 

May 30, 2012

«BRANCH_NAME» 
«BRANCH_ADDRESS_LINE_1» 
«BRANCH_ADDRESS_LINE_2» 
«BRANCH_CITY_STATE_ZIP» 

«MAIL_ADDRESS_LINE1» 
«MAIL_ADDRESS_LINE2» 
«MAIL_ADDRESS_CITY_STATE_ZIP» 

Dear «ACCOUNT_FIRST_NAME_1» «ACCOUNT_LAST_NAME_1»,

As we discussed on «ACH_PMT_EFFECTIVE_DATE_ALPHA», you instructed us to cancel your
previously authorized electronic transfer of funds to pay on your loan account number ending with
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«CREDITED_TO_ACCOUNT_NUMBER_MASKED». If you do not make your loan payment by some other
method by «DUE_DATE_ALPHA», you will be charged any applicable late charge as provided in your loan
agreement.

If you would like to have future payments handled by electronic funds transfer, you must call us. If you have
any questions about this transaction, please call us at «BRANCH_PHONE_NUMBER».

Sincerely,

«BRANCH_MANAGER_NAME», Branch Manager

«EVENT_DATE» «EVENT_NUMBER»

ï Return to Event 61
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Support

GOLDPoint Systems customer service is available Monday through Friday, from 6:00 a.m. to 7:00 p.m. (MT).

Phone: (888) 477-0099
Phone: (801) 429-2172

Fax: (801) 374-5316

Email: ccfisher@goldpointsystem.com

GOLDPoint Systems
1525 West 820 North
Provo, Utah  84601

mailto:ccfisher@goldpointsystem.com
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